
Welcome to SAW32/SAWPlus32!
At IQS, we have a different philosophy - and a unique vision. You may not find us in all the trade 
magazines, or on the shelves in all the local retail stores. Our focus is on quality and integrity, 
investing first in craftsmanship and design. We build our products around the belief that there is 
no compromise when it comes to high standards, and we feel good knowing that you're getting 
the best of the best when you invest in our product line. 

SAW32/SAWPlus32 is the elite when it comes to non-linear hard disk editing software, finely 
crafted using hand-coded Assembly Language, a powerful programming technique, rarely found 
in today's world of fast food and disposable products. Assembly Language coding provides 
unparalleled design capabilities, efficiency, and speed. Like a finely sculpted piece of art, 
SAW32/SAWPlus32 is    handcrafted, intimately detailed, and seriously equipped with the most 
powerful disk editing features needed by audio professionals today. 

SAW32/SAWPlus32 is not just another piece of software. It's a work of art fueled by a passion for 
perfection. It's a step in a brave new limitless direction. It's a whole new way of thinking... 



Other Products from Innovative Quality Software
Ø Demonstration versions of these programs are available at our web site 

(http://www.iqsoft.com/). Try them all!!

Software
SAW Plus 
Professional hard disk editing and multitrack mixing for Windows with 16 simultaneous stereo (32) playback tracks, real 
time preview of all DSP functions, and live automated non-destructive mixing.

SAW 6.x
Professional hard disk editing and multitrack mixing for Windows with 4 simultaneous stereo (8) playback tracks, real 
time preview of all DSP functions, and live automated non-destructive mixing.

SAMM 
Provides an audio console interface that is graphically represented to emulate and bring all the functions of the Yamaha 
ProMix 01 console to your computer screen.

EDL Investigator
The SAW EDL Investigator is a SAW 6.x/SAW Plus/SAWPlus32 enhancement product, which displays, saves and prints all
the information saved inside your EDL files, including sound files, regions, markers, track lists and fx settings. The 
Investigator is highly customized through tabbed preference settings - so you only need to display the information you 
want to see.

IQS and Third Party FX PlugIns
AVI Viewer
An exciting new tool which makes sound editing to video a simple and affordable process. The AVI Viewer is assigned to 
a track of the MultiTrack View through the FX Patch Builder Window. The viewer will display an AVI video file to the 
computer screen, without the need for any additional hardware, or to an external full screen video monitor with the use of
specialized video capture boards. This video display is dynamically linked to the SAW MultiTrack environment and will 
track precisely with all MultiTrack cursor movements in any SMPTE Mode, with sub-frame accuracy.

Reverberator
The Reverberator brings new power to the Saw environment by opening up the world of real sounding Room 
Reverberation to each track on the MultiTrack. The Reverberator is capable of real time processing of 16 bit stereo 44100 
soundfiles on a Pentium 133 or faster machine. The algorithms used incorporate the same Comb/Allpass filter design 
found in many high quality rack-mounted reverb devices. Most devices of this type use 4 comb filters and 2 allpass 
filters, but the Reverberator gives you up to 20 comb filters and 20 allpass filters, with Hi Freq Diffusion control in each 
comb filter feedback path and a high quality sharp cutoff bandpass filter on the overall wet output. 

Meter Bridge
The Meter Bridge enhances the SAW environment with beautiful visual displays of individual or multiple track playback 
volume reference meters. The meters can be assigned to any track, including output tracks, giving you a live/real time 
LED or VU meter display of your multitrack session. The displays can be mixed (LED/VU), labeled, and positioned 
anywhere, and all information is retained with your EDL’s.

PanHandler
The PanHandler brings surround sound panning and encoding to the SAW environment and operates in real-time. The 
final mix can then be successfully decoded via a surround sound receiver/decoder playback unit. All the surround sound
encoded events are played back exactly as they were panned and encoded. The result is a remarkably realistic listening 
experience. And if play back is in a normal stereo configuration, surround sound tracks still create a wider, more 
enveloping sound field for the listener. 

Stereo Enhance FX 32

Now you can control the "openness" of your stereo image with the stereo Enhance FX 32 effects PlugIn for 
SawPlus32. You can set the width to anything from mono to a wide open image. This way, you can "open up" stereo 
tracks and/or your final mix for an improved stereo experience. A simple to use interface makes it fast and easy to 
tweak your stereo image to perfection. 



Ignition CDR Burner
Now, master your own CD's directly from the SAWPlus or SAWPlus32 MultiTrack window with the Ignition CDR Burner 
Plug-In. This FX Plug-In patches into the Output Track of the MultiTrack window and allows you to place Track Indexes 
and PQ Codes directly into your existing sessions. Then simply use the new Build Mix To FX Modules function in 
SAWPlus or SAWPlus32 and send your data directly to the CD with all Volumes, Fades, EQ, Echo, Reverb and 
Compressor, Limiter and Normalize functions being applied live on the way.

Tube Warmth

Now you can impart the warmth and richness of vacuum tube amplification to your digital audio tracks. This intriguing
new plug-in module allows users of SAW Plus or SAW32/SAWPlus32 to make any .WAV file sound subtly warmer, 
richer, closer, and fatter. It may be just what the sound doctor ordered for thin sounding tracks. It processes a stereo 
sound file in real time (on a P75 or higher). This makes it a snap to compare processed against unprocessed sound, 
and you can dial in just the right amount of effect with a pop-up control panel. 

WinJammer Sequencer Sync
Introducing WinJammer Sequencer Sync! A powerful new plug-in link between the 32 bit WinJammer MIDI Sequencer 
and the SAWPlus32 environment. This link creates a bi-directional sync-lock between the two programs. This allows for 
much tighter control of the sync and also locks manual cursor positioning between both programs. For instance, move 
the cursor in SAWPlus32's MultiTrack, and pop over to WinJammer to find its play position at the same location. Or 
change the play position in WinJammer to Measure 56, Beat 1 and pop over to SAWPlus32 and find its MultiTrack cursor 
at the exact sample position!

FX Convolver
This module performs linear convolution, a mathematical operation that describes a filtering action in the time domain, 
between the track audio data and an impulse response (IR), a time domain description for a filter of any type, from the 
simplest low pass filter to the most complex room reverb. This means that you can filter your tracks with any filter 
function you like, all you need is its IR. The module applications are almost infinite thanks to its capability of managing 
stereo IRs too: spectrum shaping, equalization, reverberation, spatial positioning, auralization, ... 
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About This Helpfile
This Helpfile was designed as a reference for understanding and using the features and functions of 
SAW32/SAWPlus32. These products are continually being updated with new features which may not be 
included in this version of the Helpfile. Once you receive an updated product version, look for details on 
any new features and maintenance fixes in the Latest Release Notes located in the Info dropdown menu 
within the program.



Helpfile Conventions and Terminology
I The hand symbol will be used to indicate important notices and warnings.

F The pointing finger symbol will be used to indicate a point of mention 
about a particular feature or concept.

» The clock symbol will be used to indicate a time saving suggestion.
Italics Menu items, keyboard commands, screen objects and reference to terms 

relating to audio will be written in italics. (Example: Click the Cancel 
button.)

Click When instructions indicate to ‘click’ an object, press and release the left 
mouse button.

Double-click When instructions indicate to 
‘double-click’ an object, press and release the left mouse button twice 
quickly.

Right-click When instructed to ‘right-click’ 
an object, press and release the right mouse button.

Drag When instructed to ‘drag’ the mouse, point to the object then press and 
hold the left mouse button as you drag the object.



Overview
SAW is the acronym for Software Audio Workshop. This program runs in Microsoft Windows and turns 
your Windows PC into a powerful digital audio workstation.

SAW32 and SAWPlus32 represent the third generation of digital hard disk editing software from 
Innovative Quality Software. SAW32/SAWPlus32 is written in native NT/95 32 bit code. It truly makes use
of and takes advantage of the multithreaded technology of the Windows 32 bit API.

Now you can easily record and edit up to 24 mono or stereo tracks with SAWPlus32 (eight tracks in 
SAW32) of 16 bit resolution, CD and DAT-quality soundfiles directly on your computer’s hard drive. 
SAWPlus32 supports up to eight stereo sound cards (four for SAW32), for a maximum of up to 16 
physical inputs and outputs, and automatically converts 8 bit, 16 bit, mono or stereo files of any 
samplerate, playing them all seamlessly in sync - LIVE…in REAL-TIME!! The elegance and speed of the 
SAW32/SAWPlus32 design offers unmatched efficiency in taking a project from conception to 
completion.

Each track contains software controls for mute, solo, pan and fader with user definable fader slope 
values. These controls give you non-destructive, real-time PROGRAMMABLE mixing control with down-
to-the-sample accuracy. Easily set volume and pan offsets that work in addition to complex fades and 
pans, allowing you to adjust overall track levels without disturbing the details of your mix. Volume and pan
information is displayed on the track so you can see, as well as hear, the mix changes!

Easily overlay vocals on music beds. Easily add sound effects to existing productions. Easily create 
custom cross fades from one track to another. Easily assemble and master complete album projects…
perform fades and panning live during playback, recording every move for perfect reproduction. And do it 
all non-destructively!

And since SAW32/SAWPlus32 allows you to edit across 200 sound files at once in the same editing 
session, you can mix and blend sounds from pre-categorized libraries or easily assemble that perfect solo
from many different musical takes.

The MultiTrack View allows you to copy, drag and drop regions of audio to any position within the 
production instantly! This means you can change musical phrasing long after the original recording has 
been made and hear the changes immediately.

While other systems rely heavily on complex and expensive hardware to manipulate digital audio, 
SAW32/SAWPlus32 relies extensively on hand-coded, 32 bit Assembly Language programming to 
efficiently manipulate the digital audio within the software using the computer’s CPU. This rare digital 
craftsmanship translates directly into incredible savings for you. Also, since the SAW32/SAWPlus32 
system is not directly dependent on one proprietary hardware design, it offers much more flexibility and 
user choice in selecting the exact configuration to fit specific needs.

SAW32/SAWPlus32 can continue to grow and expand rapidly with software updates alone, allowing you 
to benefit from the post-release product enhancements that Innovative Quality Software has become 
famous for.

SAW32/SAWPlus32 makes excellent use of the Windows graphics operating system without getting 
bogged down by the typical overhead of resource-intensive dialog boxes. In fact, SAW32/SAWPlus32 
boosts Window’s normal performance tremendously due to its assembly language code, and you will 
enjoy screen updates and fast waveform drawing unmatched by even some of the most expensive audio 
workstations.

The editing environment offers simultaneous full and zoomed views of your audio waveforms, making it 
fast and simple to move around within a soundfile. Audio waveforms are true oscilloscope style, allowing 



you to visually locate exact positions easily.

On-screen control buttons eliminate the need for learning complex keystroke combinations to perform 
basic editing operations, however a comprehensive list of keystroke commands are available for those 
who prefer to use the keyboard. (See Keyboard Command Quick Reference section.) 
SAW32/SAWPlus32 takes you far beyond the functionality of standard tape recording equipment and 
delivers the effectiveness of true, non-linear, random hard disk editing power, matching the capabilities of 
systems costing thousands more.

Simultaneous Marker, Region and play Sequence Views make it easy to select and audition various 
sections of your soundfile and update editlists with the click of the mouse.

The MultiTrack View graphically displays your entire session from a zoomed out overview to the most 
critical detail of a track’s waveform, volume, pan and time information. Fully implemented drag and drop 
editing simplifies complex manipulation of large sessions beyond anything you ever thought possible or 
expected from a digital audio workstation.

The capability to instantly copy, move, delete, replace or otherwise reorder and compare data on multiple 
tracks can save you hours of production time. In many cases, you can build productions that would not 
even be possible with standard audio equipment! 

All windows can be rearranged and assigned to as many as twelve different function key views. This 
allows easy customization of the interface so you can optimize it for the way you want to work. Change 
from a full view of 24 tracks, to a view of all windows perfectly tiled, to a zoomed view of one section of 
your waveform - all in an instant!

SAW32/SAWPlus32 offers real-time, non-destructive effects processing for many of the most common 
functions including EQ, compression, limiting, gating, echo/delay, reversing, vari-pitch and more. These 
functions represent another breakthrough in high-quality, Assembly Language craftsmanship. All of the 
functions are designed using special high-resolution integer routines that actually out-perform the floating-
point math co-processor and deliver the equivalent of 64 bit resolution, eight decimal point math. These 
features manipulate digital audio data without the need for expensive DSP (Digital Signal Processor) 
hardware, bringing the power of this technology to virtually and Windows-compatible sound card!

In short, the SAW32/SAWPlus32 environment can and most likely will change the way you work with 
audio forever.



SAW32/SAWPlus32 Features
· Simultaneous playback of up to 24 mono or stereo tracks in SAWPlus32 (eight for SAW32)

· Support of up to eight stereo sound cards (four for SAW32), translating into a maximum of 16 
input/output channels

· Ability to record direct to MultiTrack or to SoundFile View

· Power to record, edit and play stereo or mono soundfiles in the same session at the same time

· Fast, accurate segmented bar graph meters in the Record Panel with peak hold

· MultiChannel Record mode for instant emulation of a typical MultiTrack tape recording system

· Simultaneous Sync Record/Play (sound card dependent)

· Remote Transport panel allowing control of SAW32/SAWPlus32 from any other application

· Complete Drag and Drop, non-destructive editing

· The same high performance with any size project - from seconds to hours in length

· MultiTrack display including waveforms and adjustable track height

· Nine session versions which can be instantly saved and recalled within each project

· MultiTrack select mode marking, allowing fast grouping of multiple regions for simultaneous editing 
operations

· MultiTrack edit tools providing quick segment splicing or removal functions

· Virtual scrolling of SoundFile and MultiTrack displays

· Software-emulated DSP functions providing parametric EQ, noise gate, peak limiter, normalizer, 
compressor, echo/delay effects, vari-pitch/speed, reverse audio, reverse phase, and center channel 
eliminate

· Emulated DSP functions, patchable to each track or sound card output for real-time processing during
playback

· Separate master volume controls for each sound card output

· Live format conversion during playback (mix any combination of regions that are 8 bit or 16 bit, mono 
or stereo, and any samplerate)

· Ability to adjust volume, pans, mutes, solos and effects during playback (without additional expensive 
hardware) and ability to define fader slope values for each mix change

· Automatic recording of Mix changes for exact duplication during playback

· Programmable function key views providing fast access to multiple workspaces

· Support for industry standard WAV file format

· Incredibly fast Assembly Language waveform displays and screen redraws

· SMPTE sync and generate capability with sub-frame accuracy

· MIDI trigger capability for regions or MultiTrack playback

· Loop scrubbing to find hard-to-see editpoints

· And much, much more…

SAW32/SAWPlus32 provides enhanced performance to the previous generations of SAW products due 



to its new flat 32 bit Native NT/95 code and multithreaded handling routines which take advantage of the 
Priority Threading architecture of the Windows 32 bit API. SAW32/SAWPlus32 also supports long file 
names.

Fader resolution has been enhanced to ¼ dB steps and each mix step is now ramped according to a 
Slope Setting, resulting in resolutions below 1/1000 of a dB for smoother, noiseless fades. Marked Area 
fade in/outs also utilize Fade Curve parameters for more precise control and complex fades can now be 
stretched offset instantly. Vari-pitch resolution is enhanced to 1/100 of a percent in Time Mode.

The new Sample Edit mode allows you to edit the value of the actual samples of your soundfile in order to
reconstruct a waveform that has been damaged form clipping, for example.

The new KEEP TAKE feature enhances recording by allowing you to keep multiple takes during the 
recording process.

MultiChannel Record mode simplifies live session recording and closely resembles a typical MultiTrack 
tape system.

GamePort switches are now supported through the joystick services, allowing remote control of playback 
commands.

The list of features far exceeds what is listed here. The true power of the SAW32/SAWPlus32 
environment can only be appreciated by jumping in and getting your feet wet!



System Requirements
SAW32/SAWPlus32 is designed to run under Microsoft Windows NT or 95 on a PC-compatible system. 
While SAW32/SAWPlus32 may be used with slow CPUs, the ability to play multiple tracks and process 
DSP functions diminishes accordingly with CPU speed.

You must have a minimum of 64 Megabytes of RAM (Random Access Memory) for SAWPlus32, and a 
minimum of 32 Megabytes for SAW32. You need a mouse or similar pointing device and a minimum VGA 
video resolution of 800x600 at 256 colors. Fast hard drives (7200 RPM SCSI and higher) are 
recommended for optimum performance. SAW32/SAWPlus32 requires at least one Windows-compatible,
16 bit sound card and supports up to eight sound cards (16 simultaneous inputs/outputs) while SAW32 
supports up to four sound cards.



Setting Your Windows Display
SAW32/SAWPlus32 is able to display a substantial amount of information on the screen at any given 
time. We strongly recommend that you use the program at a video resolution of 1024x768 with 65,000 
colors. SVGA 800x600 will work, but the amount of information displayed on the screen is very limited. 
The 256 color setting will work, but the 16 bit or higher color options help to eliminate palette switching 
problems inherent in the PC/Windows design.

Even though your video card and monitor might be capable of these higher resolutions, the Windows 
system installs at a default resolution of VGA (640x480). You must specifically select one of the higher 
resolutions. Refer to your video card documentation, the manufacturer, or your computer supplier for 
information on adjusting your video resolution.



Installing SAW32/SAWPlus32 On Your Computer
To install the SAW32/SAWPlus32 program files on your computer, simply run the SETUP.EXE program 
from inside Windows as follows:

èInstalling SAW32/SAWPlus32:

1. Insert Disk 1 into your computer’s floppy drive.

2. From the Start menu, point to Settings, select Control Panel, then choose Add/Remove Programs.

3. Click on the Install button and follow the installation instructions.

1. Insert Disk 1 into your computer’s floppy drive.

2. From the Start menu, choose Run.

3. In the Run Command text box, type A:SETUP.

4. Press Enter and follow the installation instructions.

SAW32/SAWPlus32 will install into its own folder (you can specify a different one if you like). The 
installation of SAW32/SAWPlus32 will in no way affect any of your system files. All files are installed to 
one location, without adding files to system folders or changing existing configuration files.

The program will also create a subfolder under the application folder name AUDIO. The program will 
default to this folder when saving. You may save your work to any folder you choose, and we recommend 
creating separate folders for each project, saving all associated project files to their applicable locations. 
We also suggest you never save your work directly to the application folder.

I Important Information Regarding Product Updates: Please read the Latest Release Notes file (in 
the program’s Info dropdown menu) for recent information about your current program version. This 
file will always contain information and operation guidelines for new features added since the 
publishing of this Helpfile. Windows 95 users should also read the help section on Optimizing 
Windows 95. 



Installing Your Sound Card
First, complete the installation of your audio card(s) according to the instructions that accompany the 
card(s). Follow the manufacturer’s recommendations and complete any necessary testing to insure that 
the card is functioning prior to running SAW32/SAWPlus32.

SAW32/SAWPlus32 is fully compatible with the Windows MultiMedia specification. This allows 
SAW32/SAWPlus32 to work with virtually any sound card that is supplied with a well written Windows 
driver. You must install the sound card driver in order to work with SAW32/SAWPlus32.



Installing Your MIDI/SMPTE Card
SAW32/SAWPlus32 has the ability to sync to or generate SMPTE and MTC time code. 
SAW32/SAWPlus32 can read MTC with any MIDI device, but only certain devices have the ability to 
generate SMPTE. Complete the hardware installation of your MIDI/SMPTE card according to the 
manufacturers instructions that accompany the card. Refer to the Options menu and MIDI/SMPTE 
hardware setup for further information on setting up SAW32/SAWPlus32 to use the installed MIDI card.



Starting SAW32/SAWPlus32 
Once you have successfully completed the setup program installation, you are ready to run the 
SAW32/SAWPlus32 program:

èStarting SAW32/SAWPlus32 from the Start Menu:

1. From the Start menu on the taskbar, choose Programs.

2. Point to SAW32/SAWPlus32 and select the SAW32/SAWPlus32 program icon.

F You may also create a program shortcut on the desktop and double-click the icon to start the 
program. (Refer to your Windows Help files for information on creating shortcuts.)

èStarting SAW32/SAWPlus32 from the Run Command:

You may also use the Run command to start SAW32/SAWPlus32 in a special debug mode if you need to 
troubleshoot the program:

1. From the Start menu, choose Run.

2. Click Browse and navigate to the SAW32/SAWPlus32 folder.

3. Select the applicable .exe file (for example SAWPlus32.exe).

4. Click OK.

5. At the end of the pathname in the command line text box, add a space and /D. This will bypass your
preference file and force the program to load its pre-programmed defaults. This can be helpful in 
detecting problems that can arise from a corrupted .prf file.

SAW32/SAWPlus32 will also accept a WAV, SND or EDL filename on the command line when starting 
up. WAV and SND files will automatically open into the SoundFile View. EDL files will automatically open 
into the MultiTrack View. With EDL filenames, you may also include a /P command option to immediately 
begin playback of the EDL. Make sure to include the entire path and filename and leave a space after an 
EDL name before adding the /P.

For example, to have SAW32/SAWPlus32 load a begin playback of an EDL upon startup from a shortcut 
icon on the desktop:

1. From the Windows desktop, right-click the SAW32/SAWPlus32 shortcut icon.

2. Select Properties from the shortcut menu.

3. Click the Shortcut tab.

4. In the Target textbox, click at the end of the command line.

5. Add a space, then type the pathname for the EDL followed by another space then /P.

Example: C:\SAWPLUS32\SAWPLUS32.EXE C:\AUDIO\TEST.EDL/P

6. Click OK.

7. Double-click the icon to start the program.



Adjusting Hardware Parameters
When you first run SAW32/SAWPlus32, you must configure the program to work with your sound card(s).
From the Options menu, choose Audio Hardware Setup. There are several options to adjust.

Wave Devices
The Audio Card Setup window first displays the wave output device selections. Start with Wave Device 1 
and select the audio card driver that matches the card that you have installed. If you have more than one 
card installed, repeat this for each card. SAW32/SAWPlus32 will not allow you to select a driver more 
than once, nor allow you to assign a wave device out of sequence.

Next, click the Out/In Device Toggle button to display the wave input device selections. Start with Wave 
Device 1 and select the audio card driver that matches the card that you have installed. If you have more 
than one card installed, repeat this for each card. If your sound card has an unmatched number of inputs 
and outputs, you should set the matching input and output pairs to the same device number, leaving 
unmatched devices set to none. 

F For example, if your sound card has four stereo analog outputs and one stereo digital output, but 
only one stereo analog input and one stereo digital input (thereby creating an unmatched set of 
inputs and outputs), set out device 1 to driver-out 1-2, out device 2 to driver-out 3-4, out device 3 to 
driver-out 5-6, and out device 4 to driver-out 7-8, and out device 5 to driver-out digital 1-2. Then set 
in device 1 to driver-in 1-2, and in device 5 to driver-in digital 1-2, leaving in device 2, 3, and 4 set to 
none.

PreLoad Buffer Queue
This setting controls how many buffers of data are preloaded to the card before playback or recording 
begins. This affects the response time of live controls such as mutes, solos, faders and pans. If this 
setting is too low for your system, audio stuttering or glitching during playback may occur, especially when
minimizing or sizing windows, etc.

Pressing the PreLoad Queue button to the right of the display window will cycle through the available 
settings from 1 to 15. Lower values will give you faster response times.

If you are using a fast Windows NT system, a setting of 1 or 2 may work well. If you have a slower 
machine running Windows 95, try using higher settings like 4 to 6.

When you are finished with all adjustments, click OK, then save your default settings by clicking on the 
File menu and selecting Save Preferences.



Product Registration
Registration is important for us as a means of ensuring legitimate software purchases. It’s important to 
YOU as it guarantees that you receive all the benefits of being a registered IQS customer, including 
access to free technical support, new product updates, and discounts on other IQS products.

So that we can continue to bring you the high quality software and support you’ve come to expect from 
us, we ask that you support our registration system, and that you don’t pirate or accept pirated copies of 
our software. Thank you.

Registration occurs in one of the following ways:

· If you call and purchase products direct from us, you will be pre-registered in our database. You will 
be assigned a unique keycode which will be stamped inside the front cover of your product’s 
reference manual.

If you prefer to download products from our website on the Internet (www.iqsoft.com), you may attain 
your keycode at the time of purchase and be authorized to download the software immediately. In 
addition, you may specify at the time of purchase if you would also like to receive the software 
package, including original disks and reference guide (if applicable).

· If you purchase our products through a dealer/distributor, to receive registration benefits, we will need 
to receive the completed registration card from your package including your name and your keycode 
(stamped inside the front cover of your product’s reference manual). Sorry - we cannot accept faxed 
or Xeroxed copies.

· If you purchase our products from a previous owner, please call us at (702) 435-9077 to re-register 
the copy in your name and receive your new keycode.



Technical Support
If you are experiencing difficulties using one of our products and are unable to find the solution in the 
reference manual that accompanied your product, online help, or the Latest Release Notes under the 
program’s Info menu, please call our technical support team for assistance. We’re eager to answer your 
questions and help you create the best audio projects possible.

To aid us in assisting you with your questions, please be in front of your computer. Our technicians may 
ask that you experiment with different settings on your equipment and/or software. It would be very helpful
if you have a good working knowledge of the Windows environment (Windows Explorer and Control 
Panel) when you call for support or have someone with you that knows it well.

You can reach IQS Software Support at (702) 435-9077 (USA), Monday thru Friday, 9:00 AM to 5:00 PM 
PST, or you can email your questions to tech@iqsoft.com at our website. 



IQS on the World Wide Web
Innovative Quality Software maintains an exciting, fast-changing site on the World Wide Web at 
http://www.iqsoft.com. There you will find up-to-date information on our company and products, along 
with exciting program demos available for downloading, allowing you to experience the power of our 
products before purchasing.

We encourage you also to explore the new IQS Magazine on our website which contains reviews, 
technical support documents, powerful tips and techniques, and a wealth of information and fun reading 
about how IQS products are currently being used in the industry.

Registered user program updates are now obtainable from our site. We suggest checking our website 
frequently to find out what the latest available version of your software is and to download the latest 
update. When obtaining a program update from our website, you will be asked for your keycode access 
number, which can be found stamped inside the front cover of your manual.

In our endeavor to educate, inform, and inspire you, we encourage you to stop by and stay informed with 
the latest and most honest look at what’s happening in digital audio and related industries.



The SAW32/SAWPlus32 Main Screen
The SAW32/SAWPlus32 interface is superbly and strategically designed to give the user complete digital 
editing capabilities by enhancing (and in some cases overriding) the normal Windows behavior with 
procedures essential to performing serious digital editing with the highest degree of quality and 
proficiency. By reading about and understanding the logic behind this program and letting go of old 
standards and beliefs, SAW32/SAWPlus32 will reward you with a powerful new way of working with 
digital audio.

Even though SAW32/SAWPlus32 is considered to be one of the most sophisticated digital audio editing 
programs available, the intuitive visual design can take the “scare” out of digital editing, making the 
process fun and exciting. The SAW32/SAWPlus32 interface is designed to be easy to use for the 
beginner as well as extremely powerful for the experienced user. 

Below is a list providing an overview on how each of the windows is used in audio production.

Window                      Function  

MultiTrack View The MultiTrack View window is where the majority of your work is accomplished. It 
is here that your production is assembled and referenced to time, fine tuned and 
ultimately finished.

Full View The Full View window shows the current soundfile in its entirety, and is used to 
audition any part of the soundfile quickly.

SoundFile View The SoundFile View window is used to audition editpoints and to create precise 
region definitions.

Remote Transport View The Remote Transport View window 
controls playback of your sound and displays time or sample information about 
your production.

Regions View The Regions View window displays the regions you create in an alphabetized list.
Sequence View The Sequence View window displays detailed information about the MultiTrack 

entries in list form.



Saving Different Workspace Views
As you work with SAW32/SAWPlus32 and become more comfortable with the interface, you may wish to 
change the view of the main screen by moving and sizing the different windows to more easily facilitate 
your work. You may save up to 12 different views, assigning each view to a different function key on the 
keyboard. These views can then be easily recalled by simply pressing the applicable function key, making
it extremely quick and easy to navigate to different views within the same editing session.

èTo Assign a Workspace View to a Function Key:

1. Arrange the SAW32/SAWPlus32 display to your specifications.

2. Press Shift and the function key you wish to use to recall that view.

3. To recall the view, press the assigned function key.

4. To permanently save your function key assignments, from the File menu, choose Save Preferences.

F Whenever preferences are saved, the current workspace view becomes the default startup view.

» As a recommendation for a useful set of workspaces, try these suggestions:

F1 Key Leave as is (original screen view)

F2 Key Extend the MultiTrack View window downwards by dragging the bottom of the window, to 
display 12-16 normal size tracks.

F3 Key Press F1, then press PageUp three or four times to expand the track size of the original 
four track display.

F4 Key Shrink the MultiTrack View window, by dragging the bottom of the window upwards to 
display only two tracks, then press PageUp three or four times to expand the track size.

F5 Key Shrink the MultiTrack View window, by dragging the bottom of the window upwards, to 
display only one track, then press PageUp three or four times to expand the track size.

F6 Key Press F1 to get back to the original default. Close the MultiTrack and Sequence View 
windows. Expand the Full View window, by dragging the top of the window upwards to 
the top of the screen.

F7 Key Press F1 to get back to the original default. Close the Full and Sequence View windows. 
Resize and reposition the Regions View window in the lower left corner. From the 
Windows menu, select Markers to open the Markers View window. Click the green button 
in the Markers View to contract the window.

F8-F12 Keys Use as temporary workspace views for the current session.





The Fundamentals of Digital Audio
Now that you’ve been introduced to the basic windows of the SAW32/SAWPlus32 interface, let’s explore 
some of the fundamentals of digital audio and how the power of non-linear editing can unleash unlimited 
possibilities when it comes to designing and building audio productions.

What is Digital Audio?
Prior to the computer age and the introduction of digital audio concepts, analog technology ruled the 
audio recording industry. Analog audio can be considered a continuous stream of fluctuating electronic 
pulses, a perfectly smooth facsimile of the original acoustic audio signal.

Digital audio, however, is actually a series of individual snapshots of the original acoustic audio signal, 
taken at defined time intervals, which when sequentially reassembled, creates a facsimile of the original 
signal.

Because the components of a digital audio signal are discreet in nature, they can easily be stored and 
manipulated as files in a standard PC computer environment. We will refer to these files as soundfiles.

The time intervals between snapshots we refer to as the samplerate. The smaller these intervals are, the 
more snapshots there are within a specified time. For example, if the time interval is a tenth of a second, 
then ten snapshots will be taken per second, making the samplerate ten. If the time interval is a 
hundredth of a second, then 100 snapshots will be taken per second, making the samplerate 100. The 
higher the samplerate, the more snapshots per second there are, making the facsimile closer to the 
original. We will refer to each snapshot as a sample.

Each sample in a digital audio signal represents the instantaneous volume level of the original audio at 
the moment the sample was taken. PC computers represent number values as binary data. The basic 
building block of binary data is called a bit. The higher the number of bits, the higher the value they can 
represent. For instance, one bit can represent two values, 0 and 1. Two bits combined can represent four 
values, 0, 1, 2, and 3. Eight bits can represent 256 values, 0 thru 255. Sixteen bits can represent 65,536 
values.

When representing an audio signal with eight bits, the facsimile of the original is very limited in detail (only
256 values available). When representing the same signal with 16 bits (65,536 values available), the 
amount of detail captured more closely duplicates the original signal. The amount of detail is referred to 
as resolution. The higher the resolution and the samplerate, the higher the quality of the digital audio 
captured.

The tradeoff to using the higher resolution and samplerate values is the need for more computer memory 
and speed to store and manipulate the data. For example, an 8 bit resolution, 44100 Hz samplerate 
stereo soundfile requires approximately 5.25 megabytes of hard disk storage per minute, whereas a 16 bit
resolution, 44100 Hz samplerate stereo soundfile requires approximately 10.5 megabytes of hard disk 
storage per minute.

What is Non-Linear Editing?
There are two general methods commonly used to manipulate digital audio once it has been brought into 
the computer environment - Linear and Non-Linear.

The Linear method is generally a simpler concept to implement when designing a digital audio 
environment. Original soundfile data is typically marked, cut, copied, pasted, processed, and otherwise 
assembled from beginning to end, in a sequential fashion, most likely into a new soundfile representing 



the finished production. The process of linear editing is much like stacking bricks one on top of the other, 
one at a time. As the bricks are stacked, removing one brick near the bottom topples the entire structure. 
Each editing operation is usually performed on the actual soundfile data, requiring mass amounts of data 
manipulation, slowing processing time drastically. Also, many of the editing operations can actually be 
considered destructive as they permanently alter the original audio data. In order to provide Undo 
capabilities, copies of large amount of original data are required to be stored prior to each destructive 
operation. For instance, to cut six seconds from the front of a one minute soundfile might require saving 
one megabyte worth of data to an Undo file, and then copying the remaining nine megabytes forward. 
Undoing the cut would then require recopying the first megabyte from the Undo file and appending the 
remaining nine megabytes to the end. Expand this concept to editing a 20 minute soundfile and realize 
you might move and copy up to 200 megabytes of data each time you remove a few seconds from the 
file. This translates into large amounts of extra storage space and lots of precious time needed to perform
simple editing operations in a typical production.

The Non-Linear method is a more complex concept to implement, but offers phenomenal benefits, 
incredible power, and time-saving capabilities that a linear system can’t begin to compare to. In this 
environment, small objects, typically called clips or regions, that represent and link to the original 
soundfile data are manipulated instead of the original data. Two immediate advantages of this concept 
are 1) there is no longer a need to move and copy large amounts of original soundfile data to perform 
simple editing operations, and 2) most editing operations can be considered non-destructive as they do 
NOT alter original soundfile data. Most non-linear environments are built around the concept of a virtual 
MultiTrack workspace. Regions can be randomly placed on any combination of tracks and assembled to 
create a finished production. A powerful non-linear editing environment like SAW32/SAWPlus32 allows 
the regions to be copied, moved, overlaid, processed and otherwise manipulated non-destructively in 
real-time, allowing instant auditioning of the production as it’s being built, and eliminating the need for the 
Undo function for most operations. For example, the procedure of cutting a small amount of materiel from 
the front of a large soundfile requires absolutely no copying or moving of the data, and can be undone or 
altered at any time without the need for an Undo file. A small Region is created to represent the part of the
soundfile in front of the desired cut point. Another Region is created to represent the part of the soundfile 
after cut. The two regions are simply placed side by side on a track, and the cut is complete. Playback 
can occur instantly and original soundfile remains intact! To alter the cut, one or both of the Region 
boundaries can be simply redefined and once again, the original soundfile remains intact!

The advantages of non-linear editing are numerous, and will continue to astound you the more you work 
with this concept. So hold on to your hat and fasten your seatbelt as we begin our journey into the 
powerful world of the SAW32/SAWPlus32 non-linear MultiTrack editing environment.



Basic Concepts You Should Know

Windows and SAW32/SAWPlus32 Conventions
The SAW32/SAWPlus32 interface displays many windows at the same time. The Active Window 
generally has the mouse and keyboard focus and is usually indicated by a different colored title bar. 
Clicking inside of any window typically makes that the active window. Commands that have functionality in
multiple windows may, in some cases, function differently depending on which window is active.

Sizing and Moving Windows
If a window can be sized, you may do so by pointing the mouse arrow to the edge of the window until a 
double-headed arrow is displayed. When you see the double-headed arrow, click and hold the left mouse 
button and drag the window to the desired size.

Move any window by clicking and dragging it’s title bar and moving the window to a desired location. (Title
bars are labeled in each diagram where applicable).

Using a List Box
To navigate inside of a list box in SAW32/SAWPlus32 (such as the Regions View window), use one of the
following methods:

1. Use the Up and Down arrow keys to move up and down the list one item at a time.

2. Use Page Up/Page Down keys to page up or down through the list, one screen at a time.

3. Click the scroll bar arrows to move up or down one item at a time.

4. Drag the scroll box inside of the scroll bar to move to a relative position.

5. Click inside of the scroll bar on either side of the scroll box to move up or down a page at a time.

6. Use the Home/End keys to go instantly to the top or bottom of the list.

7. To navigate to a specific item in a list, type the first letter of the item. Continue to type subsequent 
letters until the name of the desired item is selected.

Using the File Dialog Boxes (Open/Save)
I Regarding File Management: It is recommended that you learn the basics of file management in the

Windows platform (Windows Explorer or My Computer) from one of the many books available on the 
subject, or by studying the online help files built into the Windows operating system. 

Basic concepts:

· The Drive/Folder Drop Down List indicates the folder you are currently accessing. Click the arrow to 
the right of the list box to display the hierarchy and drive information or select a new drive/folder 
location.

· To navigate to a folder residing within the current folder, double-click the desired folder name 
displayed within the Contents List. The newly selected folder name will be displayed in the 
Drive/Folder Drop Down List, and it’s contents will be displayed in the Contents List.

· Use the Up One Level button to go backwards in the file structure.

· Use the Create New Folder button to create a new folder inside of the currently displayed folder.



· Use the Contents View button to display just the names of the files and folders in the Contents List.

· Use the Detail View button to display the names of the files and folders along with the size, type, and 
last modified date of each file.

· To open a file, navigate to the desired folder location, click the desired file name and click Open.

· To save a file, navigate to the desired folder location, type the name of the new file in the File Name 
text box and click Save.

· To use context sensitive help, click the ‘What’s This’ button then click on the dialog box item you want 
more information on. An applicable help screen will be displayed.

· Click the Close button to close the File dialog box.



Recording Soundfiles
The first step in beginning a new project is to record soundfiles or otherwise bring soundfile data into the 
SAW32/SAWPlus32 environment. Soundfiles can be recorded directly to the SoundFile View window or, 
for more complex or synchronized recording operations, directly to the MultiTrack View window.

To begin, press the red REC (record) button located at the right edge of the SoundFile View control button
bar. This will display the Record Panel and the Record Remote Transport windows.

The Record Panel is used to set up the parameters for the current recording session. The Record Remote
Transport window is used to initiate and control the recording process.

The top of the Record Panel displays the currently selected wave device (sound card).

F If more than one wave device is installed, you may choose which device you wish to record to by 
clicking in the blue OUT display box (next to the REC button) prior to opening the Record Panel.

Before recording a soundfile, you must first set the basic file parameters and name the file.

èTo Set Recording Parameters:

1. Select a samplerate. Click the Samplerate Selector button. A popup list of available samplerates is 
displayed. Either choose one of the preset rates or enter a custom samplerate by choosing the 
Custom option. The higher the rate, the better the quality. 44100 Hz is the same rate as an audio CD
and is one of the most commonly used rates in digital audio.

2. Select a file type: Stereo creates a stereo soundfile, keeping the left and right audio information 
intact; Mono L+R creates a mono soundfile summing together the right and left audio information; 
Mono L/R creates one or two individual mono soundfiles keeping the left and right information 
separate.

3. Select a bit resolution. (The higher the resolution, the better the quality). Sixteen bit is the same 
resolution as an audio CD and is one of the most commonly used resolutions in digital audio.

4. If the file type is Stereo or Mono L+R, click the FileName button to display the file dialog box and 
name the file.

If the file type is Mono L/R, click the Left button to display the file dialog box and name the file that 
will contain the left input audio data. Click the Right button to name the file that will contain the right 
input audio data. You may use one or the other, or both, in which case SAW32/SAWPlus32 will 
automatically split the audio data into two separate files at the same time.

F If you select a pre-existing filename, the original data will not be overwritten, instead the new 
recording will be appended to the end of the existing data.

5. Click Save.

Next you should set the recording volume levels.

èTo Set Volume Levels:

1. In the Record Remote Transport window, click the RecRdy button (Or press the * key). This 
activates the meters and places SAW32/SAWPlus32 in Record Ready mode.

2. Start the audio source playback and observe the meter levels.

3. For the best signal to noise ratio (sound quality), if possible, adjust source levels outside of the 



SAW32/SAWPlus32 environment by using external volume controls or your sound card’s mixer 
applet. Meter levels should average mostly in the yellow area with some peaks reaching slightly into 
the red area. Margin readings should be between 60-80%.

4. If necessary to fine-tune volume levels, adjust the red record faders by clicking and dragging a fader
knob.

F By default both Faders are latched together. Adjusting either one moves both. Holding the Shift 
key breaks the latch, allowing you to adjust either one individually. Clicking the right mouse 
button while adjusting either Fader resets both to zero. You may also click in the incremental 
Fader zone to the right of either Fader to step up or down in ¼ dB increments. Clicking above 
the red zero dB lines will increase the level. Clicking below the lines will decrease the level.

I Regarding Fader Processing: When the SAW32/SAWPlus32 Faders are set to zero dB (default), 
incoming audio data is not processed in any way. The saved soundfile data is an exact replica of the 
data delivered from the sound card. When the Faders are not set to zero, SAW32/SAWPlus32 alters 
each sample by scaling the data according to the Fader settings.

èTo Start and Stop Recording:

1. To start recording, click the Rec button (or press the Enter key) in the Record Remote Transport 
window.

2. To stop recording, click the Stop button (or press the Enter key) in the Record Remote Transport 
window.

F If the Enter key is pressed, the operation will toggle back to Record Ready mode. To turn off 
Record Ready mode, click the Stop button (or press the * key).

èTo Save the Soundfile and Close the Record Panel:

1. In the Record Panel, click the Close/Save button. This saves the soundfile and instantly opens it in 
the Full View and SoundFile View windows, ready for editing.

More About the Record Windows

There are many other features in the Record Panel and Record Remote Transport windows. These 
features add powerful versatility and functionality to the basic recording operation. As you read on, you’ll 
discover many variations in the way soundfiles can be recorded in the SAW32/SAWPlus32 environment.

See Also:

Title Bar 

Time Readouts 

Time Remaining/Drive Selector 

Track Indicators 

Control Buttons 





Title Bar - Record Panel and Record Remote Transport Windows
The Record Panel and the Record Remote Transport windows can be moved by dragging their respective
title bars.

See Also:

Time Readouts 

Time Remaining/Drive Selector 

Track Indicators 

Control Buttons 



Time Readouts - Record Panel
The left and right Elapsed Time readouts display the current time position in both the left and right 
soundfiles being recorded. Only the left readout will be used when the file type is Stereo or Mono L+R. 
Each time recording is stopped and restarted, the Elapsed Time continues to increase, reflecting the size 
of the growing soundfiles.

The Current Rec Time readout displays the time elapsed since last engaging record mode. Each time 
recording is stopped and restarted, the reading resets to zero.

See Also:

Title Bar 

Time Remaining/Drive Selector 

Track Indicators 

Control Buttons 



Time Remaining/Drive Selector - Record Remote Transport
The Time Remaining readout shows the recording time remaining on the selected drive at the current 
recording parameters. To change the drive, click the left or right drive selector arrows.

See Also:

Title Bar 

Time Readouts 

Track Indicators 

Control Buttons 



Track Indicators - Record Panel
The Track Indicators display the current tracks assigned to the left and right channels of the current 
recording. When recording directly in the SoundFile View window, they will indicate SF for soundfile. 
When recording directly in the MultiTrack View window, they will indicate the respective track 
assignments.

See Also:

Title Bar 

Time Readouts 

Time Remaining/Drive Selector 

Control Buttons 



Control Buttons - Record Panel/Record Remote Transport 

All (Record Panel)
The Retake All button allows you to clear the entire soundfile starting over again from the zero position.

H/S (Record Remote Transport)
The H/S (Hide/Show) button is used to toggle between hiding and showing the SAW32/SAWPlus32 
program workspace. When first clicking the H/S button in a window, the program workspace will be 
hidden, leaving that window on top. Clicking the H/S button again re-displays the workspace. This allows 
SAW32/SAWPlus32 to be controlled remotely while inside of another application.

Keep Take (Record Panel) 
The Keep Take button is not used in the SoundFile View and will be discussed in the MultiTrack 
Recording section.

Reset (Record Panel)
The Reset button clears the meter display and resets the Margin readout to 0%. It may be clicked at any 
time prior to or during recording.

Retake (Record Panel)
The Retake button allows you to throw away the last recorded segment and record over again from the 
same soundfile start position. This keeps soundfiles from continually increasing in size if you make 
mistakes during recording.

S-R-P (Record Remote Transport)
The S-R-P button is not used in the SoundFile View and will be discussed in the MultiTrack Recording 
section.

TL (Record Remote Transport)
The TL (Top Latch) button is used to latch a window to other windows containing H/S buttons. When any 
H/S button is clicked in any window, all windows with the TL button clicked will also remain on top.

See Also:

Title Bar 

Time Readouts 

Time Remaining/Drive Selector 
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Full View Window 
The Full View window shows the entire current soundfile waveform, compressed to fit in the window, 
regardless of its size. On stereo files, both the left and right channels are summed together and displayed
as mono. Its main purpose is to provide instant access to any part of a soundfile. Once a place of interest 
has been located, the position can be transferred to the SoundFile View for detailed work by clicking in 
the Time Line at the desired transfer point.

The Full View cursor is displayed as a line that reaches from the top to the bottom of the Full View 
window, representing the current playback position.

See Also:

Title Bar 

Time Line Display 

Full View Operation 



Title Bar - Full View
If no soundfile is currently active, the title bar displays the words Full View. When a soundfile is loaded, 
the pathname and length of the soundfile is also displayed. The window may be moved by dragging the 
title bar. The window may also be sized by dragging any of the window borders.

See Also:

Time Line Display 

Full View Operation 



Time Line Display - Full View
Along the bottom edge of the window is the Time Line display, a light yellow horizontal bar that shows 
reference times and also links the Full View position to the SoundFile position. In the Time Line display 
area you will see reference numbers indicating either STANDARD time, SMPTE time or SAMPLE 
position, depending on what mode is currently active. The mode is displayed in the right corner of the 
Time Line as H:M:S.ms for STANDARD time, SMPTE for SMPTE time, and SAMPLES for SAMPLE 
position.

See Also:

Title Bar 

Full View Operation 



Full View Operation
Cursor Positioning in Full View
Clicking with the left mouse button controls the placement of the Full View cursor within the soundfile, 
determining the current playback position.

You may position the cursor anywhere within the window, even while the file is playing, and playback will 
immediately continue from the new position.

Playback in Full View
When the Full View window is the active window, you may start and stop playback by clicking the right 
mouse button, or pressing the spacebar, or pressing the Play button in the Remote Transport window.

Stopping in the Full View window acts as a pause control, and playback will resume from where you last 
stopped. The Full View cursor will follow the playback and you may use this view as an overall visual 
reference to your current soundfile.

Link To SoundFile View
Clicking the Time Line area of the Full View window (or pressing the T key) will transfer the cursor 
positions to exactly the same point in the SoundFile View window.

Link to Remote Transport Window to Full View
When the Full View window is active, the Remote Transport window displays the current Full View cursor 
position.

See Also:

Title Bar 

Time Line Display 



SoundFile View Window
The SoundFile View waveform display can be zoomed and magnified to facilitate defining Editpoints and 
Regions.

This view shows both the left and right channels of a stereo file in detail. The left channel is displayed on 
top, the right on the bottom. Mono files show only one channel. You may zoom in or out to display the 
audio waveform data in more or less detail. You may also magnify the amplitude (height) of the display to 
see low volume waveform data in more detail.

The SoundFile View cursor is displayed as a line that reaches from the top to the bottom of the SoundFile
View window. The cursor position is set by the user, and determines playback start position as well as 
Region boundary positions, and defines a point of action for various editing functions.

The SoundFile View Tracking cursor is displayed as an alternate colored line that moves during playback,
tracking the current position. This cursor is not user adjustable.

See Also:

Title Bar 
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Control Buttons 

SoundFile View Operation 

Special Keyboard Functions 



Title Bar - SoundFile View
If no soundfile is currently active, the title bar displays the words SoundFile View. When a soundfile is 
loaded, the pathname, samplerate, bit resolution and the number of tracks (channels) is also displayed. 
The window may be moved by dragging the title bar. The windows may also be sized by dragging any of 
the window borders.

See Also:

Time Line Display 

Control Buttons 

SoundFile View Operation 

Special Keyboard Functions 



Time Line Display - SoundFile View
Along the bottom edge of the window is the Time Line display, a light yellow horizontal bar that shows 
reference times and is also used to create a Marked Area of the soundfile for special editing functions. In 
the Time Line display area you will see reference numbers indicating either STANDARD time, SMPTE 
time or SAMPLE position, depending on what mode is currently active. The mode is displayed in the right 
corner of the Time Line as H:M:S.ms for STANDARD time, SMPTE for SMPTE time, and SAMPLES for 
SAMPLE position.

See Also:

Title Bar 

Control Buttons 

SoundFile View Operation 

Special Keyboard Functions 



Control Buttons - SoundFile View
*Button descriptions are followed by keyboard equivalents if applicable.

In Full (Ctrl and +)
The In Full button takes the waveform display to the maximum zoomed-in view of one sample per pixel.

SAW32/SAWPlus32 will remember your previous zoom level and you may return to it by simply pressing 
the Zm Out button. If you press the In Full button twice in a row, you will clear the previous zoom level 
memories.

Zm In (+) in SoundFile View
The Zm In button zooms the waveform display in to the next level and decreases the time reference 
increments in the Time Line display. The zoom-in amount is based on the increment factor specified using
the Zoom In/Out Factor under the Options menu. Use this button to help find a comfortable display of 
visual detail for the particular waveform you are working with.

F SAW32/SAWPlus32 uses special peak data files to display waveforms quickly at decreased zoom 
levels. As the zoom level increases beyond a certain point (soundfile length dependent), 
SAW32/SAWPlus32 displays true, sample-accurate, vector graphic waveform displays for precise 
representation of the actual waveform.

Zm Out (-) in SoundFile View

The Zm Out button zooms the waveform display out to the next level and increases the time reference 
increments in the Time Line display. The zoom-out amount is based on the increment factor specified 
using the Zoom In/Out Factor under the Options menu. Use this button to help find a comfortable display 
of visual detail for the particular waveform you are working with.

Out Full (Ctrl and -)
The Out Full button takes the waveform display to the maximum zoomed-out view that attempts to display
the complete soundfile at once. This view will be very similar to the Full View window display.

SAW32/SAWPlus32 will remember your previous zoom level and you may return to it by simply pressing 
the Zm In Button. If you press the Out Full button twice in a row, you will clear the previous zoom level 
memories.

Up (PageUp)
The Up button increases the amplitude (height) of the waveform display. By using this button, you can 
magnify low level sections of the audio data to help locate and remove background noises.

0 dB (0)
The 0 dB button sets the amplitude of the waveform display so that full digital clipping is reached at the 
top and bottom of the respective channel displays, showing the waveform at the exact recorded level.

When toggling between this button the Up button, the magnified level will be memorized, allowing you to 
easily switch between both levels. If you press this button twice in a row, the magnified level will be reset 
to zero.

Dn (PageDown)



The Dn button decreases the amplitude (height) of the waveform display. By using this button, you can 
reduce magnification of loud sections of audio data that might be extending beyond the visible limits of the
respective channel displays.

Mrk Beg (B)
The Mrk Beg button marks the current SoundFile View cursor position as the beginning boundary of a 
Marked Area of data. If the end boundary is beyond this point, the Marked Area between boundaries will 
be highlighted in both the SoundFile View window and the Full View window.

Mrk End (E)
The Mrk End button marks the current SoundFile View cursor position as the ending boundary of a 
Marked Area of data. If the beginning boundary is before this point, the Marked Area between boundaries 
will be highlighted in both the SoundFile View window and the Full View window.

F You may clear the Marked Area at any time by pressing the C key, or by setting the end point before 
the beginning point. The Marked Area is used to create Regions and to define boundaries for many of
the SAW32/SAWPlus32 processing functions.

Out
The Out display box is used to select a sound card for recording or playback from the SoundFile View 
window. Clicking in the blue display box will display a popup menu allowing you to select the desired 
sound card. All wave devices that have been specified in the Audio Hardware Setup section under the 
Options menu will be listed.

Rec
The red Rec button opens the Record Panel to initiate recording a soundfile directly to the SoundFile 
View window.

F Once recording is finished, the waveform will be instantly displayed in both the SoundFile View and 
Full View windows. Recording in the SoundFile View records raw audio data that is not inherently part
of the current EDL session or has no basis in time for that session until placed in the MultiTrack View.

See Also:

Title Bar 

Time Line Display 

SoundFile View Operation 
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SoundFile View Operation
Cursor Positioning
Clicking with the left mouse button controls the placement of the SoundFile View cursor within the 
soundfile, determining the current starting playback position. This start position will remain fixed when 
playback begins, allowing an instant re-cue when playback is stopped and restarted.

» This is a very powerful tool for setting a precise editpoint. Zoom-in, place your cursor, and repeatedly 
toggle playback on and off to quickly audition the accuracy of your editpoint selection. This technique 
literally makes the complex process of scrubbing obsolete!

Double-clicking on a specific point within the waveform display causes that point of the waveform to be 
centered in the display and makes that the new SoundFile View cursor position.

You can also center the current SoundFile View cursor position by pressing the = key.

You can transfer the SoundFile View cursor position to the Tracking cursor position by pressing the T key, 
even during playback.

You can drag the cursor from one point to another within the waveform display and see a relative distance
readout within the Remote Transport window that updates as you drag, providing there is no currently 
Marked Area.

SoundFile View Navigation
There are many ways to move around within the SoundFile View window.

The scroll bar along the bottom of the window allows you to quickly position the display anywhere within 
the current SoundFile at any zoom level. You may click the left or right scroll arrow to move one screen at 
a time or drag the scroll box with the mouse to jump to a relative position in the soundfile.

Clicking in the scroll bar to the left or right of the scroll box jumps the cursor position to the beginning or 
end of the file. This modification to the standard Windows interface allows much faster navigation and is 
more appropriate for this type of application.

F If you jump your position accidentally by clicking to the left or right of the scroll box, you may instantly 
return to your last position by pressing the Shift key and clicking in the scroll box.

SAW32/SAWPlus32 also features dynamic scrolling in the SoundFile View. Both edges of the waveform 
display are active zones. Clicking near the left or right edge of the waveform display causes the display to
page left or right, respectively.

If you drag the cursor to the left or right edge of the waveform display, the screen will scroll automatically 
as long as there is movement of the mouse in that direction. You can adjust the scrolling speed by setting 
the Wave Display Scroll Factor located in the Options menu.

Marking Areas in SoundFile View
Dragging the SoundFile View cursor while the mouse is positioned in the Time Line display defines a 
Marked Area. The beginning boundary is defined by where you start the drag, while the end boundary is 
defined by where you end the drag.

F Once an area is defined, you can alter either boundary by clicking inside the Time Line display near 
the boundary and dragging it to a new position.



Pressing the B and E keys (or MRK BEG and MRK END buttons) also define the beginning and end of a 
Marked Area.

F Pressing the Ctrl key and any one of the B, E, MRK BEG, or MRK END buttons defines the entire 
soundfile as a Marked Area.

A Marked Area is inverse highlighted, clearly showing the area between the boundaries, and the length of 
the Marked Area is displayed in the Remote Transport display window.

Clearing a Marked Area in SoundFile View
To clear a Marked Area in the SoundFile View, click with the right mouse button anywhere in the Time 
Line display or press the C key.

Playback
Several options are available to control audio playback in the SoundFile View. When the SoundFile View 
is the active window, pressing the Spacebar or clicking the right mouse button toggles between play and 
stop. The Play and Stop buttons on the Remote Transport window can also be used.

If a Marked Area is defined, the Play Mark button on the Remote Transport window can be used to play 
back just that area. Pressing the Shift key and clicking the right mouse button will perform the same 
function.

F If the SoundFile View cursor is outside of the Marked Area, playback begins from the beginning of the
Marked Area and plays back the entire area. If the cursor is within the boundaries of the Marked Area 
however, playback begins at the cursor position and plays to the end of the area.

If a Marked Area is defined, the Play Loop button on the Remote Transport window can be used to play 
back and loop just that area. Pressing the Ctrl key and clicking the right mouse button will perform the 
same function.

F If the SoundFile View cursor is outside of the Marked Area, playback begins from the beginning of the
Marked Area and plays back and loops the entire area. If the cursor is within the boundaries of the 
Marked Area however, playback begins at the cursor position and plays to the end of the area and 
loops back to the beginning. While the loop is playing, the begin and end points can be redefined on-
the-fly by clicking anywhere in the display area.

It’s important to understand that the playback function in the SoundFile View is optimized for previewing 
editpoints. At times two cursors will be displayed, the normal SoundFile View cursor and a separate 
SoundFile View Tracking cursor.

Normal playback begins at the SoundFile View cursor. The SoundFile View Tracking cursor displays the 
current playback position as playback proceeds. Stopping and starting again automatically places the 
SoundFile View Tracking cursor back to the SoundFile View cursor position and playback begins again 
from that original position.

Loop Scrub Mode
Loop Scrubbing is an alternative method of searching for an editpoint, when the visual display data 
contains no easily recognizable transient information. (For example, finding the exact beginning of an ‘s’ 
sound in the middle of a vocal dialog).

To enter Loop Scrub mode, press the Ctrl key and click the left mouse button. You have now grabbed the 
SoundFile View cursor while playback of a tight loop is activated. You may release the Ctrl key but keep 
pressing the left mouse button. You may now slowly slide the cursor position back and forth, listening for 



an audible change that defines your hard-to-see editpoint. The cursor position defines the end of the loop 
that is playing.

While still in this mode, you may change the length of the scrub loop by using the Up and Down arrow 
keys. Pressing the Left arrow key takes you back to the default loop size. Pressing the Right arrow key 
takes you to your adjusted loop size. Pressing the Left arrow key twice resets the adjusted size back to 
the default. You may also use the keyboard keys to adjust zoom and magnification level while Loop Scrub
is active. Releasing the left mouse button exits Loop Scrub mode.

Sample Edit Mode
Sample Edit mode allows you to see and manipulate the individual samples that are part of a soundfile. 
Sample Edit mode is engaged when you zoom in past the IN FULL position. When Sample Edit mode is 
active, the mouse pointer changes to an X-shape.

Sample Edit mode displays the individual samples spread further and further apart as you continue to 
zoom in. Each sample is represented as a small square within the waveform display. Pressing the Shift 
key and clicking near a sample square snaps the mouse pointer directly on top of the sample. You may 
now drag the sample up or down in the display, instantly changing the actual sample value directly in the 
SoundFile.

I Regarding Sample Edit Mode: This is a destructive process with no automatic Undo. To restore 
settings, you must manually drag the individual samples back into position.

Zooming out past the IN FULL position disengages Sample Edit mode. Any process that opens a different
soundfile will also disengage Sample Edit mode.

F Sample Edit mode is an incredibly powerful feature for removing clicks, pops, or any other unwanted 
random noises that appear as out of place samples when compared to neighboring samples. Even 
clipped soundfiles can sometimes be fixed in Sample Edit mode by adjusting the samples 
surrounding the clipped portion of the waveform attempting to reshape the wave to remove the 
distortion.

Link to Remote Transport Window 
When the SoundFile View window is active, the Remote Transport window displays the current SoundFile
View cursor position.

See Also:
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Special Keyboard Functions - SoundFile View
These are extra SoundFile View keyboard functions that, in many cases, have no menu option or control 
button equivalent.

Ctrl and Left/Right Arrow Keys in SoundFile View
Pressing Ctrl and clicking the Left/Right arrow keys moves the SoundFile View cursor to the beginning or 
ending boundary of the Marked Area.

Home/End Keys in SoundFile View
The Home/End keys moves the SoundFile View cursor to the beginning or end of the soundfile.

Left/Right Arrow Keys in SoundFile View
Pressing the Left/Right arrow keys move the SoundFile View cursor one pixel left or right. The amount of 
actual samples this represents depends on the current zoom level.

M Key in SoundFile View 
The M key drops an SF (soundfile) Marker at the current SoundFile View cursor position, even during 
playback. See the Markers View Window section for more detail.

Shift and Left/Right Arrow Keys
Pressing Shift and clicking the Left/Right arrow keys moves the SoundFile View cursor one pixel left or 
right, and also extends or contracts the closest Marked Area boundary to the current cursor position.

Z Key in SoundFile View
The Z key moves the SoundFile View cursor position to the nearest zero crossing point. The program 
looks for the lowest left/right average waveform value within a small range before and after the current 
cursor position.

F Use this tool to help find the best editpoint for creating quiet splices.

See Also:
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Regions View Window
Regions are the building blocks of your production. They are the core elements that give non-linear 
editing its power. The Regions View window alphabetically lists all Regions in the current editing session.

F A Region is simply a link to a Marked Area that has been named and saved, and contains various 
elements about that area such as the begin and end points, the pathname of the soundfile that 
contains the area, and the zoom levels at the time the region was created. It does NOT contain the 
actual audio data.

» Because Regions are merely links to the audio data and not the actual audio data itself, manipulating 
and building a production using Regions can literally be done instantaneously due to the fact that you 
are not moving and processing massive amounts of data during the creation of your project. For 
example, in a typical cut and paste linear editing environment, copying an area of audio data any 
number of times requires moving and duplicating potentially hundreds of thousands of bytes of data, 
whereas Regions move and duplicate no data whatsoever.

See Also:
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Title Bar- Regions View
The title bar displays the words Regions View. The window may be moved by dragging the title bar. The 
window may also be sized by dragging any of the window borders.

See Also:

ADD TO MT Control Button 

Regions View Operation 



ADD TO MT Control Button
The Add TO MT button adds the currently selected Region to the active (hot) track in the MultiTrack at the 
current MultiTrack View cursor position.

See Also:
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Regions View Operation
Creating Regions
Creating Regions in SAW32/SAWPlus32 is easy. There area many ways this can be accomplished - 
some directly, and some indirectly. Here are two of the most common methods to create a Region.

èTo Create a Region Using the Regions Menu:

1. Define a Marked Area in the SoundFile View window.

2. From the Regions menu, select Create New Region.

3. In the Input Text box, specify a new Region name, or accept the default unique numbered name.

4. Click OK. The new Region will appear in the Regions View window in alphabetical order.

» Group Regions in the Regions View window, by utilizing alphabetical naming conventions.
Example:

Vocal - Beginning Phrase
Vocal - Center Phrase
Vocal - Ending Phrase

èTo Create a Region Using Drag and Drop:

1. Define a Marked Area in the SoundFile View window.

2. With the SoundFile View as the active window, hold the Shift key and click and release the left 
mouse button. The cursor will change in appearance.

F A new Region will automatically be created and named with the soundfile name and a unique 
number identifier. The new Region will appear in the Regions View window in alphabetical order.

3. Position the new cursor onto an empty area of a track in the MultiTrack View and click the left mouse
button to drop the newly created Region in place.

F You may cancel the drop operation by clicking anywhere outside the MultiTrack View window.

You may freely open other soundfiles at any time, without disturbing the current session, including already
existing Regions and MultiTrack Entries. In this way, you can create new Regions, one at a time, from 
many different soundfile sources, blending them all into one session.

Inserting Regions onto the MultiTrack

èTo Insert a Region Using the Add TO MT Button:

1. In the MultiTrack View window, select the track and position where you would like to insert the 
Region by clicking the left mouse in the desired location.

2. In the Regions View window, click the left mouse button the desired Region name.

3. Click the Add TO MT button.

èTo Insert a Region Using Drag and Drop:



1. Hold the Shift key and click and release the left mouse button on the desired Region name. The 
cursor will change in appearance.

2. Position the new cursor onto an empty area of a track in the MultiTrack View and click the left mouse
button to drop the selected Region in place.

F You may cancel the drop operation by clicking anywhere outside the MultiTrack View window.

» Add more copies of the same Region by making the MultiTrack View window active and pressing the
A key.

Viewing Existing Regions

èTo View an Existing Region:

1. In the Regions View window, double-click the desired Region. The soundfile linked to this Region 
will be instantaneously loaded and displayed in the SoundFile and Full View windows at the 
Region’s original zoom levels.

Modifying Existing Regions

èTo Modify an Existing Region:

1. In the Regions View window, double-click the desired Region to view.

2. Modify any Region setting you desire (such as boundaries, zoom levels, etc.)

3. From the Regions menu, select Update Region.

4. In the Input Text dialog box, accept the existing name or rename the Region.

5. Click OK.

Playing Back an Existing Region

èTo Playback an Existing Region Using the Mouse:

1. In the Regions View window, click the left mouse button on the desired Region name.

2. Click the right mouse button anywhere inside the Regions View window. The linked soundfile will be 
loaded (if needed), and the Marked Area (the selected Region) will be played.

èTo Playback an Existing Region Using the Keyboard:

1. With the Regions View as the active window, use the Up and Down arrow keys to select a Region.

2. Press the Enter key to load and play the Region.

F While a Region is playing, you may use the arrow keys to select another Region without 
affecting current playback. Pressing the Enter key will cancel the current playback, and load and
play the newly selected Region.



Deleting an Existing Region

èTo Delete an Existing Region Using the Regions Menu:

1. In the Regions View window, click the left mouse button on the desired Region name.

2. From the Regions menu, select Remove Region. The Region will be deleted from the Regions View 
window and from the MultiTrack View window if currently being used on one or more tracks. All 
following MultiTrack Entries on the same track(s) will be left undisturbed in their current positions.

3. From the Regions menu, select Delete Region. The Region will be deleted from the Regions View 
window and from the MultiTrack View window if currently being used on one or more tracks. All 
following MultiTrack Entries on the same track(s) will be shifted to the left replacing any resulting 
gaps.

èTo Delete an Existing Region Using the Keyboard:

1. In the Regions View window, select the desired Region.

2. Press the Delete key. The Region will be deleted from the Regions View window and from the 
MultiTrack View window if currently being used on one or more tracks. All following MultiTrack 
Entries on the same track(s) will be left undisturbed in their current positions.

3. Hold the Shift key and press the Delete key. The Region will be deleted from the Regions View 
window and from the MultiTrack View window if currently being used on one or more tracks. All 
following MultiTrack Entries on the same track(s) will be shifted to the left replacing any resulting 
gaps.

Link to SoundFile and Full View
Double-clicking on a Region in the list causes the linked soundfile to be loaded and displayed in the 
SoundFile View, with the region shown at the zoom level it was saved at. The soundfile is also displayed 
in the Full View.

F Pressing the Ctrl key while double-clicking overrides the saved zoom levels and displays the Region 
at the current SoundFile View zoom levels.

See Also:
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MultiTrack View Window
The MultiTrack View window is the heart of the SAW32/SAWPlus32 non-linear environment, where, like a
jigsaw puzzle, all the components come together to create the final production - the final masterpiece. 
And like a puzzle, different pieces (MultiTrack Entries) can be taken out, moved, and tried in other places 
until you find the perfect “fit”. MultiTrack View combines its incredible power and functionality with ease of 
use, making it unbelievably fast and easy to produce a high quality production that even the high dollar 
systems envy.

The MultiTrack View window displays and provides real-time playback of up to 24 tracks (eight for 
SAW32) of audio data, accommodating any combination of stereo or mono files, samplerates or bit 
resolutions at the same time.

The default workspace normally shows four tracks, but you may view all or any number of tracks by 
dragging the window border to a different size. Audio Regions can be placed in the MultiTrack, where they
are displayed as colored blocks (blue by default), and referred to as MultiTrack Entries (MT Entries).

The window has multiple zoom levels and can display audio waveforms when desired. It is also possible 
to record directly to the MultiTrack.

The MultiTrack also handles all of your mixing needs with virtual faders and pan controls. Audio effects 
processing on each track, such as equalization, delay, compression, etc. further adds to the 
comprehensive capabilities available for the creation of your projects.

This workspace can be used for something as simple as combining a music bed with a voice-over, or for 
creating complex audio productions utilizing thousands of entries with full mix automation and effects 
processing.

In general, the MultiTrack should be considered the most powerful and significant part of the 
SAW32/SAWPlus32 environment. Essentially, this is where it all comes together.

I Regarding MultiTrack Entries: For many of the MT Entry manipulation functions, entries that are 
butt-spliced will be considered as one unit. Operating on one entry will affect all following butt-spliced 
entries, moving them accordingly. 

Entries that are separated by a blank space will be considered as separate. In most cases, operating 
on one entry will leave following entries unaltered. If an operation conflict occurs (requiring following 
entries to be moved), the operation will either be cancelled or you will be prompted for confirmation to 
move the following entries.
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Title Bar - MultiTrack View
If no editlist is currently active, the title bar displays the words MultiTrack View, followed by the current 
MultiTrack samplerate. Once an editlist is loaded or created, the pathname of the editlist file is displayed 
as well. The window may be moved by dragging the title bar. The window may also be sized by dragging 
any of the window borders.
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Time Line Display - MultiTrack View
Along the bottom edge of the window is the Time Line display, a light yellow horizontal bar that shows 
reference times and is also used to create a Marked Area for special editing functions. In the Time Line 
display area you will see reference numbers indicating either STANDARD time, SMPTE time or SAMPLE 
position, depending on what mode is currently active. The mode is displayed in the right corner of the 
Time Line as H:M:S.ms for STANDARD time, SMPTE for SMPTE time, and SAMPLES for SAMPLE 
position.

See Also:
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Normal Tracks and Output Tracks
In addition to the 24 normal tracks (eight for SAW32), there are eight Output tracks (four for SAW32), one 
for each available sound card. These special tracks are the last tracks at the bottom of the MultiTrack and 
are distinguished by different colors for both the controls and tracks. They provide master volume controls
and effects processing capabilities for each sound card output.

F Use an output track to control the volume of the overall mix being sent to a specific sound card, or 
perform a master fade across multiple tracks assigned to that sound card output. Patching effects on 
an output track applies those effects to all tracks assigned to that sound card output.

See Also:
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Hot Tracks - MultiTrack View
One track is bordered by two white horizontal lines and is referred to as the Hot Track. The Hot Track is 
the target track for many MultiTrack operations. Clicking on any track selects it as the Hot Track.

See Also:
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Control Buttons - MultiTrack View
*Button descriptions are followed by applicable keyboard commands.

I Regarding the PreLoad Queue Buffer Setting: Many controls can be operated in real-time during 
playback. The time it takes for a control to respond during playback is directly related to the PreLoad 
Queue Buffer setting. This setting can be adjusted in the Audio Hardware Setup option located in the 
Options menu. Smaller numbers result in faster response times.

Making changes during playback can seriously tax the CPU for a moment as the MultiTrack re-cues 
and changes are applied. Depending on the speed of your computer and the complexity of the 
session, playback may be interrupted. Increasing the PreLoad Queue Buffer setting may resolve the 
situation, but will result in slower response times.

Track Number display
By default, the Track Number Display boxes start track numbering sequentially from 1 to 24 (one to eight 
for SAW32).

You can drag any track to a new location in the MultiTrack by dragging the track’s number display box up 
or down to a new position.

F This is useful when you wish to place two non-sequential tracks side by side for editing purposes, for 
example, to align a musical downbeat on track three with a cymbal crash on track eight.

Pressing the Ctrl key and clicking on any Track Number Display box reorders the tracks sequentially.

Solo
Clicking the Solo button mutes all other tracks so that the current track is the only one you hear during 
playback. Placing multiple tracks in Solo mode allows you to hear a mix of only those selected tracks.

Pressing the Ctrl key and clicking on any Solo button clears all solos at once.

Mute
Clicking the Mute button on any track will mute or turn that track off to exclude it from playback. Placing 
multiple tracks in Mute mode allows you to hear a mix excluding those tracks.

Pressing the Ctrl key and clicking on any Mute button clears all mutes at once.

Fader Icon
Clicking on the Fader icon displays the Fader and Pan Control window for that particular track. We refer 
to this as Open Fader View.

F Fader windows have special “on top” status that prevents them from being hidden as you work with 
other windows.

The track’s entry color changes and two horizontal lines representing pan and volume levels are 
displayed. The top line indicates pan information (red when in the center default position) and the bottom 
line indicates volume information (yellow when in the 0 dB default position).

Press the Ctrl key and clicking on any Fader icon opens Faders for all tracks at once.



F All Fader windows will be stacked on top of each other. Clicking on any track in the MultiTrack will 
cause its particular Fader window to come to the top, ready for use.

To close a Fader window, click its close button or the corresponding Fader icon. When multiple Faders 
are open, pressing the Ctrl key and clicking any Fader close button closes all Faders at once.

Details on Fader operation are discussed in the Controlling the Mix section.

Out
The Out display box is used to select a sound card for recording or playback for that particular track. 
Clicking in the blue display box will display a popup menu allowing you to select the desired sound card. 
All wave devices that have been specified in the Audio Hardware Setup section under the Options menu 
will be listed.

Pressing the Ctrl key while selecting a sound card default all tracks to the same card.

FX Icon
Clicking the FX icon displays the Effect Patch Builder window. This window displays a list of all built-in 
and installed PlugIn effects. It allows you to patch in various combinations of processing effects for that 
particular track.

Pressing the Ctrl key and clicking on any FX icon clears all FX patches from all tracks at once.

Details on effects operation are discussed in the Using Effects section.

Rec
Clicking the Rec button opens the Record Panel to initiate recording directly to the MultiTrack.

Details on recording to the MultiTrack are discussed in the MultiTrack Recording section.

Return to Zero Hot Zone
The gray section just to the right of the Rec button is a “hot zone” that snaps the playback cursor 
immediately to the beginning of the MultiTrack production.

Zm In (+)
The Zm In button zooms the MultiTrack display in to the next level and decreases the time reference 
increments in the Time Line display. Use this button to help find a comfortable display of visual detail for 
the particular session you are working with.

Zm Out (-)
The Zm Out button zooms the MultiTrack display out to the next level and increases the time reference 
increments in the Time Line display. Use this button to help find a comfortable display of visual detail for 
the particular session you are working with.

Rate
Clicking the Rate button displays the Set MTRate window. This window selects the default output 
samplerate for the entire session.

» All MT Entries of a different samplerate will be converted live during playback to this default rate. 



Since samplerate conversion is a CPU intensive process, try selecting a default samplerate that 
matches the majority of the soundfiles involved in the production.

In the Set MTRate window, clicking the Out Rate button displays a popup list of available samplerates. 
Either choose one of the preset rates or enter a custom samplerate by choosing the Custom option. Click 
OK to save your choice as the default rate. The new default rate will be displayed in the MultiTrack View 
title bar.

I Regarding Repeated Samplerate Changing: Changing the samplerate of an existing editlist file 
recalculates all entry positions and lengths. It’s possible to accumulate slight position and length 
errors if the setting is changed over and over again. All butt-spliced entries are adjusted to remain 
butt-spliced, but slight discrepancies in start positions and length can occur.

Select Mode (S)
Clicking the Select mode button toggles Select mode on and off. When engaged, the mouse pointer takes
on the button icon shape whenever it is positioned within the MultiTrack View window indicating that 
Select mode is active.

Select mode allows you to select and highlight MT Entries. Entries that are selected may be moved, 
copied, deleted, and manipulated in various ways.

F Select mode is normally engaged with no entries selected. Pressing the Shift key while activating 
Select mode highlights the MT Entries from the previous Select mode operation.

Waveform Display (W)
Clicking on the Waveform Display button toggles MultiTrack waveform display on and off. When active, 
audio waveforms will be displayed inside all MT Entries.

F Zooming, scrolling, or otherwise moving around the MultiTrack window with waveforms displayed can 
slow screen redraws considerably. For faster movement during these operations, toggle waveform 
display off.
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MultiTrack Operation
Cursor Positioning
Clicking with the left mouse button within the current Hot Track controls the placement of the MultiTrack 
View cursor. The cursor is used as a focal point for many MultiTrack operations and functions as well as 
to determine playback and record start position.

F Clicking on another track selects a new Hot Track without changing cursor position. Clicking again in 
the new Hot Track will allow cursor positioning.

Double-clicking within the Time Line display at a specific point causes that point to be centered in the 
display and makes that the new MultiTrack View cursor position.

You can also center the current MultiTrack View cursor position by pressing the = key.

Pressing the Tab key snaps the cursor forward to the next MT Entry boundary on the current Hot Track. 
Pressing Shift and Tab snaps the cursor backward to the previous MT Entry boundary on the current Hot 
Track.

You can drag the cursor from one point to another within the MultiTrack and see a relative distance 
readout within the Remote Transport window that updates as you drag, providing there is no currently 
Marked Area.

Navigation
There are many ways to move around within the MultiTrack View window. The scroll bar along the bottom 
of the window allows you to quickly position the display anywhere within the current session at any zoom 
level. You may click the left or right scroll arrow to move one screen at a time or drag the scroll box with 
the mouse to jump to a relative position in the session.

Clicking in the scroll bar to the left or right of the scroll box jumps the cursor position to the beginning or 
end of the session. This modification to the standard Windows interface allows for much faster navigation 
and is more appropriate for this type of application.

F If you jump your position accidentally by clicking to the left or right of the scroll box, you may instantly 
return to your last position by pressing the Shift key and clicking in the scroll box.

The vertical scroll bar along the right edge of the window allows you to quickly scroll through the tracks. 
You may click the up or down scroll arrow to move one track at a time. Clicking in the scroll bar above or 
below the scroll box jumps the display one screen at a time. Dragging the scroll box with the mouse, 
jumps the display to a relative track location.

SAW32/SAWPlus32 also features dynamic horizontal and vertical scrolling the MultiTrack View. Both 
edges of the MultiTrack display are active zones. Clicking near the left or right edge of the display causes 
it to page left or right, respectively.

If you drag the cursor to the left or right edge of the display, the screen will scroll automatically as long as 
there is movement of the mouse in that direction.

If you drag the cursor to the top or bottom edge of the display, the screen will scroll up or down through 
the tracks as long as there is movement of the mouse in that direction.

You can adjust the scrolling speed by setting the Wave Display Scroll Factor located in the Options menu.



Marking Areas
Dragging the MultiTrack View cursor while the mouse is positioned in the Time Line display defines a 
Marked Area. The beginning boundary is defined by where you start the drag, while the end boundary is 
defined by where you end the drag.

F Once an area is defined, you can alter either boundary by clicking inside the Time Line display near 
the boundary and dragging it to a new position.

Pressing the B and E keys also define the beginning and end of a Marked Area.

F Pressing the Ctrl key and either the B or E key defines the entire MT Entry under the cursor as the 
Marked Area.

A Marked Area is inverse highlighted on the Hot Track, clearly showing the area between the boundaries, 
and the length of the Marked Area is displayed in the Remote Transport display window. Changing Hot 
Tracks transfers the Marked Area to the newly selected track.

F Even though the highlighting is displayed only on the Hot Track, certain functions use the Marked 
Area boundaries and apply them to all tracks at the same time.

Clearing a Marked Area 
To clear a Marked Area in MultiTrack View, click with the right mouse button anywhere in the Time Line 
display or press the C key.

Playback
Several options are available to control audio playback in the MultiTrack View. When the MultiTrack View 
is the active window, clicking the right mouse button toggles between play and stop. The Play and Stop 
buttons on the Remote Transport window can also be used.

MultiTrack playback gathers MT Entry audio data for each track, applies mix changes and effects 
processing, performs any necessary format and samplerate conversion, and combines all tracks together,
dispersing them to their assigned sound card outputs in real-time.

F Depending on the complexity of the session, there may be a slight delay before playback begins while
the MultiTrack PreLoad buffers are assembled. The amount of buffers preloaded before playback can 
be adjusted in the MultiTrack PreLoad option under the Window menu.

Pressing the spacebar performs a MultiTrack PreLoad only. Playback can then be initiated instantly on 
cue, with no delay, by pressing the spacebar (or any key) again.

Normal playback begins at the MultiTrack View cursor. The cursor displays the current playback position 
as playback proceeds. Stopping and restarting causes playback to resume from where you last stopped.

F Using the AutoRewind button in the Remote Transport window automatically returns the playback 
cursor to the original starting point when playback is stopped. See Remote Transport Window later in 
this section for more detail.

MultiTrack Link to SoundFile, Full and Regions View
Double-clicking on an MT Entry (or pressing the T key) loads and displays the associated Region, at its 
saved zoom levels, in the SoundFile View and transfers the cursor position to the same relative position 
with the Marked Area representing the Region. This creates a bi-directional link between the two 
windows. The Region can be auditioned, zoomed, or magnified without breaking the link, however, 



adjusting either boundary, altering the Region, will break the link. Adjusting the cursor position to a new 
point within the SoundFile’s Marked Area and then clicking inside the MultiTrack, to make it the active 
window, snaps the MultiTrack cursor to the exact relative sample position as selected in the SoundFile 
View.

The soundfile is also loaded and displayed in the Full View, and selected and highlighted in the Regions 
View.

F To override the Region’s saved zoom levels and hold the current SoundFile View zoom and 
magnification levels when transferring MT Entries, press the Ctrl key while double-clicking.

Link to Sequence View
As you change Hot Tracks in the MultiTrack View, the Sequence View automatically changes and displays
a list of the MT Entries for the newly selected track. When you click on a specific MT Entry in the 
MultiTrack, the Sequence View automatically jumps to that entry.

Link to Remote Transport Window
When the MultiTrack View window is active, the Remote Transport window displays the current MultiTrack
View cursor position.

Working with MultiTrack Entries
Part of the excitement of working in a non-linear environment such as SAW32/SAWPlus32, is the 
creative freedom it offers while assembling and experimenting with many variations of a project until the 
perfect blend of elements comes together.

One of the most powerful design benefits built into the SAW32/SAWPlus32 environment is the ability to 
place Regions as MT Entries on the MultiTrack. Because MT Entries are simply representations of the 
data and are not the actual audio data, the editing operations you perform, and any changes you make to 
them, are virtually instantaneous and will not effect the original audio data. The MultiTrack View works like
a safety net, allowing you to practice, experiment, and redo anything, any number of times, in any order, 
at unbelievable speeds - all while leaving your original soundfile data untouched! This feature alone is an 
audio editor’s dream come true.

èTo Change an MT Entry Boundary Using the Mouse:

1. Confirm that the MT Entry track is the current Hot Track. If not, click once on the track to make it the 
new Hot Track.

2. While pressing the Shift key, click near the desired boundary of the MT Entry you wish to change. 
The mouse cursor changes to the Extend Entry cursor shape and the cursor snaps to the boundary 
edge.

3. Drag the cursor left or right to the new desired position.

4. Release the mouse to resize the MT Entry to the new boundary.

èTo Change an MT Entry Boundary Using the Keyboard:

1. Confirm that the MT Entry track is the current Hot Track. If not, click once on the track to make it the 
new Hot Track.

2. Place the cursor near the desired boundary of the MT Entry you wish to change.

3. Adjust the cursor to the new desired position.

4. Press the U key to update the MT Entry boundary.



I Regarding Adjusting MT Entry Boundaries: The boundary that is updated is the boundary 
closest to the new cursor position. Adjusting the begin boundary in this manner is only possible 
within the front half of the MT Entry, likewise, adjusting the end boundary is only possible within 
the back half.

F If the MT Entry boundary you are adjusting is butt-spliced to an adjacent entry, then both entries are 
adjusted simultaneously, effectively shifting the splice point but not altering the time or meter.

F If you overlap the MT Entry boundary you are adjusting with the boundary of the next or previous 
entry, the MT Entry you are adjusting is sized to fit the gap and is directly butt-spliced to the 
overlapped entry.

èTo Remove an MT Entry Without Disturbing Following Entries:

1. Confirm that the MT Entry track is the current Hot Track. If not, click once on the track to make it the 
new Hot Track.

2. Click to place the cursor within the MT Entry boundaries you wish to delete.

3. Press the Delete key.

4. Click OK or press Enter.

èTo Delete an MT Entry Pulling Following Entries Forward:

1. Confirm that the MT Entry track is the current Hot Track. If not, click once on the track to make it the 
new Hot Track.

2. Click to place the cursor within the MT Entry boundaries you wish to delete.

3. Press the Shift and Delete keys.

4. Click OK or press Enter.

èTo Split an MT Entry into Two Regions Using the Keyboard:

1. Confirm that the MT Entry track is the current Hot Track. If not, click once on the track to make it the 
new Hot Track.

2. Click to place the cursor at the desired split point.

3. Press Ctrl and K to split and keep both entries.

F An MT Entry is based on a single Region. Splitting an entry automatically move the original 
Region’s end boundary forward to the split point and creates and butt-splices a new Region 
from the split point to the end. The name of the new Region is the same as the original with an 
appended unique identifier number.

èTo Split and MT Entry Using the Split Region Toolbar:

1. Confirm that the MT Entry track is the current Hot Track. If not, click once on the track to make it the 
new Hot Track.

2. Click to place the cursor at the desired split point.

3. From the Window menu, select Split Region Toolbar.



4. Click the Split/Keep button to split and keep both entries.

Select Mode
Select mode allows you to select and highlight MT Entries. Entries that are selected may be moved, 
copies, deleted, and manipulated in various ways.

When Select mode is engaged, normal cursor positioning functions are not available with the mouse, and 
cursor remains stationary in its current position. The right mouse button no longer toggles playback, but 
instead is used as part of the selection process.

F Using the mouse within the Time Line display replaces these functions. Marked Areas are unused 
and automatically cleared when Select mode is made active.

èTo Select MT Entries:

1. Click the Select mode button in the MultiTrack (or press the S key)

2. Click an MT Entry with the left mouse button to select and highlight it. You may select multiple 
entries to create a group.

3. To clear all entries and start again, click the right mouse button (or press the C key).

4. To deselect a single entry, press the Ctrl key while clicking the right mouse button on an entry.

F To select a group of entries, click the left mouse button and drag the mouse over the desired entries.
Dragging an imaginary rectangle from the top left corner to the bottom right corner selects all entries
within those boundaries.    (Note: Dragging too fast can cause tiny entries within the group to be 
missed.)

You may also select a range of entries without dragging (and inadvertently missing small entries) by 
selecting the first entry as usual, and pressing the Alt key while selecting the last entry in the range. 
All entries inclusive will be selected. This will work across multiple tracks also, as long as the last 
entry is on the same or higher track number.

èTo Extend MT Entry Selections:

· Pressing the End key after selecting an entry selects all following entries on that track to the end of 
the session.

· Pressing Ctrl and End after selecting an entry selects all following entries on the current Hot Track and 
all tracks below to the end of the session.

· Pressing the Home key after selecting an entry selects all previous entries on that track to the 
beginning of the session.

· Pressing Ctrl and Home after selecting an entry selects all previous entries on the current Hot Track 
and all tracks below to the beginning of the session.

· Press the A key selects all entries in the entire session.

I Regarding Key Entries: The last entry selected is referred to as the Key Entry, which is used by 
certain positioning operations as the reference point for position calculations. Prior to using one of 
these positioning operations, click again on the desired Key Entry to ensure that that entry is used as 



the reference point.

èTo Move Selected MT Entries with the Mouse:

· Pressing the Shift key and dragging any one of the selected entries allows you to move them forward 
or backward in time on the same tracks. Releasing the mouse moves and places the entries at the 
new location.

· Pressing the Ctrl key and dragging any one of the selected entries allows you to move them up or 
down to different tracks without altering their position in time. Releasing the mouse moves and places
the entries at the new location.

F Releasing the Shift or Ctrl key during the move removes the horizontal and vertical constraint and 
allows you to move freely in any direction.

èTo Copy Selected MT Entries with the Mouse:

· Pressing the Shift key and dragging any one of the selected entries allows you to move them forward 
or backward in time on the same tracks. Clicking and releasing the right mouse button at any time 
during the move engages Copy mode. Releasing the mouse copies and places the entries at the new 
location leaving the originals intact. The copies will retain the highlighting in case you want to repeat 
the action.

· Pressing the Ctrl key and dragging any one of the selected entries allows you to move them up or 
down to different tracks without altering their position in time. Clicking and releasing the right mouse 
button at any time during the move engages Copy mode. Releasing the mouse copies and places the
entries on the new tracks leaving the originals intact. The copies will retain the highlighting in case 
you want to repeat the action.

F Releasing the Shift or Ctrl key during the copy removes the horizontal and vertical constraint and 
allows you to move freely in any direction.

F During all move or copy operations, the begin and end boundaries of the entry you are dragging are 
extended vertically across all tracks as reference lines. These can be very helpful for aligning entries 
on different tracks. Another vertical reference line will be displayed at the mouse position within the 
entry you are dragging. This can be very helpful for aligning two specific sample points on different 
tracks.

When performing a Shift key horizontal move or copy operation, the Current Time display in the 
Remote Transport window will show the time where the entry starts and will update as you move the 
entry. Pressing the Alt and Shift keys displays the time at the mouse position within the entry, rather 
than the entry start time.

I Regarding Moving and Copying: The entire range of selected entries from left to right and top to 
bottom forms an imaginary solid block which is not allowed to overlap another entry. If a conflict 
occurs, the move will be cancelled. Overlapping an entry while moving the block left or right restricts 
the move, butt-splicing the overlapped edges.

èTo Snap Selected MT Entries to the Current Cursor Position:

F This operation uses a Key Entry as the reference point for calculating the distance to be moved.

1. After selecting MT Entries, click the entry to be assigned as the Key Entry.



2. Press the Backspace key to snap the selected entries to the current cursor position.

F The left side of the Key Entry aligns itself to the current cursor position and all other entries 
retain their relative positions. If a conflict occurs during the move, the move will be restricted 
possibly leaving the Key Entry short of its intended mark.

è To Remove Selected MT Entries
Without Disturbing Following Entries:

1. Press the Delete key.

2. Click OK or press Enter.

è To Delete Selected MT Entries
Pulling Following Entries Forward:

1. Press the Shift and Delete key.

2. Click OK or press Enter.

Processing Data Back to the Original Soundfiles
Mix changes and effects processing assigned to a track in the MultiTrack can be processed permanently 
back to the original soundfiles if desired. See Process Marked Area Back to Original Soundfile in the 
Using the Menus section for more detail.

Building MixDowns
The entire MultiTrack session, or selected tracks and portions of the session, may be mixed down and 
written to a new soundfile if desired. You may also alter the format, resolution and samplerate during this 
operation if you choose. See Build/Mix Options in the Using the Menus section for more detail.
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Special Keyboard Functions - MultiTrack
These are extra MultiTrack View keyboard functions that, in many cases, have no menu option or control 
button equivalent.

A Key
The A key adds the currently selected Region from the Regions View to the Hot Track at the MultiTrack 
View cursor position.

Ctrl and Left/Right Arrow Keys
The Ctrl and Left/Right arrow keys move the MultiTrack cursor to the beginning or ending boundary of the 
Marked Area.

Ctrl and Page Up/Down Keys
The Ctrl and Page Up/Down keys expand or contract the track width to its maximum or minimum limits.

Home/End Keys
The Home/End keys move the MultiTrack View cursor to the beginning or end of the production.

Left/Right Arrow Keys
The Left/Right arrow keys move the MultiTrack View cursor one pixel left or right. The amount of actual 
samples this represents depends on the current zoom level.

M Key
The M key drops an MT (MultiTrack) marker at the current MultiTrack View cursor position, even during 
playback. See the Markers View Window section for more detail.

Page Up/Down Keys
The Page Up/Down keys increase or decrease the track width in the MultiTrack View. As the tracks 
expand or contract, the window size automatically adjusts.

Shift and Page Up/Down Keys
The Shift and Page Up/Down keys amplify or reduce the waveform display. Press the 0 (zero) key to return 
to Zero dB (the original waveform size).

Up/Down Arrows
The Up/Down arrow keys allow you to move up and down to different tracks in the MultiTrack.

Z Key
The Z key moves the MultiTrack View cursor position to the nearest zero crossing point. The program 
looks for the lowest left/right average waveform value within a small range before and after the current 
cursor position.

F Use this tool to help find the best editpoint for creating quiet splices.
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Sequence View Window
The Sequence View window displays information about all MT Entries on the current Hot Track in the 
MultiTrack. MT Entries are listed in the same order as they are positioned on the track, displaying the 
entry name, In-time, Out-time, and Length, according to the currently selected format: STANDARD time, 
SMPTE time or SAMPLES.

The Sequence View window may be used as a quick reference to entry position information, and as a 
quick navigational tool. It also is used to add special sequence entries that can control the flow of 
playback in the MultiTrack.
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Title Bar - Sequence View
The title bar displays the words Sequence View. The window may be moved by dragging the title bar. The
window may also be sized by dragging any one of the window borders.

See Also:
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Control Buttons - Sequence View
Sequence View Window Expand
The Window Expand button toggles the Sequence View display between a narrow and wide view. The 
narrow view displays the MT Entry names only. The wide view displays all available information. This 
allows you to keep the window small, allowing room for other windows, but expand it quickly when you 
need additional information.

Add Ctrl
Pressing the Add Ctrl button displays the Sequence Control View window which allows special sequence 
entries to be added to control the flow of MultiTrack playback.

F These entries can be moved, copied, deleted, or otherwise manipulated like any other MT Entry.

· The <BREAK> entry causes the MultiTrack playback to stop at the entry position. This stops all tracks
regardless of which track it is placed on. The MultiTrack is automatically cued forward to the end of 
the break entry, ready to play back the next entry if one follows immediately.

F This can be useful for using SAW32/SAWPlus32 as a live performance playback device. 
Production show segments can be automatically stopped and cued for the next segment.

F By activating the Auto MT PreLoad After Break option from the Options menu, an automatic 
preload of the MultiTrack after cueing can also take place.

· The <LOOP TO BEG> entry can be placed anywhere on any track, and when encountered, activates 
MultiTrack Loop mode. This resets the MultiTrack playback to the beginning and automatically restarts
playback of all tracks after the entire production has been played to the end.

F This can be useful for using SAW32/SAWPlus32 as a background music playback device. For 
instance, place two hours of your favorite music on the MultiTrack and use this special entry to 
allow unattended repeated playback for as long as you like.

In-Position Control Zone
When any SMPTE mode is active, you may double-click on the In-time position of a particular entry in the 
Sequence List to display the SMPTE Position window. Entering a SMPTE time in the window and clicking 
OK snaps that entry to the specified SMPTE time. See the Working with SMPTE section for more details 
on using the SMPTE Position window.
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Sequence View Operation
Link to MultiTrack View
Selecting an entry in the Sequence List by clicking with the left mouse button or using the Up/Down arrow
keys snaps the MultiTrack cursor directly to the beginning position of that MT Entry.

Link to SoundFile, Full and Regions View
Double-clicking on an entry in the Sequence List causes the associated Region’s linked soundfile to be 
loaded and displayed in the SoundFile View at the saved zoom levels. The soundfile is also loaded and 
displayed in the Full View, and selected and highlighted in the Regions View.

F Pressing the Ctrl key while double-clicking overrides the saved zoom levels and displays at the 
current SoundFile View zoom levels.

Playing Back an Entry

èTo Play Back an Entry Using the Mouse:

1. In the Sequence View window, click the left mouse button on the desired entry name.

2. Click the right mouse button anywhere inside the Sequence View window. This will initiate normal 
MultiTrack playback starting at that entry’s position.

èTo Play Back an Entry Using the Keyboard:

1. With the Sequence View as the active window, use the Up and Down arrow keys to select an entry.

2. Press the Enter key to initiate MultiTrack playback starting at that entry’s position or press the 
Spacebar to initiate a MultiTrack PreLoad.

F While playback is active, pressing the Up/Down arrow keys to select another entry will 
immediately cue and begin playback at that entry.

èTo Delete an Entry:

1. In the Sequence View window, select the desired entry.

2. Press the Delete key. The entry will be removed from the Sequence View window and from the 
MultiTrack View window. All following MT Entries on the same track(s) will be left undisturbed in their
current positions.

3. Hold the Shift key and press the Delete key. The entry will be deleted from the Sequence View 
window and from the MultiTrack View window. All following MT Entries on the same track(s) will be 
shifted to the left replacing any resulting gaps.
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Markers View Window
The Markers View provides powerful navigational features within the SAW32/SAWPlus32 environment. 
Markers are reference positions in either the SoundFile View (SF) or the MultiTrack View (MT) that can be
named and easily recalled. Markers can be dropped live during playback in either view and also during 
recording in the MultiTrack View. The Markers View can also be used to display the relative distance 
between any two Markers and can even be used as a quick method for creating Marked Areas.
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Title Bar - Markers View
The title bar displays the words Markers View. The window may be moved by dragging the title bar. The 
window may also be sized vertically, and horizontally to a limit, by dragging the window borders.
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Control Buttons - Markers View
H/S
The H/S (Hide/Show) button is used to toggle between hiding and showing the SAW32/SAWPlus32 
program workspace. When first clicking this button in a window, the program workspace will be hidden, 
leaving the Markers View window on top. Clicking the H/S button again redisplays the workspace. This 
allows SAW32/SAWPlus32 to be controlled remotely while inside of another application.

TL
The TL (Top Latch) button is used to latch this window to other windows containing H/S buttons. When 
any H/S button is clicked in any window, the Markers View window will also remain on top.

Window Expand
The Window Expand button toggles the Markers View display between a narrow and wide view. The 
narrow view displays Marker names only. The wide view also displays Marker information. This allows you
to keep the window small, allowing room for other windows, but expand it quickly when you need 
additional information.

Marker 1
Clicking the Marker 1 button places the currently selected Marker name in the Marker 1 readout display.

Marker 2
Clicking the Marker 2 button places the currently selected Marker name in the Marker 2 readout display.

Relative 1-2 Time Readout Display
When Marker names of similar types (SF or MT) are displayed in the Marker 1/Marker 2 readouts, the 
relative time between the two positions is displayed in the Relative 1-2 Time readout.

Add SF
The Add SF button adds a Marker referencing the current SoundFile cursor position. If playback is not 
active, you’ll be prompted to enter a Marker name. Otherwise, a unique default name will be created 
which can be changed later.

F Soundfile Marker names will be listed with an SF prefix.

Add MT
The Add MT button adds a Marker referencing the current MultiTrack cursor position. If playback is not 
active, you’ll be prompted to enter a Marker name. Otherwise, a unique default name will be created 
which can be changed later.

F MultiTrack Marker names will be listed with an MT prefix.

Update
The Update button allows you to change the name and/or the position of the currently selected Marker.
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Markers View Operation
Adding a Soundfile Marker

èTo Add a Soundfile Marker:

1. From the Window menu, select Markers to display the Markers View window.

F You may want to create a function key workspace view that includes the Markers View window. 
See our suggested workspaces at the beginning of this section.

2. With a soundfile displayed in the SoundFile View window, place the cursor at the desired Marker 
position.

3. Click the Add SF button in the Markers View window.

4. In the Input Text box, specify a new Marker name, or accept the default unique numbered name.

5. Click OK or press the Enter key. This will add the new Marker in the Markers View window in 
alphabetical order.

Jumping to an Existing Soundfile Marker

èTo Jump to an Existing Soundfile Marker:

1. From the Markers View window, click the desired SF Marker name. The associated soundfile will be 
loaded and the SoundFile cursor will be set to the Marker reference position.

Adding a MultiTrack Marker

èTo Add a MultiTrack Marker:

1. From the Window menu, select Markers to display the Markers View window.

F You may want to create a function key workspace view that includes the Markers View window. 
See our suggested workspaces at the beginning of this section.

2. In the MultiTrack, place the cursor at the desired Marker position.

3. Click the Add MT button in the Markers View window.

4. In the Input Text box, specify a new Marker name, or accept the default unique numbered name.

5. Click OK or press Enter. This will add the new Marker in the Markers View window in alphabetical 
order.

Jumping to an Existing MultiTrack Marker

èTo Jump to an Existing MultiTrack Marker:

1. From the Markers View window, click the desired MT Marker name. The MultiTrack cursor will be set
to the Marker reference position.



F When double-clicking an MT Marker, the MultiTrack cursor will be set to the Marker reference 
position, and the MT Entry at the cursor position on the current Hot Track will be displayed in the
SoundFile and Full View windows. If there is no MT Entry at the Hot Track cursor position, no 
change will be made in the SoundFile or Full View windows.

I Regarding Markers View During Playback: These functions are immediate and occur, even during 
playback. While this is a powerful feature for fast navigation and editing, it is recommended that the 
Markers View be left closed during critical playback periods (as in a final mix) to minimize the chance 
of error.

èTo Create a Marked Area Between Two Markers:

1. Select the SF or MT Marker with the earliest time reference from the Markers View window. This will 
jump to that Marker location.

2. While holding the Shift key, select a second Marker (of the same type) at a later time reference. This
will jump to that Marker location, and mark and highlight the area between them.

F The Markers must be of the same type (SF or MT) and SF Markers must be part of the same 
soundfile.

F Pressing the Shift key when selecting any Marker will automatically mark from the current 
associated cursor position (SF or MT) to the selected Marker position. The relative movement 
must be from left to right and, if using SF Markers, must be part of the same soundfile.

Playback
Pressing the Enter key or clicking the right mouse button initiates playback of any Marker position 
immediately.

Pressing the Spacebar toggles playback on and off. On MT Markers, it performs a MultiTrack PreLoad on 
the first press and pauses. The next press starts playback instantly.
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Special Keyboard Functions - Markers View
These are extra Markers View keyboard functions that, in many cases, have no menu option or control 
button equivalent.

Ctrl and Delete
Pressing Ctrl and Delete deletes all Marker entries.

Delete
Pressing the Delete key deletes the currently selected Marker from the Markers View.

Up/Down Arrows
Pressing the Up/Down arrow keys selects the previous/next Marker and instantly jumps to its location. 

F If the newly selected Marker is an SF Marker, playback, if active, will be stopped. If the newly selected
Marker is an MT Marker, playback, if active, will continue at the new location.
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Remote Transport Window
The Remote Transport window serves as a central playback and position control, and information display 
tool. The window can remain active on top of other applications, allowing you to remotely control many of 
the SAW32/SAWPlus32 playback and positioning functions.
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Title Bar - Remote Transport 
The Remote Transport window can be moved by dragging the title bar.
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Time/Position Readouts - Remote Transport
The Current Time readout displays the current cursor position in the active window. Depending on the 
active display mode, the readout will show STANDARD time (to the nearest millisecond), SMPTE time (to 
the nearest subframe), or SAMPLE count.

F This readout display can also act as a special GoTo Position feature. If any SMPTE mode is active, 
clicking in the display with the left mouse button will display the SMPTE Position window, allowing you
to enter the SMPTE position which the MultiTrack cursor will immediately jump to. If the sample 
display mode is active, the same mouse click will prompt you for a ten-digit sample position instead.

The Marked/Relative Time readout displays the length of the current Marked Area, if one exists, or the 
relative difference between two points on the waveform as the mouse is dragged.
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Control Buttons - Remote Transport
Remote Transport Close
This button closes the window with a single click.

H/S
The H/S (Hide/Show) button is used to toggle between hiding and showing the SAW32/SAWPlus32 
program workspace. When first clicking this button in a window, the program workspace will be hidden, 
leaving the Remote Transport window on top. Clicking the H/S button again redisplays the workspace. 
This allows SAW32/SAWPlus32 to be controlled remotely while inside of another application.

TL
The TL (Top Latch) button is used to latch this window to other windows containing H/S buttons. When 
any H/S button is clicked in any window, the Remote Transport window will also remain on top.

B and E
The B and E buttons are included as a convenient way to navigate to the beginning or end of a marked 
region in the SoundFile or MultiTrack View. Ctrl and Left arrow or Ctrl and Right arrow perform the same 
function.

T/S
The T/S (Time/Samples) button toggles between time and sample display modes and causes all position 
and time references in SAW32/SAWPlus32 to change accordingly.

Z
The Z (Return to Zero) button returns the cursor to the Zero Position of the SoundFile View or MultiTrack 
View windows, depending on which one is active.

Pressing the Shift key at the same time sets a new relative Zero Position for the Current Time display. 
The Time Line of the active window is updated to reflect the change. Any position prior to the new Zero 
Position will display as zero. When the cursor moves past the Zero Position, time will increment normally.

Pressing the Ctrl key at the same time clears the relative Zero Position back to the actual beginning 
position (real zero).

The Full View and SoundFile View retain a separate relative Zero Position from the MultiTrack View. The 
Sample Display mode or any SMPTE mode overrides the relative zero display.

Stop and Play
When the MultiTrack View is the active window, Play begins playback of all tracks that are not muted. 
Stop ends playback and leaves the cursor at a new current position ready to resume playback from that 
point.

When the SoundFile View is the active window, Play begins playback of the current soundfile from the 
SoundFile View cursor position. Stop ends playback leaving the Tracking cursor at a new current position.
Clicking Play again replays from the original start point. This allows you to easily and quickly preview an 
editpoint as many times as you like.

When the Regions View is the active window, Play automatically loads and displays the selected Region 



in the SoundFile View, and begins playback at the start of the Region, automatically stopping at the end 
of the Region.

When the Sequence View is the active window, Play begins playback in MultiTrack View from the start of 
the currently selected sequence entry.

Play Mark
Clicking the Play Mark button immediately shifts the focus to the SoundFile View and initiates playback of 
the Marked Area.

F If the SoundFile View cursor is outside of the Marked Area, playback begins from the beginning of the
Marked Area and plays back the entire area. If the cursor is within the boundaries of the Marked Area 
however, playback begins at the cursor position and plays to the end of the area.

Play Loop
Clicking the Play Loop button immediately shifts the focus to the SoundFile View and initiates and loops 
playback of the Marked Area.

F If the SoundFile View cursor is outside of the Marked Area, playback begins from the beginning of the
Marked Area and plays back and loops the entire area. If the cursor is within the boundaries of the 
Marked Area however, playback begins at the cursor position and plays to the end of the area and 
loops back to the beginning. While the loop is playing, the begin and end points can be redefined on-
the-fly by clicking anywhere in the display area.

Auto<<
This button toggles the MultiTrack View AutoRewind mode on and off. When this mode is active, the 
MultiTrack playback cursor automatically returns to the original starting point when a playback or record 
operation is stopped. This button has no effect in the SoundFile View.

Jog Slider Control
Dragging the Jog Slider control to the left or right will rewind or fast forward the cursor position in 
MultiTrack View. The farther you drag from the center, the faster the position changes. When you release 
the control, the MultiTrack View window redraws the screen, centering the new cursor position.
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Controlling the Mix
The SAW32/SAWPlus32 environment offers an incredible array of tools and functions to control Volume 
Levels and Pan Positions. Popup Faders for each track are the central element used to adjust the mix. 
Mix changes can be programmed non-destructively, one at a time, and played back simultaneously, live in
real-time, without ever modifying the original soundfile data! Programmed mix changes can be moved, 
copied, expanded and compressed, at any time, because they are never written directly to the soundfiles 
themselves. Level and pan changes can also be programmed live during playback, if desired. 

SAW32/SAWPlus32 is designed do the work of a full featured audio mixing console complete with a 
sophisticated fader automation system capable of down-to-the-sample-accuracy.

The mixing concepts and techniques presented here are probably quite different from what you are 
accustomed to, using physical hands-on faders and controls, but the incredible power and flexibility 
gained by this design is worth the small learning curve. So let's jump in and get control of the mix.



Using The Faders
Clicking a Fader icon on any track of the MultiTrack opens and displays a popup Fader window for that 
track. You may open as many Fader windows as you wish, and arrange them on the screen in any 
fashion. When multiple Faders overlap, the current HotTrack Fader will always be displayed on the top. 
Changing the Hot Track will also change the topmost Fader. Clicking on any Fader to bring it to the top 
will also change the current Hot Track. This bi-directional link can be very helpful when trying to 
manipulate many Faders at the same time. 

F Relying on this design feature, you might find that the default overlapping Faders work most efficiently
and save screen space, rather than spreading the Fader windows out like a standard mixing console 
display.

When any Fader is open, its corresponding track display will change color and two horizontal mix display 
lines will appear. The top line represents pan information and the bottom line represents volume 
information. The default Center Pan Position is displayed as red. The default zero dB Volume Level is 
displayed as yellow. Whenever a mix change is programmed, these lines change color, giving visual 
indication of the new value and position. Whenever the mix displays are at the default positions, 
SAW32/SAWPlus32 performs no mix calculations on the data at all. Any deviation from the default, 
causes SAW32/SAWPlus32 to mathematically scale the audio data on the fly to accomplish the desired 
mix changes, thereby adding CPU processing time to the playback operation.

The Faders dynamically display the current mix values at the MultiTrack cursor position. If you drag the 
cursor across the MultiTrack mix changes, you will see the associated Fader knobs move to reflect the 
levels. This display mode is also active during playback. 

F The Fader tracking during playback can be disabled to save CPU processing time if desired by 
toggling off the MultiTrack View Playback Mixer Tracking option in the Options menu.

When a Fader is open (and the Offset button is not pressed), it is automatically ready for programming. 
Placing the MultiTrack cursor at the desired mix change position and adjusting the Fader or Pan Knob, 
writes the mix change onto the track, altering the display lines to show the change. The Fader is also 
active for programming live during playback. When playback is active, adjusting either knob writes the 
changes into the track as you perform them. Whenever you release the mouse button the display is 
updated. A slight delay in hearing a change will be experienced based on the Preload Queue Buffers 
setting in the Audio Hardware Setup window, located under the Options menu. The smaller the setting, 
the less the delay. The changes are actually written onto the track without the delay and during following 
playbacks will exactly duplicate your moves and timing. 

F This feature is useful for performing a live fade that does not fit the preset Fade Curve selections, 
however we recommend programming precision mix adjustments in non real-time to take advantage 
of the power and accuracy available to you in that mode of operation.

SAW guides you to write mix changes only within the confines of MT Entry boundaries, although the 
flexibility of the interface makes it possible to place mix changes anywhere on a track (possibly as a result
of certain editing operations). 

I Regarding Mix Changes: We strongly recommend keeping all mix changes inside MT Entry 
boundaries so that you can freely move, copy and otherwise adjust your production at any time, 
maintaining perfect sample accurate sync between MT Entries and mix events. Any mix event outside
an MT Entry boundary will not retain its relative position to the rest of the production during many of 
the positioning operations.
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Title Bar - Fader
The title bar displays the Fader window's associated Track Number. The Fader window may be moved by
dragging the title bar.
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Control Buttons - Fader
Close
The Close button closes the Fader window. Pressing the Ctrl key while clicking any Fader Close button, 
closes all Fader windows at once.

Next
The Next button snaps the MultiTrack cursor position to the next or previous mix change. Clicking on the 
right half of the button moves the cursor forward to the next mix change. Clicking on the left half of the 
button moves the cursor backward to the previous mix change. If there are no more mix changes in the 
chosen direction, the cursor does not move.

Clr All
The Clr All button clears all mix changes on the associated track.

Offset
The Offset button adjusts the volume and pan levels of the entire track at once. All mix changes are left 
intact relative to each other, and are offset as a group by the offset value. When the Offset button is 
pressed in, dynamic Fader tracking is disabled and the only value displayed is the offset value. Offset 
adjustments are not connected to cursor positions and do not write programmed changes into the track. 
With Faders set to Offset mode, you can adjust them dynamically during playback to set a relative mix 
between multiple tracks, much the same as you would adjust a physical mixing console.

Pan Incremental Zones
Clicking in the Pan Incremental Zones adjusts the pan position left or right in repeatable, incremental 
steps. 

F If playback is active, the display will not be updated at each click to show the pan changes until the 
pan knob is clicked once. This reduces CPU overhead considerably.

Pan Knob
Adjusting the Pan Knob changes the left/right position of the track in the mix. Clicking the right mouse 
button while adjusting the pan knob snaps the pan to the default center position.

Slope Zone
The Slope Zone displays the current slope value for the mix change. Each mix change in 
SAW32/SAWPlus32 is actually a series of ramped steps at a resolution of about 1/1000 dB. These tiny 
steps allow the mix changes to be applied without creating digital noise (crackles and pops) during 
sustained tones or music information. The Slope Value determines how fast or slow these step transitions
take place. Lower values produce slower transitions. Clicking in the Slope Zone pops up a Slope menu. 
The checked value is the current default value. You may select a new default value from 1 to 10. The 
lower values sound like quick fades and the higher values sound like instantaneous jumps. This default 
value is used for every new mix change programmed. You may select different values for individual mix 
changes and you may change an individual slope value at any time. The Fader Slope value display is 
dynamic and reflects the current Slope value at the cursor position, not necessarily the default value.

Fader Incremental Zones
Clicking in the Fader Incremental Zones adjusts the volume level up or down in ¼ dB steps. Pressing the 



Shift key while clicking in the zones increases the steps to 1 dB each. 

F If playback is active, the display will not be updated at each click to show the level changes until the 
Fader knob is clicked once. This reduces CPU overhead considerably.

Fader Knob
Adjusting the Fader knob changes the volume level of the track in the mix. Clicking the right mouse button
while adjusting the Fader knob snaps the Fader to the default 0 dB position. The adjustment increments 
are in 1 dB steps. Use the incremental zones for ¼ dB resolution. 
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Fader Operation
The following operations assume that the Fader window is open for the track(s) you are working with.

Working with Individual Volume and Pan Changes
When working with individual volume and pan changes, the default slope value is used to determine the 
speed of the actual change from one value to the next. A different slope value may be chosen before 
making new changes, and that value will remain in effect for all following changes until a new value is 
selected.

èTo Add a Volume or Pan Change:

1. Place the MultiTrack cursor at the desired position.

2. Adjust the Fader or Pan knob to the new value. 

èTo Adjust an Existing Mix Change Value:

1. Place the cursor near the mix change you wish to adjust.

2. Click the Next button to snap the cursor in the appropriate direction until it is at the exact mix change
position you wish to adjust.

3. Adjust the Fader or Pan knob to the new value.

èTo Move Mix Changes on the Same Track:

1. Create a Marked Area encompassing the mix changes you wish to move.

2. While pressing the Shift key, click and hold the left mouse button inside the Marked Area and drag 
the selection left or right on the same track to the new position.

èTo Move Mix Changes to a Different Track:

1. Create a Marked Area encompassing the mix changes you wish to move.

2. While pressing the Ctrl key, click and hold the left mouse button inside the Marked Area and drag 
the selection up or down to the new track.

èTo Copy Mix Changes on the Same Track:

1. Create a Marked Area encompassing the mix changes to be moved.

2. While pressing the Shift key, click and hold the left mouse button inside the Marked Area and drag 
the selection left or right on the same track to the new position. At any time during the move, click 
and release the right mouse button to engage Copy mode.

3. Release the mouse to copy and place the mix changes in the new position leaving the originals 
intact.

èTo Copy Mix Changes to a Different Track:



1. Create a Marked Area encompassing the mix changes to be moved.

2. While pressing the Ctrl key, click and hold the left mouse button inside the Marked Area and drag 
the selection up or down to the new track. At any time during the move, click and release the right 
mouse button to engage Copy mode.

3. Release the mouse to copy and place the mix changes in the new position leaving the originals 
intact.

è To Sweep Between Pan Positions:

1. Place the MultiTrack cursor at the desired end position and set the destination pan position.

2. Move the cursor back to the desired start position.

3. From the Mix menu, select Sweep to Next Pan Change (or press P).

F Using the keyboard bypasses the confirmation prompts, to allow for quicker operation.

èTo Reverse Mix Changes:

1. Create a Marked Area encompassing the mix changes to be reversed. 

2. From the Mix menu, select Reverse Marked Vol and Pan Changes (or press Shift-R).

èTo Clear Volume and Pan Changes at the Same Time:

1. Create a Marked Area encompassing the mix changes to be cleared.

2. From the Mix menu, select Clear Marked Vol and Pan Changes (or press Shift and C).

3. Click OK or press Enter.

èTo Clear Volume Changes Only:

1. Create a Marked Area encompassing the mix changes to be cleared.

2. From the Mix menu, select Clear Marked Vol Changes (or press Shift and V).

3. Click OK or press Enter.

èTo Clear Pan Changes Only:

1. Create a Marked Area encompassing the mix changes to be cleared.

2. From the Mix menu, select Clear Marked Pan Changes (or press Shift and P).

3. Click OK or press Enter.

Working with Fades

A fade in SAW32/SAWPlus32 is actually a series of individual mix changes maintained as a group 
(displayed in white) and pre-programmed to follow a specific curve shape. The curve shape is pre-
selected using the Fade Curve Setup option under the Mix menu. For more information about selecting 



Fade Curves, see Using the Menus.

F The default slope value is still used for each step in the fade group. Fades created with the same 
curve shape but different slope values will produce subtle differences in the overall sound of the fade. 

èTo Fade In or Out Within a Marked Area:

1. Create a Marked Area defining the begin and end points of the fade.

2. Confirm that the desired Fade Curve parameters and the Slope Value are set as desired.

3. From the Mix menu, select Fade Out Marked (or press O), or select Fade In Marked (or press I).

F Using the keyboard bypasses the confirmation prompts, to allow for quicker operation.

F Using this fade process, a fade-in always starts from a mute volume level and ends at the volume 
level of the Marked Area end boundary. A fade-out always starts at the volume level of the Marked 
Area begin boundary and ends at a mute volume level.

è To Fade from a Higher to a Lower Volume Level:

1. Place the MultiTrack cursor at the desired end position and set the destination volume to a lower 
level.

2. Move the cursor back to the desired start position.

3. From the Mix menu, select Fade to Next Volume Change (or press F).

F Using the keyboard bypasses the confirmation prompts, to allow for quicker operation.

èTo Fade from a Lower to a Higher Volume Level:

1. Place the MultiTrack cursor at the desired end position and set the destination volume to a higher 
level.

2. Move the cursor back to the desired start position.

3. From the Mix menu, select Fade to Next Volume Change (or press F).

F Using the keyboard bypasses the confirmation prompts, to allow for quicker operation.

F In some cases, you may need to set a starting volume first before performing this operation. For 
example: Suppose you have an entry in the middle of a track. The current volume at that entry 
position is 0 dB. You would like to fade this entry in from -40 to 0 dB. In order to accomplish this, Tab
(or Shift-Tab) to the beginning boundary of the entry. Adjust the Fader knob to -40 dB to create the 
start volume level. Position the cursor in the entry where you would like the fade-in to end. Adjust the
Fader knob to 0 dB. This creates a dip in the volume display line. Place the cursor slightly inside of 
the begin boundary (confirming the fader readout is -40) and press the F key to create the fade.

Working with CrossFades
Fading one audio segment out while an overlapping audio segment fades in, is referred to as a 
CrossFade. Creating automatic CrossFades in SAW32/SAWPlus32 is extremely simple, and yet 
incredible flexibility is provided for precisely selecting the crossover point, so critical in achieving the 



desired effect. 

The crossover point is the position where the incoming and outgoing volume levels of both audio 
segments are the same. If the crossover point occurs at a -6 dB level, there is no apparent decrease in 
volume during the transition.

The SAW32/SAWPlus32 environment does not allow MT Entries to overlap on the same track, therefore, 
CrossFades between audio segments must occur across different tracks. To use the automatic 
CrossFade functions, overlapped segments must be on adjacent tracks. 

èTo Create a CrossFade Between Two Overlapped MT Entries:

1. If the entries are not on adjacent tracks, reposition the tracks to be next to each other by dragging 
the Track Number display of either track. 

2. Select the top track as the Hot Track.

3. Place the cursor within the overlapped area at the desired crossover position.

4. From the Mix menu, select CrossFade Marked or Overlapped to the Next (or press X).

From the Mix menu, select CrossFade (-6dB) Marked or Overlapped to the Next (or press Shift-X)
to maintain a -6 dB crossover point.

F Using the keyboard bypasses the confirmation prompts, to allow for quicker operation.

F By creating a Marked Area you can shorten or extend the boundaries of the actual overlap. The 
CrossFade function will use the Marked Area as its boundaries. 

Modifying Existing Fades
A major advantage of working in the non-destructive, non-linear SAW32/SAWPlus32 environment is that 
programmed fades are not etched in stone. In other words, they can still be modified at any time after 
they’ve been created. 

èTo Stretch or Shrink an Existing Fade:

1. Place the cursor within the fade near the boundary to be adjusted.

2. While pressing the Ctrl key, click and hold the left mouse button to snap the cursor to the fade 
boundary.

3. Drag the boundary left or right to stretch or shrink the fade. Releasing the mouse will resize the fade 
while retaining its original shape.

èTo Offset the Relative Volume of an Existing Fade:

1. Create a Marked Area encompassing the whole fade or portion of the fade to be offset. 

2. Place the cursor within the fade area.

3. Adjust the Fader knob to shift relative volume of the fade up or down.

F Placing the cursor outside the fade area but still within the Marked Area boundaries, still applies the 
offset, but causes the Fader knob to snap back to its default position upon release. If the default 
position is 0 dB, you can obtain a direct readout of the relative offset you are applying.



Creating Master Mix Changes Using the Output Tracks
The popup Faders on the output tracks at the bottom of the MultiTrack can be used to create master mix 
changes that apply to all tracks assigned to that output card. 

» Use this feature to create a master fadeout, rather than creating individual fades on each track.

I Regarding Mix Changes on Output Tracks: Output track mix changes are not linked to any 
particular MT Entry. Therefore, shifting elements of a production will not shift corresponding mix 
changes on the output track. It is recommended that you adjust all entry positions first, and create 
master mix changes as a finishing touch to the production process.
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MultiTrack Recording
Recording soundfiles in the SoundFile View window records audio data that has no reference to time as 
far as the MultiTrack session is concerned. In other words, this audio data will be placed at a later time in 
the front, middle or end of the actual non-linear session we are building. This method of recording is very 
useful for bringing unconnected pieces of an entire project into the editing environment, which we will then
assemble in a certain order as the session progresses. SAW32/SAWPlus32 also provides very flexible 
and powerful ways to record audio files directly in sync with other audio data already placed in a 
MultiTrack session, or even synchronized to a specific time reference (SMPTE Timecode). This method 
involves recording audio directly into the MultiTrack View window.

Two distinctly different modes of MultiTrack recording exist. Normal mode uses the same Record Panel 
as in SoundFile View recording. This mode is useful when recording one or two tracks at a time in sync 
with existing audio on other tracks, or when dropping individual audio segments on a track at a specific 
SMPTE time reference. Multi-Channel Record mode uses a completely different control interface and is 
designed for live session overdubbing and emulation of a typical Multi-Channel tape recording system. 
This mode makes it easy to assign and record multiple tracks at the same time.

Both modes automatically create and drop MT Entries in place to designated tracks at the time of 
recording. You may also perform manual or automatic Punch In/Out to drop small sections of a recording 
in between already existing sections, live and on the fly.

The MultiTrack Record modes also allow for keeping multiple takes of a performance, and for retaking a 
performance and automatically reclaiming hard drive space.

All SMPTE Trigger and Generate modes can be used during MultiTrack Recording. These are explained 
in detail in the Working with SMPTE section.



Normal Mode
Normal mode is in effect for recording, unless the Multi-Channel Record Mode option in the MultiTrack 
menu is checked. To begin, click the MultiTrack View red REC button for the specific track you wish to 
record to. This will display the Record Panel and the Record Remote Transport windows. (For more 
details see Recording Soundfiles in Understanding the Interface.) Setting recording parameters in the 
MultiTrack is the same as using the Record Panel in the SoundFile View window, except for special 
conditions when using the Mono L/R file type. 

The Record Panel will open with the default MultiTrack samplerate selected. You may override the default 
and record at a different samplerate if desired, but realize that samplerate conversion will take place 
during MultiTrack playback, which adds to CPU processing time. We recommend using the default rate. 
The Record Panel will also default to the soundcard currently assigned as the output card on the selected
track. 

F If more than one wave device is installed, you may choose which device you wish to record to by 
clicking in the blue OUT display box prior to opening the Record Panel.

You may record Stereo or Mono L+R file types to a single track in the MultiTrack, but the Mono L/R file 
type requires the use of two tracks at the same time. 

èTo Setup Mono L/R Recording:

1. Click the REC button on the first track you wish to use. The Record Panel and Record Remote 
Transport windows are displayed. Both track indicators will be assigned to the selected track.

2. Select the Mono L/R type.

3. Click either the Left or Right filename button to assign a filename for this track. The track indicators 
display and the associated filename display will be updated. The opposite track indicator is now 
available for a different track assignment.

F The button you choose determines which soundcard input data records to this track. 

4. Click the REC button on the second track you wish to use. The other track indicator will now be 
assigned to this track.

5. Click the opposite filename button (Left or Right) to assign a filename for this track. The associated 
filename display will be updated. You are now ready to record!

When recording in the MultiTrack, the cursor location designates the starting record position. Clicking the 
Rec button in the Record Remote Transport window begins recording at that point. The cursor moves 
forward and the time readouts display the recording progress. 

Clicking the Stop button in the Record Remote Transport window stops the recording process and 
automatically creates a Region and places an MT Entry at the original record start position, for each 
assigned recording track.

F The Regions are automatically named using the assigned filename(s) enclosed in brackets, followed 
by a unique number identifier. Region names may be changed after closing the Record Panel, by 
double-clicking the associated MT Entry, selecting Update Region from the Regions menu, and 
entering a new name in the Input Text box.

Without closing the Record Panel, you may now play back the MultiTrack to decide if you want to keep 
the recording. If you decide to discard the recording and reclaim the hard drive space, click the Retake 
button on the Record Panel. This button allows you to throw away the last recorded segment and record 



over again from the same start position. This keeps soundfiles from continually increasing in size if you 
make mistakes during recording.

F The automatically created Regions and MT Entries associated with the last recorded segment will 
be deleted, and the file pointer and MultiTrack start position will be reset, ready to record again.

Clicking the All button (next to Retake) will reset the file pointer to the beginning of the soundfile, deleting 
all associated Regions and MT Entries, and reclaiming all associated hard drive space.

If you decide to keep the recording but would like to try another take, click the Keep Take button on the 
Record Panel. This will append a Take number and an MT Entry position value to the Region name. The 
MT Entry will then be removed and the record start position will be reset. The file pointer will be left alone 
causing the next take to be appended to the end of the soundfile.

S-R-P Recording
S-R-P (Simultaneous Record and Play) recording allows you to hear other tracks in the MultiTrack at the 
same time you record new tracks.

This feature can be used to overdub vocals to music, apply instrument solos to existing rhythm tracks, 
etc. S-R-P recording is soundcard dependent and requires an S-R-P capable driver and hardware. 

Clicking the S-R-P button begins MultiTrack playback of all non-muted tracks and arms the soundcard for 
record. Clicking the Rec button punches in on the fly beginning the actual record process at the point 
where you clicked. 

F Pressing the Shift key when clicking the S-R-P button links and activates the Rec button at the same
time, causing the recording to begin simultaneously. This link can be set as a default condition by 
choosing Auto SRP/Rec Link in the Options menu. In this mode, pressing the Shift key breaks the 
link temporarily.

Punch in/out points may be automated for precision recording operations, such as capturing a single 
phrase in the middle of a vocal section. If a Marked Area exists in the MultiTrack, once the S-R-P button 
has been activated, the Rec button will be automatically activated at the Marked Area begin boundary and
deactivated at the end boundary.

Overdubbing on the Same Track
As with standard tape recording equipment, SAW32/SAWPlus32 allows you to punch in and overdub a 
new recording over an existing track. Unlike standard tape recording equipment, the underlying data in 
SAW32/SAWPlus32 is still available even after the newly recorded data has been inserted on top.

Whenever the Record Panel is activated on a track with existing data, and your recording position 
overlaps an MT Entry, SAW32/SAWPlus32 automatically splits the existing entry, and inserts and butt-
splices the new entry in place when recording stops. 

F This process is completely non-destructive to the underlying data, which can easily be restored by 
adjusting the boundaries of the newly recorded entry. Adjusting either boundary of the newly 
inserted entry inward, will extend the underlying entry boundaries, restoring the original data up to 
the splice point.

This extremely powerful enhancement to the overdub process eliminates any chance of destroying 
surrounding data to the overdub area. To take full advantage of this power, we recommend relaxing, 
punching in early, punching out late, and adjusting the inserted entry after the recording.

SAW32/SAWPlus32 can be set to automatically mute the underlying entry playback at the punch in 



position, similar to standard tape recording equipment. Activate this mode by choosing Auto Mute During 
SRP Punch-In in the Options menu.

F A slight delay will occur before the mute is heard based on the PreLoad Buffer Queue setting 
located in the Audio Hardware Setup under the Options menu. The smaller the setting, the shorter 
the delay. The delay does not affect the actual recording, which is inserted correctly at the punch in 
point.

Using Multiple Soundcards and Record Panels
If you have more than one soundcard or a multichannel soundcard installed (providing more than two 
physical inputs), you may open more than one Record Panel at the same time. Each Record Panel will be
associated with two input channels. Parameters must be set for each Record Panel separately, yet all 
panels are synchronized through the common Record Remote Transport window.



Multi-Channel Record Mode
Multi-Channel Record mode is activated by selecting the Multi-Channel Record mode option in the 
MultiTrack menu. When recording more than two inputs at a time, or for live session overdubbing and 
emulation of standard tape recording equipment, you may find Multi-Channel Record mode a powerful 
enhancement to the SAW32/SAWPlus32 environment. This mode greatly simplifies the recording 
process by eliminating the need to set parameters and file names for each recording operation. Multiple 
inputs can be instantly assigned and recording can begin immediately. Inputs may be reassigned to 
different tracks on the fly, making multi-take recording a simple and efficient process.

When Multi-Channel Record mode is active, you must first set a base file name for all soundfiles to be 
recorded by selecting the Multi-Channel Record Setup option in the MultiTrack menu. This file name will 
become a common base file name for each available input channel installed in your system. This base 
name will be saved with the EDL and be automatically available the next time this session is opened. 
Once set, you may initiate record operations as many times as you like without ever having to re-enter file
names and other recording parameters.

F Multi-Channel Record mode automatically creates a separate soundfile for each soundcard input 
that you utilize, and uses the base file name with appended soundcard and input channel 
information as the complete soundfile name. Each time you select a soundcard input as a recording 
source, the associated soundfile is either newly created or opened for appending. The new data is 
recorded in a non-linear fashion into these soundfiles and automatically assigned to the appropriate 
track and MT Entry.

Each of these soundfiles are created as mono 16 bit soundfiles at the MultiTrack samplerate setting, 
closely emulating a standard tape recorder with multiple inputs.

To begin recording, click the MultiTrack View red REC button for the specific track you wish to record to. 
Instead of the standard Record Panel, a single recording meter will be displayed along with the Record 
Remote Transport window and the Retake Tools window. Clicking the REC button on another track 
displays a new recording meter alongside the previous. You may open a meter for each soundcard input 
installed. These meters will attach themselves into a straight line in order of track assignment.

The default input connection will follow the output card assignment for the particular track, starting with 
the left side (if available) then the right side. Dashes will be displayed if all inputs for the default card are 
already assigned. Clicking on the In display readout at the bottom of the meter will pop up a list of all 
available input selections. You may freely assign the input with no regard to the track's output assignment.
All previously assigned selections will appear grayed out and the selection for the current meter will 
display a check mark next to it. 

F If a track has an offset pan assigned, the default input connection will override the automatic 
left/right ordering, and instead uses the offset pan position as the left or right input connection.

Clicking on the small fader icon will pop up an input fader, if needed, to adjust input level. Clicking on the 
track number display readout at the top of the meter pops up a list of all available track selections. All 
previously assigned selections will appear grayed out and the selection for the current meter will display a
check mark next to it. You may freely reassign the current meter to any available track by clicking on a 
new selection. The meter will automatically reorder itself sequentially in the group of displayed meters.

Clicking the Rec or S-R-P/Rec button begins the recording process at the current cursor position. Clicking
Stop or S-R-P (to punch out) stops the recording process and automatically creates Regions and MT 
Entries for each meter’s associated track.

You may instantly play back and audition the newly recorded material without altering your record setup. If
you decide to retake the recording, clicking the Retake button will remove all the Regions and MT Entries 
created by the last recording, and reset the file positions to the last position before recording started. In 



this way, you will not waste disk space for recordings you did not like. If you decide to keep the recording 
but would like to try another take at the same spot, click the KeepTake button, and each Region name 
belonging to the last recording will be appended with a unique Take Number and the actual Sample 
Position insertion point. The MultiTrack will be cleared and the cursor returned to the starting point, but 
the file positions will not be altered. Therefore recording again will retain the last recorded information.

» You will find it easy to do multiple vocal takes or harmony guitar solos etc., by setting up a track to 
record, assigning the input (which will stay the same between overdubs), and doing your first track's 
recording. To change to another track and do a harmony part, click inside the Track Number display 
readout at the top of the meter and select a new track. All internal assignments and file handling will 
be done automatically, so you can begin recording immediately. 

» You can setup a template for typical emulation of a multitrack tape system. Start with a clean EDL. 
Arrange the first group of tracks on the MultiTrack to point to each installed soundcard a pair at a 
time. For instance, Track 1 to Card 1, Track 2 to Card 1, Track 3 to Card 2, Track 4 to Card 2, and so
on for each installed pair of inputs. Bring up the fader on Track 1 and click the Offset button. Pan all 
the way left and close the fader. Bring up the fader on Track 2 and Offset pan all the way right. 
Follow this procedure all the way down for each track assigned to a different soundcard. Activate 
MultiChannel Record mode and save your EDL, naming it 'MultiChannel Record Template', or 
whatever you prefer. To instantly setup a MultiChannel Record Mode Session, open this template 
EDL, enter a Base Name in the MultiChannel Record Mode Setup and immediately save and name 
your session. Now when you arm a track for record, it will automatically pick up the exact input 
matching channel, just as if you were using an ADAT or some other type of multitrack tape system. 
Each track will output through its specific card's output to your external mixer and you will be 
emulating the feel of your oldstyle multitrack tape system. 

When recording is complete, click the close box to close each meter. Pressing the Ctrl key when closing 
the meter panels will close all meters at once.



Using the Menus
The menu bar at the top of the SAW32/SAWPlus32 screen provides access to the various pull down 
menus. These menus offer many powerful options and tools for manipulating data in the 
SAW32/SAWPlus32 environment. Applicable keyboard shortcuts are displayed next to the menu items in 
each menu.

Menu selections may be duplicated in a toolbar window or some other control. Selecting an option from a 
menu usually displays warning prompts. Many of the keyboard shortcuts or toolbar buttons will bypass the
warning prompts increasing efficiency for the advanced user.

Menus:

File Menu 

Edit Menu 

Regions Menu 

MultiTrack Menu 

Mix Menu 

Process/MixDown Menu 

Window Menu 

Smpte/Midi Menu 

Options Menu 

Info Menu 



File Menu
The File menu contains options for opening, closing, and manipulating files, saving preferences, and 
exiting the SAW32/SAWPlus32 program.

Open SoundFile (Ctrl and Alt and O)

This option opens an existing soundfile to the Full and SoundFile View windows. 

Use the File dialog box to select a file and click OK.

F The path set in the File dialog box using this option can be saved in the Preferences file as the default
path. When first using SAW32/SAWPlus32, navigate to the drive and folder you wish to use as the 
default, and save your preferences.

I Regarding Soundfile Storage: It is suggested that you use the Audio folder, created automatically 
during installation under the SAW32/SAWPlus32 application folder, or create a separate folder at a 
desired location to store all of your soundfiles and editlists. It is recommended that you always keep 
your audio files separate from the SAW32/SAWPlus32 program files by saving to a dedicated folder 
instead of the application folder.

Open SoundFile and Create Region (Ctrl and Alt and R)
This option opens an existing soundfile to the Full and SoundFile View windows and automatically marks 
the entire soundfile and creates a Region adding it to the Regions View ready for further use.

Use the File dialog box to select a file and click OK.

Open SoundFile and Refresh
This option opens an existing soundfile and refreshes the peak data file that is used to enhance screen 
display speed. This is used after modifying a file in another utility program. When the file is reopened in 
SAW32/SAWPlus32, a new peak data file must be built in order for the changes to be properly displayed.

Use the File dialog box to select a file and click OK.

Close SoundFile
This option closes the current soundfile, clearing the Full and SoundFile View windows.

Open EditListFile (Ctrl and Alt and E)
This option opens an existing editlist file. EDL files contain all of the Region, MT Entry, mix automation, 
effects, and other information involved in the editing session. 

Use the File dialog box to select a file and click OK.



F EDL files are relatively small in size as they contain no actual audio data. You may keep different 
versions of a particular production by saving different editlist files during the course of an editing 
session.

I Regarding EDL Files: Because EDL files are linked directly to soundfiles on the hard drive and refer 
to audio data contained within those soundfiles, deleting any soundfiles referenced in an EDL will 
adversely affect linked portions of the EDL in future use.

When opening an EDL file, you will be notified if any linked soundfile cannot be found. You may 
choose to ignore the warning and continue working with the remaining information that is not affected.
Any Region or MT Entry referencing a soundfile that cannot be located will be skipped during 
playback.

F The path set in the File dialog box using this option can be saved in the Preferences file as the default
path. When first using SAW32/SAWPlus32, navigate to the drive and folder you wish to use as the 
default, and save your preferences.

Close EditListFile
This option closes the current editlist file, clearing all windows except the Full and SoundFile View.

Save EditListFile As… (Ctrl and Alt and S)
This option saves your current project as an editlist file (EDL), including all Region, MT Entry, Marker, and
mix automation information, effects patches and settings, and other information needed to recall the 
session. These are small files saving only reference information and not the actual soundfile date, and 
use the .EDL extension.

Use the File dialog box to create a file name and click OK. SAW32/SAWPlus32 will automatically add 
the .EDL extension to your file name and the editlist information will be saved. 

F Use this option to save different versions of a production during the course of an editing session. By 
saving the EDL file under a new name, a copy of the session is created, which then becomes the 
active session, leaving the original file intact.

Save EditListFile Copy As… (Ctrl and Alt and C)
This option saves a copy of the current EDL to a new file, but leaves you working in the original EDL, not 
the new one.

Use the File dialog box to create a file name and click OK. SAW32/SAWPlus32 will automatically add 
the .EDL extension to your file name and the editlist information will be saved. 

Update EditListFile (Ctrl and Alt and U)
This option overwrites and updates the current EDL file without any further prompts.

F Use this option to continually update an EDL as you are working on and building a new production. It
is recommended that you update and backup your EDLs often to avoid the possibility of losing data.



Blend EditListFile
This option allows you to blend the File, Region, Marker and Track Sequence data from an existing EDL 
into the current EDL at the MultiTrack cursor position. The position must be chosen after the end of the 
current EDL. Once the data is on the MultiTrack, it can be positioned anywhere using the Select mode 
positioning capabilities.

Position the MultiTrack cursor anywhere past the end of the current EDL. Use the File dialog box to select
a file and click OK.

F Global track information such as solo, mute, effects, volume and pan offsets, etc. is not transferred by
using this option. The current global track information overrides the blended EDL information. You 
may rearrange the blended sequence data to empty tracks and reassign effects and/or other global 
information without disturbing the current EDL.

Recover EditListFile
This option can be used to attempt a recover of the last EDL undo operation, even after a system crash. 

Use the File dialog box to see a list of all EDL undo files. Select the session you are trying to recover and 
most, if not all, of your session should be restored.

Change EditListFile Paths
This option allows you to change the path of any or all soundfiles associated with an EDL file.

If you decide to move a soundfile associated with an EDL, you must use this option to change the path in 
the EDL so that when it is opened, SAW32/SAWPlus32 knows where to find the linked soundfile(s).

This option displays a dialog box listing each soundfile linked to the EDL, one at a time. You are given the 
option to change the path and soundfile name. Type in a new path, if needed, and click OK to move on to 
the next name. You must complete every entry, by clicking OK, in order for the changes to take effect. A 
file reference can be removed from an editlist by clearing the name and then clicking OK. After the last 
entry is done, the EDL file is modified and ready to be opened for further editing.

Change SoundFile Header SampleRate
This option overwrites the samplerate information in a soundfile header with a new samplerate. This does 
not convert or otherwise alter the audio data in any way. It only changes the header itself which affects 
how the soundcard opens the file and the actual playback speed. 

F This is a useful way to easily change a digitally recorded file whose samplerate was not correctly set 
in the Record Panel. If the samplerate in the soundfile header does not match the correct samplerate 
of the original source material, the soundfile will play back at the wrong speed.

Save Preferences
This option saves certain settings as defaults which take effect each time you start the 
SAW32/SAWPlus32 program. Your preferences are saved in a file called SAW32.PRF or 
SAWPlus32.PRF. 



F The settings currently saved in the preferences file are:

· Audio Hardware Setup information
· MIDI/SMPTE Hardware Setup information
· Window size & placement settings
· Function key view settings
· Current Open SoundFile path
· Current Open SoundFile qualifier
· Current record soundfile path
· Current record soundfile qualifier
· Current MultiChannel Record Mode setting
· Current MultiChannel Record Setup information
· Current Open EditlistFile path
· Current default samplerate (selected in the MultiTrack View)
· Current MultiTrack PreLoad Buffer setting
· Current Fade Curve Setup information
· Current Fade Slope setting
· Current SMPTE active mode
· Current SMPTE Chase-Advance setting
· Current SMPTE Conform 30 to 29.97 setting
· Current SMPTE StartOffset position
· Current Auto SMPTE Stop Detection setting
· Current Auto SMPTE Format Detection setting
· Current Directory Path Setup information
· Current Color Setup information
· Each individual option setting in the Options menu

Delete SoundFile
This option deletes a soundfile and its associated peak data file. Use the file dialog box to select a file. 
You will then be prompted for verification before the file is actually deleted. Click OK to delete the file or 
Cancel to stop the operation.

It is always best to delete soundfiles using this command rather than from outside of SAW32/SAWPlus32
(i.e. Explorer or My Computer). This ensures that both the soundfile and the peak data file are deleted as 
a group.

I Regarding Deleting Soundfiles: Avoid deleting soundfiles that are part of your current work session.
It is recommended that you first remove all Regions referencing the soundfile, close your editlist file, 
and then delete the soundfile.

Delete EditListFile
This option deletes an EDL file. Use the file dialog box to select a file. You will then be prompted for 
verification before the file is actually deleted. Click OK to delete the file or Cancel to cancel the operation. 
This option does not delete the soundfiles referenced by the editlist, only the session information.



Split Stereo File
This option splits a stereo file into two separate mono files. You will be asked for the source filename and 
then the new left and right filenames. The source file is not destroyed by this operation.

Exit
This option exits the program. SAW32/SAWPlus32 will prompt you to save your EDL file if you have 
made any changes since the last time saved, or to confirm that you want to exit.

I Regarding Saving Editlists: It’s a good idea to get in the habit of saving your editlist frequently and 
always prior to exiting SAW32/SAWPlus32. This minimizes the chance of accidentally exiting without 
saving your current work session. All soundfile data, however, is securely saved on the hard disk as 
soon as it is recorded.



Edit Menu
The Edit menu contains several options which allow you to directly manipulate audio data within your 
soundfiles. Some of these options actually overwrite the originally recorded soundfile data, and are 
therefore called destructive processes.

SAW32/SAWPlus32 can keep information in an Undo file that allows you to Undo the last destructive 
operation performed. Writing the Undo information takes extra processing time and hard disk storage 
space. Consequently, you are given the choice of skipping this process if you feel you do not need the 
Undo information for a particular operation.

When you select one of these options, a warning dialog box is displayed giving you three choices:

1. Select OK to proceed with the operation and save the current audio data to an Undo file, giving you 
the chance to Undo the process later.

2. Select Cancel to abort the operation.

3. Select OK / No Undo to proceed with the operation without saving the Undo information. This will be 
a faster operation, but you will no longer have the option to Undo the process later.

» Some of these operations write the results to a new soundfile. An Undo file is not needed, since the 
original data is not destroyed. Therefore, using the OK / No Undo option is the preferred choice as it 
saves time and hard drive space. 

When processing large data areas, creating Undo files can be very time consuming and require 
large amounts of extra disk space. Consider testing the operation on a small area first, using the OK
option to create an Undo file. Repeat the Undo process on the small area until the desired results 
are achieved. Use the Undo process one more time to restore the soundfile to it’s original state, then
process the large area using the OK / No Undo option.

Undo (Alt and U)
This option allows you to Undo the last destructive operation or EDL manipulation that was saved to the 
Undo file. When no Undo file exists, this option will be grayed and unavailable. Many MultiTrack 
manipulations as well as destructive operations will create an Undo file. 

When you select Undo, if the Undo is associated with a destructive file operation, the file will be opened 
and displayed in the SoundFile View, the affected data will be displayed as a Marked Area, and you will 
be notified of the type of operation you are about to Undo. Click OK to replace the original data back into 
the soundfile or Cancel to leave things as they are.

If the Undo is associated with and EDL manipulation (i.e. functions affecting MT Entries, Regions, mix 
changes, etc.), you will be notified that you are about to Undo the last EDL change. Click OK to restore 
the EDL or Cancel to leave things as they are.

F The Auto EDL Undo option under the Options menu must be checked for the Undo function to 
operate with EDL manipulations.

» SAW32/SAWPlus32 has the ability to save multiple versions of a session under one common EDL 
file. This feature was designed to enhance the power of the typical Undo list, which usually can only 
step backward in a serial fashion. Multiple EDL versions can be recalled completely independently of 
each other, in any sequence, and up to nine of them can be created. At any time (especially before 
attempting a major change in your session), press the Ctrl and Shift keys and a number key (1-9 on 
the main keyboard). A version of the current EDL will be saved to that number key, retaining all of the 



present session information. You may restore that version by pressing the Ctrl key and the 
corresponding number key. The versions will stay available with the original EDL even after exiting the
program.

F Versions of an EDL are saved using the current EDL name, with the extension modified to 
reflect the version number. (For example, TEST.EDL will change to TEST.ED1 for version one, 
and TEST.ED2 for version two, etc.)

F If the Auto EDL Undo option is active, most EDL manipulations will save an Undo file as the 
current EDL file name with the extension modified to .ED0. If for any reason an important .EDL 
is rendered unusable, many times changing the extension of the associated .ED0 file (if one 
exists) to .EDL will allow you to retrieve the EDL in the condition it was prior to your last major 
EDL manipulation.

Copy Marked (SoundFile)
This option copies the currently marked soundfile area to the SAW32/SAWPlus32 internal clipboard (not 
the Windows clipboard). It only copies pointer information, not audio data, and therefore does not require 
massive amounts of storage space.

To use this option, first mark the area of interest in the SoundFile View and then select the Copy Marked 
option. You will hear two beeps signaling the completion of a successful copy operation.

Paste Clipboard to Current SoundFile
This option pastes the audio data referenced in the SAW32/SAWPlus32 clipboard (not the Windows 
clipboard) to the current SoundFile View cursor position. 

Position the SoundFile View cursor at the location where you would like to paste the data then select this 
function. You will be warned that this is a destructive process. Choose an option and the clipboard data 
will be pasted at the cursor position.

This function overwrites the existing data in the destination soundfile, adding to the file length if 
necessary. The destination soundfile does not have to be the same soundfile from which the clipboard 
data was taken, but it does have to be the same format (i.e. samplerate, resolution, file type). This allows 
audio data to be easily moved from one soundfile to another.

F After this operation, the newly pasted data will be automatically displayed as a Marked Area. This can
save time when updating or creating new Regions associated with this data in its new location.

Paste Clipboard to New SoundFile
This option pastes the audio data referenced in the SAW32/SAWPlus32 clipboard (not the Windows 
clipboard) to a new SoundFile, or appends the data to the end of an existing file.

Using this option will display the File dialog box. Create a new name or select an existing name and click 
OK. You will be warned that this is a destructive process. Choose an option and the clipboard data will be 
written to the new file or appended to the end of the existing file.

F After this operation, the new file will be opened in the SoundFile View and the newly pasted data will 
be automatically displayed as a Marked Area. This can save time when updating or creating new 
Regions associated with this data in its new location.



Cut (Delete) Marked from SoundFile
This option allows you to physically cut audio data from the soundfile. This permanently alters the size of 
the file and cannot be reversed. 

When selecting this option the Edit Cut SoundFile dialog box is displayed. The Preview button plays back 
the soundfile in the SoundFile View and skips over the marked area, allowing you to hear the effect of the 
cut before actually cutting the file. Place your cursor a small distance before the Marked Area begin 
boundary to define a PreRoll distance. Playback begins at this point and continues for the same 
approximate distance after the cut. Adjust the Marked Area boundary positions to your satisfaction, and 
click the Cut Snd File button. 

I Regarding Cutting Soundfiles: This operation must move all data past the cut end-point forward to 
the cut begin-point and can be an extremely time consuming procedure when working with large files.
All Regions past the cut begin-point will become invalid and can cause random session errors if 
referenced data has been moved forward or no longer exists. If you find it necessary to trim 
soundfiles in this manner, do so prior to creating Regions. 

Physically cutting a soundfile is not the most efficient way to work in the SAW32/SAWPlus32 
environment. We suggest using the power of non-linear editing instead, where it is unnecessary to 
worry about extraneous audio data in your soundfiles. Using Regions and the power of the MultiTrack 
allows you to skip over soundfile data you don’t want to use in the final production, easily, instantly, 
and non-destructively. 

Hard drives with gigabytes of storage space are now very affordable. If concerned about saving hard 
drive space by trimming files using this function, consider that the cost of a new hard drive can easily 
be offset by the tremendous savings of your valuable time by using SAW32/SAWPlus32’s non-linear 
power, rather than waiting for this function to do its job.

Clear Marked Left (SoundFile)
This option clears the left channel of the currently marked soundfile area to zero. This is a destructive 
operation and undoing it is subject to your choice of saving the Undo file information or not.

To use this function, create a Marked Area in the SoundFile View and select this option.

Clear Marked Right (SoundFile)
This option clears the right channel of the currently marked soundfile area to zero. This is a destructive 
operation and undoing it is subject to your choice of saving the Undo file information or not.

To use this function, create a Marked Area in the SoundFile View and select this option.

Clear Marked (SoundFile)
This option clears both channels of the currently marked soundfile area to zero. This is a destructive 
operation and undoing it is subject to your choice of saving the Undo file information or not.

To use this function, create a Marked Area in the SoundFile View and select this option.

Paste Marked Left to Right (SoundFile)



This option pastes the left channel data to the right channel (at the same location) of the currently marked
soundfile area. This is a destructive operation and undoing it is subject to your choice of saving the Undo 
file information or not.

To use this function, create a Marked Area in the SoundFile View and select this option.

Paste Marked Right to Left (SoundFile)
This option pastes the right channel data to the left channel (at the same location) of the currently marked
soundfile area. This is a destructive operation and undoing it is subject to your choice of saving the Undo 
file information or not.

To use this function, create a Marked Area in the SoundFile View and select this option.

Mix Marked Left to Right (SoundFile)
This option mixes the left channel data to the right channel (at the same location) of the currently marked 
soundfile area. This results in the left channel remaining intact and the right channel becoming a mono 
mix of left and right data. This is a destructive operation and undoing it is subject to your choice of saving 
the Undo file information or not.

To use this function, create a Marked Area in the SoundFile View and select this option.

Mix Marked Right to Left (SoundFile)
This option mixes the right channel data to the left channel (at the same location) of the currently marked 
soundfile area. This results in the right channel remaining intact and the left channel becoming a mono 
mix of left and right data. This is a destructive operation and undoing it is subject to your choice of saving 
the Undo file information or not.

To use this function, create a Marked Area in the SoundFile View and select this option.

Mix Marked (SoundFile)
This option mixes both left and right channel data to both channels (at the same location) of the currently 
marked soundfile area. This results in a mono mix of left and right data on both channels. This is a 
destructive operation and undoing it is subject to your choice of saving the Undo file information or not.

To use this function, create a Marked Area in the SoundFile View and select this option.

Calibrate DC Offset (SoundFile)
SAW32/SAWPlus32 can be calibrated to compensate for audio cards or external equipment that create 
some level of constant DC offset voltage in your recorded soundfiles. A soundfile without DC offset will 
display its audio waveform peaks and valleys evenly balanced above and below the display center line 
(zero reference). A soundfile with some level of DC offset will display a shift in either the positive or 
negative direction, and can potentially cause pops at the beginning and ending of Region playback.

To use the Calibrate DC Offset function on existing soundfiles, zoom in on a blank section of the soundfile
and click the Up button on the SoundFile View window, (or press the Page Up key) to magnify the 



waveform. You should see a flat line for both the left and right channels. As you continue to increase the 
magnification, the flat lines will start to show noise waveforms, but should still be balanced around each 
center line. If there is DC Offset present then the lines will tend to shift above or below their respective 
center lines.

Create a small Marked Area and select this function. SAW32/SAWPlus32 calculates the average DC 
Offset in the section and reports and saves the values. 

Apply DC Offset (SoundFile)
This function uses the Calibrate DC Offset values and applies them to the soundfile Marked Area. 

After using Calibrate DC Offset function, mark the entire soundfile or area of interest and select this 
function. 

SAW32/SAWPlus32 applies the calibration values and centers the waveform properly around the center 
lines, thereby eliminating the potential pops that might occur on Region boundaries.

This is a destructive operation and undoing it is subject to your choice of saving the Undo file information 
or not.



Regions Menu
The Regions Menu contains options which allow you to create and manipulate Regions, which are the 
basic building blocks of your production in the SAW32/SAWPlus32 environment. Regions can be 
manipulated in various ways and are the basis for performing non-destructive splices, mixes, etc. 

See Regions View Window in the Understanding the Interface section for detailed information on working 
with Regions.

Create New Region (Ctrl and N)
This option allows you to create and name a new Region.

First mark the area of interest in the SoundFile View window, select the desired zoom and magnification 
level, and select this option.

In the Input Text dialog box, accept the default name or enter a new name for the Region. Click OK to 
create the new region.

Update Region (Ctrl and U)
This option allows you to rename, adjust and update the parameters of an existing Region.

First select and display the existing Region into the SoundFile View by one of the various methods 
explained in the Understanding the Interface section.

Make any desired parameter adjustments and select this option. The original name is displayed in the 
Input Text dialog box, which can be changed if desired. Click OK to update the Region and all associated 
MT Entries that reference it.

Get EDL Region
This option allows you to easily import a Region from another EDL file into the current editing session, 
making it simple to retrieve existing Regions from other editing sessions you have created.

When this option is selected, the File dialog box is displayed, allowing you to select another EDL file. A 
second Regions View window is then displayed, containing the Regions from the selected EDL file. You 
can now select and preview Regions from this window in the same manner as the current editing session.

By clicking the Add to EDL button in the new Regions View window, the newly selected Region is copied 
into the current EDL session. You may continue auditioning and adding as many Regions as desired. 
When you are finished, close the second Regions View window.

The newly added Regions are now available in the current editing session for further use.

Merge EDL Regions
This option allows you to easily import all Regions from another EDL file into the current editing session. 

When this option is selected, the File dialog box is displayed, allowing you to select another EDL file. All 
Regions from that EDL will be instantly added to the current editing session.



Split/Keep Region (Ctrl and K)
This option splits an existing Region, and MT Entries referencing this Region, into two parts. 

This function works in either the MultiTrack or SoundFile View and is also available in the Split Region 
Tools toolbar window.

SoundFile View
To use this function in SoundFile View, first display the Region in the SoundFile View window, using one 
of the various methods explained in the Understanding the Interface section. Position the SoundFile View 
cursor at the point where you want to divide the Region and select this option. The Region and all 
associated MT Entries are split at that point. The Region and the associated entries to the left of the split 
retain the original name. The Region and the associated entries to the right of the split will have a unique 
number appended to the original name.

MultiTrack View
When using this function in MultiTrack View, an MT Entry becomes the focal point for the split and is the 
only entry affected by the split. Position the MultiTrack View cursor at the point where you want to split the
MT Entry and select this option. The MT Entry and associated Region is split at that point. The entry and 
the associated Region to the left of the split retain the original name. The entry and the associated Region
to the right of the split will have a unique number appended to the original name.

Split/Mark Region (Ctrl and M)
This option splits an existing Region, and MT Entries referencing this Region, into two parts, and 
automatically marks any associated entry to the left of the split point as a Select mode selected entry.

This function works in either the MultiTrack or SoundFile View and is also available in the Split Region 
Tools toolbar window.

SoundFile View
To use this function in SoundFile View, first display the Region in the SoundFile View window, using one 
of the various methods explained in the Understanding the Interface section. Position the SoundFile View 
cursor at the point where you want to divide the Region and select this option. The Region and all 
associated MT Entries are split at that point. The Region and the associated entries to the left of the split 
retain the original name and leave the entries marked as Select mode selected entries. The Region and 
the associated entries to the right of the split will have a unique number appended to the original name.

MultiTrack View
When using this function in MultiTrack View, an MT Entry becomes the focal point for the split and is the 
only entry affected by the split. Position the MultiTrack View cursor at the point where you want to split the
MT Entry and select this option. The MT Entry and associated Region is split at that point. The entry and 
the associated Region to the left of the split retain the original name and the entry is marked as a Select 
mode selected entry. The entry and the associated Region to the right of the split will have a unique 
number appended to the original name.

When Select mode is active, this function can be used to perform several Split/Mark operations in 
succession and then copy, move or delete the pre-selected entries all at once. Clear all selected Regions 
(by right-clicking while in Select mode) prior to using the Split/Mark function.

F If Select mode is not active at the time of using this option, ensure that you enter Select mode while 
pressing the Shift key to retain the marks set by this function.



Split/Remove Region (Ctrl and R)
This option splits an existing Region, and MT Entries referencing this Region, into two parts and 
automatically removes the Region and associated entries to the left of the split point.

This function works in either the MultiTrack or SoundFile View and is also available in the Split Region 
Tools toolbar window.

SoundFile View
To use this function in SoundFile View, first display the Region in the SoundFile View window, using one 
of the various methods explained in the Understanding the Interface section. Position the SoundFile View 
cursor at the point where you want to divide the Region and select this option. The Region and all 
associated MT Entries are split at that point. The Region and associated entries to the left of the split 
retain the original name. This Region is removed from the Regions View, and all associated entries are 
removed from the MultiTrack. All following MT Entries will be left in their original positions. The Region 
and associated entries to the right of the split will have a unique number appended to the original name.

MultiTrack View
When using this function in MultiTrack View, an MT Entry becomes the focal point for the split and is the 
only entry affected by the split. Position the MultiTrack View cursor at the point where you want to split the
MT Entry. If this is the only entry referencing the Region, this entry and the associated Region are split at 
that point. The entry and associated Region to the left of the split retain the original name. This entry is 
removed from the MultiTrack, and the associated Region is removed from the Regions View. All following 
MT Entries are left in their original positions. 

If there are multiple entries referencing the same Region, the associated Region is duplicated and a 
unique number appended to the original name, and the MT Entry is updated to reference this duplicate 
Region. The entry and the duplicate Region are then split at that point. The entry and the associated 
Region to the left of the split retain the original name. This entry is removed from the MultiTrack, and the 
associated Region is removed from the Regions View. All following MT Entries are left in their original 
positions. The entry and associated Region to the right of the split will have a unique number appended to
the original name.

Split/Delete Region (Ctrl and D)
This option splits an existing Region, and MT Entries referencing this Region, into two parts and 
automatically deletes the Region and associated entries to the left of the split point.

This function works in either the MultiTrack or SoundFile View and is also available in the Split Region 
Tools toolbar window.

SoundFile View
To use this function in SoundFile View, first display the Region in the SoundFile View window, using one 
of the various methods explained in the Understanding the Interface section. Position the SoundFile View 
cursor at the point where you want to divide the Region and select this option. The Region and all 
associated MT Entries are split at that point. The Region and associated entries to the left of the split 
retain the original name. This Region is deleted from the Regions View, and all associated entries are 
deleted from the MultiTrack. All following MT Entries will shift forward from their original positions 
replacing any resulting gaps. The Region and associated entries to the right of the split will have a unique 
number appended to the original name.

MultiTrack View



When using this function in MultiTrack View, an MT Entry becomes the focal point for the split and is the 
only entry affected by the split. Position the MultiTrack View cursor at the point where you want to split the
MT Entry. If this is the only entry referencing the Region, this entry and the associated Region are split at 
that point. The entry and associated Region to the left of the split retain the original name. This entry is 
deleted from the MultiTrack, and the associated Region is deleted from the Regions View. All following 
MT Entries will shift forward from their original positions replacing any resulting gaps.

If there are multiple entries referencing the same Region, the associated Region is duplicated and a 
unique number appended to the original name, and the MT Entry is updated to reference this duplicate 
Region. The entry and the duplicate Region are then split at that point. The entry and the associated 
Region to the left of the split retain the original name. This entry is deleted from the MultiTrack, and the 
associated Region is deleted from the Regions View. All following MT Entries will shift forward from their 
original positions replacing any resulting gaps. The entry and associated Region to the right of the split 
will have a unique number appended to the original name.

Remove Region (Don't Affect Other MT Entries) (Del)
This option removes the currently selected region (in the Regions View), and all associated MT Entries 
from the session. Any following entries in the MultiTrack are not affected and remain in their original 
position.

Delete Region (Move Other MT Entries Frwd) (Shift and Del)
This option removes the currently selected region (in the Regions View), and all associated MT Entries 
from the session. All following entries in the MultiTrack are shifted forward replacing any resulting gaps.

Clear All Regions
This option clears all Regions from the Regions View list and all MT Entries from the MultiTrack. This 
operation does not destroy any soundfile data but it does clear your entire session.

Clear All Unused Regions
This option scans through all tracks of your production and removes all Regions from the EDL that are not
being referenced by MT Entries.

Paste Region to Current SoundFile
This option pastes the currently selected Region (in the Regions View) to the current SoundFile View 
cursor position. 

Position the SoundFile View cursor at the location where you would like to paste the data then select this 
function. You will be warned that this is a destructive process. Choose an option and the clipboard data 
will be pasted at the cursor position.

This function overwrites the existing data in the destination soundfile, adding to the file length if 
necessary. The destination soundfile does not have to be the same soundfile which contains the Region, 
but it does have to be the same format (i.e. samplerate, resolution, file type). This allows audio data to be 
easily moved from one soundfile to another.



F After this operation, the newly pasted data will be automatically displayed as a Marked Area. This can
save time when updating or creating new Regions associated with this data in its new location.

Paste Region to New SoundFile
This option pastes the currently selected Region (in the Regions View) to a new SoundFile, or appends 
the data to the end of an existing file.

Using this option will display the File dialog box. Create a new name or select an existing name and click 
OK. You will be warned that this is a destructive process. Choose an option and the clipboard data will be 
written to the new file or appended to the end of the existing file.

F After this operation, the new file will be opened in the SoundFile View and the newly pasted data will 
be automatically displayed as a Marked Area. This can save time when updating or creating new 
Regions associated with this data in its new location.

Paste Region and Convert SampleRate to Current SoundFile
This option pastes the currently selected Region (in the Regions View) to the current SoundFile View 
cursor position, and performs a samplerate conversion at the same time. 

Position the SoundFile View cursor at the location where you would like to paste the data then select this 
function. The Set Conversion Parameters dialog box is displayed, allowing you to select a new 
samplerate. The destination file samplerate must match the newly selected rate. You will be warned that 
this is a destructive process. Choose an option and the Region will be pasted at the cursor position and 
converted at the same time.

F SAW32/SAWPlus32 performs the samplerate conversion without removing or duplicating any 
samples, thereby producing extremely clean, glitch-free results.

This function overwrites the existing data in the destination soundfile, adding to the file length if 
necessary.

F After this operation, the newly pasted data will be automatically displayed as a Marked Area. This can
save time when updating or creating new Regions associated with this data in its new location.

Paste Region and Convert SampleRate to New SoundFile
This option pastes the currently selected Region (in the Regions View) to a new SoundFile, or appends 
the data to the end of an existing file, and performs a samplerate conversion at the same time.

Using this option will display the Set Conversion Parameters dialog box, allowing you to select a new 
samplerate. Next, the File dialog box is displayed. Create a new name or select an existing name and 
click OK. If selecting an existing file, the destination samplerate must match the newly selected rate. You 
will be warned that this is a destructive process. Choose an option and the Region will be written to the 
new file or appended to the end of the existing file and converted at the same time.

F After this operation, the new file will be opened in the SoundFile View and the newly pasted data will 
be automatically displayed as a Marked Area. This can save time when updating or creating new 
Regions associated with this data in its new location.





MultiTrack Menu
The MultiTrack Menu provides several options for manipulating MT Entries in the MultiTrack. Some of the 
functions operate on the Hot Track MT Entry at the current MultiTrack cursor position. Some functions 
operate on a Marked Area, while other functions require Select mode to be activated, and operate on only
selected entries. 

Replace Entry (R)
This option replaces the Hot Track MT Entry at the MultiTrack cursor position with the selected Region 
from the Regions View list. This action affects other entries as follows:

· The replacement entry shifts all following butt-spliced entries forward or backward to accommodate 
any size difference between the original and replacement entries.

· Any following entries that are separated by blank space will not be moved, if there is enough space to
accommodate the change. If there is not enough space to accommodate the increased region size, a 
conflict exists and the operation will be cancelled.

To use this option, click on the entry you wish to replace in the MultiTrack, then click on the replacement 
Region in the Regions View. Select this option, and click OK to confirm the replacement.

F If there is a conflict (causing the operation to be cancelled), try moving the conflicting entry to another 
track, then perform the replacement operation again.

Update Entry (U)
This option selects the Hot Track MT Entry boundary closest to the MultiTrack cursor position, and moves 
the boundary to the cursor position, extending or shrinking the entry size.

To use this option, place the MultiTrack cursor at a position near the MT Entry boundary you wish to 
adjust, and select this function to move the boundary to the cursor position. If two entries are butt-spliced, 
both will be adjusted at the same time so that the splice point is then at the cursor position.

Remove Entry (Don't Affect Others) (Del)
This option removes an individual MT Entry or multiple Select mode selected entries from the MultiTrack. 
All following entries to the right are not affected and remain in their original positions.

Select an entry by clicking and placing the MultiTrack View cursor on it, or use Select mode, and select 
and highlight multiple entries prior to using this function.

This function removes only the selected MT Entries, and does not affect the referenced regions in the 
Regions View list.

Delete Entry (Move Others Frwd) (Shift and Del)
This option deletes an individual MT Entry or multiple Select mode selected entries from the MultiTrack. 
All following entries to the right are shifted forward filling in any remaining gaps.

Select an entry by clicking and placing the MultiTrack View cursor on it, or use Select mode, and select 



and highlight multiple entries prior to using this function.

This function deletes only the selected MT Entries, and does not affect the referenced regions in the 
Regions View list.

Clear Entries On Current Track
This option clears the current Hot Track of all MT Entries at once. The Regions and Markers View 
windows are not affected.

Clear Entries On All Tracks
This option clears the entire MultiTrack of all MT Entries at once. The Regions and Markers View windows
are not affected.

Cut/Remove Entry
This option cuts and removes the Marked Area from an existing MT Entry.

This function is also available in the Cut MT Entry Tools toolbar window.

To use this option, create a Marked Area within the boundaries of an existing MT Entry that you wish to 
remove, then select this function.

F The Marked Area cannot include or span across an entry boundary.

This function operates only on the selected entry and does not affect duplicate entries referencing the 
same Region.

Cut/Splice Entry
This option cuts the Marked Area from an existing MT Entry and splices the ends together, very much 
emulating tape splicing with a razor blade.

This function is also available in the Cut MT Entry Tools toolbar window.

To use this option, create a Marked Area within the boundaries of an existing MT Entry that you wish to 
cut, then select this function.

F The Marked Area cannot include or span across an entry boundary.

This function operates only on the selected entry and does not affect duplicate entries referencing the 
same Region.

Snap Selected to Cursor (BackSpace)
This option snaps all Select mode selected entries to the current MultiTrack cursor position, using the 
beginning boundary of the Key Entry as the reference point. All MultiTrack mix changes within MT Entry 
boundaries are included in the move.



To use this option, activate Select mode and select the entries you wish to move. Click last on the entry 
you wish to use as the snap-to reference point (Key Entry), even if it has already been selected. The left 
side of the Key Entry will be the point that snaps to the cursor position.

Place the MultiTrack View cursor at the desired position and select this function.

Snap Selected to SMPTE
This option snaps all Select mode selected entries to a specified SMPTE position, using the beginning 
boundary of the Key Entry as the reference point. All MultiTrack mix changes within MT Entry boundaries 
are included in the move.

F These options are not available until one of the SMPTE modes are activated.

To use this option, activate Select mode and select the entries you wish to move. Click last on the entry 
you wish to use as the snap-to reference point (Key Entry), even if it has already been selected. The left 
side of the Key Entry will be the point that snaps to the specified SMPTE position.

Select this function, and the SMPTE position window will be displayed. Set the desired SMPTE position 
and click OK. (See the Working with SMPTE section for details on using the SMPTE position window.)

Set Offset
This option allows you to set any point within an MT Entry as an offset from the beginning of the entry. 
This offset can then be used as the snap-to point instead of the beginning of the Key Entry. 

To set the offset, select the desired point within the entry, and select this function. The offset is now 
established, and can be used with one of the Snap Selected Offset options.

Snap Selected Offset To Cursor
This option snaps all Select mode selected entries to the current MultiTrack cursor position, using an 
established offset position of the Key Entry as the reference point. All MultiTrack mix changes within MT 
Entry boundaries are included in the move.

To use this option, first use the Set Offset function to establish an offset position within your desired Key 
Entry. 

Activate Select mode and select the entries you wish to move. Click last on the desired Key Entry, even if 
it has already been selected. The established offset within the Key Entry will be the point that snaps to the
cursor position.

Place the MultiTrack View cursor at the desired position and select this function.

Snap Selected Offset To SMPTE
This option snaps all Select mode selected entries to a specified SMPTE position, using an established 
offset position of the Key Entry as the reference point. All MultiTrack mix changes within MT Entry 
boundaries are included in the move.

F These options are not available until one of the SMPTE modes are activated.



To use this option, first use the Set Offset function to establish an offset position within your desired Key 
Entry. 

Activate Select mode and select the entries you wish to move. Click last on the desired Key Entry, even if 
it has already been selected. The established offset within the Key Entry will be the point that snaps to the
specified SMPTE position.

Select this function, and the SMPTE position window will be displayed. Set the desired SMPTE position 
and click OK. (See the Working with SMPTE section for details on using the SMPTE position window.)

Multi-Channel Record Mode
This option activates Multi-Channel Record mode. (See the MultiTrack Recording section for more details 
on Multi-Channel Record mode.)

Multi-Channel Record Setup
This option allows you to select a base file name for Multi-Channel Record mode operation. The base file 
name must be set before recording will be allowed in Multi-Channel Record mode. (See the MultiTrack 
Recording section for more details on Multi-Channel Record mode.)



Mix Menu
The Mix Menu provides several options for manipulating volume and pan automation. Many of these 
functions work within a Marked Area. 

F Using the keyboard equivalents in many cases, bypasses the confirmation prompts, allowing for 
quicker operation.

Fade To Next Volume Change (F)
This option creates a fade from the current MultiTrack View cursor position to the next volume mix change
position on the currently selected track. The fade will be a fade in or fade out depending on whether the 
next volume change is higher or lower in level than the level at the current cursor position. 

The fade curve created is defined in the Fade Curve Setup option in the Mix menu. (For more details on 
working with fades, see the Controlling the Mix section.)

Fade Curve Setup (Shift and F)
This option allows you to select the fade curve shape used in the various fade functions. Selecting this 
option displays the Fade Curve Selection dialog box.

The Active Curve display on the left shows the relative shape of the currently selected curve. The 
Selections list box on the right displays a list of available curve shapes.

To select a new curve shape, click on name in the Selections list. The new curve shape will be shown in 
the Active Curve display. This curve will be the default setting for all subsequent fades performed until you
select a new fade curve.

Sweep To Next Pan Change(P)
This option creates a smooth pan sweep from the current MultiTrack View cursor position to the next pan 
mix change position on the currently selected track. The direction of the sweep will depend on whether 
the next pan change is further left or right from the pan setting at the current cursor position. (For more 
details on working with pans, see the Controlling the Mix section.)

Fade Out Marked (O)
This option creates a fade out within a Marked Area. The fade starts from the current volume level at the 
beginning of the Marked Area and ends at a zero level. 

The fade curve created is defined in the Fade Curve Setup option in the Mix menu. (For more details on 
working with fades, see the Controlling the Mix section.)

Fade In Marked (I)
This option creates a fade in within a Marked Area. The fade starts from a zero level at the beginning of 
the Marked Area and ends at the Marked Area end boundary volume level. 



The fade curve created is defined in the Fade Curve Setup option in the Mix menu. (For more details on 
working with fades, see the Controlling the Mix section.)

CrossFade Marked Or Overlapped to Next Track (X)
This option creates a crossfade between two overlapping entries on two adjacent tracks. The length of the
crossfade is defined by a Marked Area, or the entire overlap if no Marked Area exists. The crossover 
equal energy point is defined by the current cursor position placed within the overlapped or Marked Area. 

The curve used for the crossfade is defined in the Fade Curve Setup option in the Mix menu. (For more 
details on working with crossfades, see the Controlling the Mix section.)

CrossFade (-6db) Marked Or Overlapped to Next Track (Shift and X)
This option creates a crossfade between two overlapping entries on two adjacent tracks. The length of the
crossfade is defined by a Marked Area, or the entire overlap if no Marked Area exists. The crossover 
equal energy point is defined by the current cursor position placed within the overlapped or Marked Area 
and occurs at a -6db level. This creates a crossfade with no apparent decrease in volume during the 
transition. 

The curve used for the crossfade is defined in the Fade Curve Setup option in the Mix menu. (For more 
details on working with crossfades, see the Controlling the Mix section.)

Clear Marked Vol And Pan Changes (Shift and C)
This option resets all volume changes to 0db, and pan changes to center within a Marked Area.

Clear Marked Vol Changes (Shift and V)
This option resets all volume changes to 0db within a Marked Area, leaving the pan changes undisturbed.

Clear Marked Pan Changes (Shift and P)
This option resets pan changes to center within a Marked Area, leaving the volume changes undisturbed.

Reverse Marked Vol And Pan Changes (Shift and R)
This option reverses all volume and pan changes within a Marked Area. For example, fade outs will now 
fade in, and pan sweeps will reverse direction.

Snap Marked Mix Changes to Cursor (Backspace)
This option is used to precisely position marked mix changes to the MultiTrack Cursor location, for 
example, relocating a fade to the exact position of a slightly extending MT Entry boundary.    This option 
can only be used when the track fader is open and a marked mix area exists.

» For a quick way to snap a fade to the beginning boundary of an MT Entry, try this: Place the 



MultiTrack cursor in front of the fade and use the fader Next button to snap the cursor to the 
beginning of the fade. Press the B key to mark the beginning. Place the cursor past the end of the 
fade and press the E key to mark the end. Use the tab key to position the cursor at the MultiTrack 
boundary and select this option from the menu, or press the backspace key. The fade begin will snap 
to the cursor position at the entry boundary.



Process/MixDown Menu

This menu contains options for processing modified data back to original soundfiles (destructive), or 
building mixdowns of all MultiTrack elements to various destinations.

Process Marked Area Back To Original File (Destructive)
This option allows effects and mix changes to be processed and written back to the original soundfile. 
This eliminates the need for live processing during MultiTrack playback and can free up CPU time for 
other processing operations. 

I This is a destructive process. Changes are written directly back to the original soundfile, 
permanently modifying the data.

This option works on a single MT Entry on the current Hot Track of the MultiTrack. Any effects or mix 
changes applied to that track will be permanently written back to the entry’s referenced soundfile. 

To use this option, first mark the entire entry or a section of it (you cannot mark across different entries). 
Make sure the track is selected as the Hot Track and then select this function.

You will be warned that this is a destructive process. Choose an option to continue with or without 
creating an Undo file, or cancel the operation. 

When the process is finished, double-click the MT Entry to transfer it to the SoundFile View. Here you can
play it back and hear the results of the processing. Playing it back in the MultiTrack without first clearing 
the effects and mix changes would result in applying the effects again to the already processed data. If 
the results you hear in the SoundFile View are satisfactory, clear the processed effects and mix changes 
from the Hot Track to gain back the CPU processing time that was required to perform the effects live.

F Vari-Pitch and Reverse Audio effects cannot be processed back to the original file using this option. 
You must use one of the BuildMix options to process those effects to a destination different from the 
original soundfile.

Force FX Pre-Scan/Playback
This option can be used to force an FX Pre-Scan and begin immediate playback so that, for example, you
may hear PeakLimit and Normalize functions live. This is also useful if you want to mix directly to DAT 
with PeakLimit and Normalize functions, and do not wish to process the data destructively, or build a mix 
to a separate soundfile.

Build Mix To Output Track File
This option builds a mixdown of all active (un-muted) tracks in the MultiTrack to a new soundfile for each 
assigned output card, and places the file(s) on the respective output track(s). This process can also 
perform samplerate, file type, and bit resolution conversion if desired.

All tracks assigned to the same output card destination will be grouped and mixed together. All effects and
mix changes assigned to the entries on those tracks will be included. The resulting soundfile will be 
placed as an MT Entry on the respective output track.



If a MultiTrack Marked Area exists, the mix will begin and end at the Marked Area boundaries across all 
tracks.

If there is no active Marked Area, the mix includes the entire length of the active tracks from beginning to 
end.

F Each output track acts as a master for all tracks assigned to it. All effects, volume and pan settings on
the output tracks are included in the mix. Use this feature to adjust overall volume levels of a mix, or 
apply a specific effect to all tracks simultaneously.

When choosing this option, the Set Conversion Parameters dialog box is displayed allowing you to 
change samplerate, file type, or bit resolution for the destination files. The In parameters will display the 
current settings. Change any Out parameter, if desired, and click OK, or click Cancel to abort the 
operation.

Next, the File dialog box is displayed prompting you to enter a file name for each active output track mix 
file. Once all file names are entered, the mixdown will proceed. 

A progress bar is displayed showing the current status of the operation. You may press Escape (Esc) at 
any time to cancel the operation, or press Enter to continue the operation in the background, allowing you
to work in other applications while the mix is being processed.

When the process is complete, MT Entries for each mix file created are placed on their respective output 
tracks, and are displayed upon completion of the mix.

The Solo buttons on the output tracks can be used to play the mixed output files. All output track effects 
and mix changes will be temporarily bypassed, allowing you to hear the actual mix as created. If a slight 
adjustment is desired, deactivating the output solos leaves all parameters intact, ready for modification 
and a new mixdown.

F The output track solos are independent from those on the normal tracks and you cannot solo both 
sections at the same time. Output track solos override normal track solos. 

You may also audition the mixdown files by double-clicking the output MT Entries into the SoundFile View 
and playing back from there. 

If the mix is satisfactory, this new entry can be easily moved to a normal track and the original track(s) 
that created the mix can be muted or erased. This process is similar to “bouncing” tracks on a typical 
multitrack tape recording system, but since the bounce remains in the digital domain, there is no signal 
degradation as occurs when using analog tape.

F This technique allows slower machines to utilize the full power of SAW32/SAWPlus32 even though 
the machine may not be capable of playing a complex and densely packed session live. For example,
a session with 20 tracks, multiple EQ and reverb patches which will not play live in real-time, can be 
mixed in this manner, creating a single stereo output file which will play back successfully on virtually 
any machine.

Build Mix To New SoundFile
This option is similar to the Build Mix To Output File option with the following exceptions:

· New entries will not be created on the active Output Tracks.
· The newly created soundfiles can overwrite or append to existing files by your choice.



Build Mix to FX Modules
This option is similar to the Build Mix To New SoundFile option, however actual mix files are not created. 
This is designed to send your mix to special effects modules which will create their own type of output, for
example, a CD burner module which will send it’s output directly to a CD.



Window Menu
The Window menu contains options allowing you to open any SAW32/SAWPlus32 window that has been 
closed. A window which is already open displays a checkmark next to its name. Selecting a checkmarked 
option brings the applicable window to the top.

MultiTrack (Alt and Shift and M)
This option opens or brings the MultiTrack View window to the top.

Full (Alt and Shift and F)
This option opens or brings the Full View window to the top.

SoundFile (Alt and Shift and S)
This option opens or brings the SoundFile View window to the top.

Regions (Alt and Shift and R)
This option opens or brings the Regions View window to the top.

Sequence (Alt and Shift and Q)
This option opens or brings the Sequence View window to the top.

Markers (Alt and Shift and A)
This option opens or brings the Markers View window to the top.

Remote Transport (Alt and Shift and T)
This option opens the Remote Transport window. When open, it is always on top.

Split Region ToolBar
This option opens the Split Region ToolBar window. When open, it is always on top. 

This toolbar duplicates the four corresponding functions found in the Regions menu. However, using this 
toolbar bypasses all confirmation prompts, allowing quicker operation for the more advanced user.

F Pressing Ctrl while clicking the Split/Keep button on the toolbar extends the Split/Keep operation 
across all tracks below the current Hot Track.



Cut MT Entry ToolBar
This option opens the Cut MT Entry ToolBar window. When open, it is always on top. 

This toolbar duplicates the two corresponding functions found in the MultiTrack menu. However, using this
toolbar bypasses all confirmation prompts, allowing quicker operation for the more advanced user.

MultiTrack PreLoad (Alt and Shift and O)
This window allows you to adjust the amount of audio buffers that SAW32/SAWPlus32 pre-loads into 
RAM before MultiTrack playback begins. 

When MultiTrack playback is initiated, the smaller the setting, the shorter the delay before playback 
actually begins.

A larger setting causes more buffers to be pre-loaded before playback begins. This increases the 
playback delay, but can help slower computers process dense sessions in the MultiTrack, especially ones
that contain extensive mix and effects processing. 

Once playback is in process, SAW32/SAWPlus32 has stringent timing constraints that must be met in 
order to prevent audio playback gaps. If a dense or complex section of the MultiTrack requires more time 
to assemble than the time allotted, an audio glitch can result. By having more data already processed, 
ready to go, and loaded into RAM, SAW32/SAWPlus32 has more time available to assemble new 
complex sections in the background while feeding the soundcard with the already processed data from 
RAM.

F Use this option to extend preview time of a session that your machine is not capable of playing back 
in real-time. By setting the pre-load buffers extremely high, you may incur a long delay before 
playback begins, but be able to preview 10-15 seconds of actual live real-time playback. This 
extended preview can allow you to make needed adjustments in critical areas of your session that 
otherwise would not be possible prior to building a mixdown.



Smpte/Midi Menu
The Smpte/Midi menu contains options which control SAW32/SAWPlus32’s response to MIDI and 
SMPTE information.

Many functions dealing with SMPTE require you to enter SMPTE position information. In these instances, 
SAW32/SAWPlus32 will display the Enter Smpte dialog box.

Live Cue 
The Live Cue button transfers the current incoming SMPTE time into the Enter Smpte display. Use this 
button while SMPTE Time Code is being received to pick up a live cue point and transfer the Time Code 
to the display.

This method is very useful for getting close to the actual cue time you might need for a specific cue point. 
You may then use the Up/Down arrow controls to make minor adjustments.

Up/Down Arrows
These controls allow you to increment or decrement the Hours, Minutes, Seconds, Frames or Sub-
Frames in the SMPTE display.

The controls will wrap in accordance with the current SMPTE format and clicking any one of the scroll box
controls resets the associated value to zero.

F If sub-frames do not apply to the current function, the sub-frame controls will be grayed and disabled.

Reset 
The Reset button resets all values in the SMPTE time display to zero.

OK and Cancel 
After setting the SMPTE display value click OK to exit and accept the value, or Cancel to cancel the 
operation.

For more information on using SMPTE, see the Working with SMPTE section.

Receive Midi Trigger
This option allows SAW32/SAWPlus32 to trigger Region or SF/MT Marker playback in response to 
incoming MIDI note information, arriving at a MIDI In-port. Selecting this option toggles the MIDI trigger on
and off. This menu item will be grayed and unavailable if no MIDI In-device has been selected in the 
Midi/Smpte Hardware Setup under the Options menu.

Using MIDI Trigger, you may play only one Region or Marker location at a time. Receiving another trigger 
while one is still playing, cuts off playback of the first to start playback of the second.

You must first assign MIDI notes to Regions or Marker locations using the Assign MIDI Notes To 
Regions/Markers option under the Midi/Smpte menu before MIDI Trigger will function.

Assign Midi Notes To Regions/Markers
This option allows you to assign MIDI Trigger notes to Regions or Marker locations. When the Receive 



Midi Trigger option is activated, and an assigned MIDI note is received at the MIDI in-port, the associated 
Region or Marker location is played. This menu item will be grayed and unavailable if no MIDI In-device 
has been selected in the Midi/Smpte Hardware Setup under the Options menu.

Assigning a MIDI Note to a Region causes the Region to begin playback upon triggering.

Assigning a MIDI Note to an SF Marker causes the associated soundfile to load and begin playback at the
Marker location upon triggering.

Assigning a MIDI Note to an MT Marker causes the MultiTrack to cue and begin playback at the Marker 
location upon triggering.

When selecting this option, the Assign Midi Notes dialog box is displayed. 

Assign Midi Notes Dialog Box Operation
The Assign Midi Notes dialog box displays a list of MIDI notes spanning ten octaves from C0 through 
G10. Assigned Regions or Markers and Note-Off parameters are displayed next to associated MIDI Notes
in the list. When this dialog box is open, it is actively connected to the MIDI in-port, and triggering MIDI 
Notes from a MIDI keyboard will instantly select that note in the list box. You may also select any note by 
clicking once with the left mouse button.

Assign
The Assign button and the associated title box above it are used to assign the selected Region or Marker 
to the currently selected MIDI Note, with the current Note-Off parameter. 

Selecting a Region from the Regions View or selecting a Marker from the Markers View automatically 
updates the title box above this button.

To assign a MIDI Note, first select the Region or Marker so that it is displayed in the title box, then select a
MIDI Note. Select the desired Note-Off option and click the Assign button.

Note Off
The Note-Off button offers three options for utilizing the MIDI Note-Off signal that occurs when you 
release a MIDI keyboard note.

· Ignore it (--): Playback trigger is applied when the Note-On signal is received and continues 
after the note is released until the end of the Region or Marker selection, or until playback is stopped 
by some other means.

· Stop Playback: Playback trigger is applied when the Note-On signal is received and stopped 
when the Note-Off signal is received (when the note is released).

· Start Playback: Playback is cued when the Note-On signal is received and triggered when the 
Note-Off signal is received, resulting in perfectly synced playback starting precisely when the note is 
released.

F Use this option when accurate start timing is needed, because normal triggering will actually 
have a variable delay prior to playback due to the time it takes to cue the Region data or Marker 
data into the playback buffers.

Midi Rcv
The Midi Rcv button selects the MIDI receive channel that SAW32/SAWPlus32 uses to look for MIDI 



trigger. All other MIDI channel data will be ignored.

Clear
The Clear button clears the currently selected MIDI Note of all previously assigned data.

Clear All
The Clear All button clears all MIDI Notes of previously assigned data.

MT Play/Continue
The MT Play/Continue button can be used instead of the Assign button to assign a MIDI Note to play 
back from the current MultiTrack cursor position (at the time the trigger is received), rather than playing 
back a Region or Marker. 

To use this option, select a MIDI Note and click the MT Play/Continue button.

OK
Click OK to close the dialog box when MIDI Note assignments are complete. 

F The MIDI Note assignments will be saved permanently with the EDL.

Generate Smpte As Master
This option allows SAW32/SAWPlus32 to generate SMPTE Time Code, using various MIDI/Audio 
devices, and act as the master component when synchronizing other equipment or software with the 
SAW32/SAWPlus32 environment. This menu item will be grayed and unavailable if no SMPTE Generate 
device has been selected in the SMPTE Gen Protocol option of the Midi/Smpte Hardware Setup under 
the Options menu.

Selecting this option toggles SMPTE Generate mode on and off. When active, the Current Time display in
the Remote Transport window will show that SMPTE Generate is active by displaying SMPTE Gen and 
the SMPTE Format information.

All time references in the Remote Transport will switch to display SMPTE Time Code references 
(Hrs:Mins:Secs:Frmes:Sub-Frames). The Time Lines in the Full, SoundFile and MultiTrack Views will also
switch to indicate SMPTE times.

Whenever playback is initiated from the MultiTrack, SAW32/SAWPlus32 will generate SMPTE code 
starting from the MultiTrack cursor position.

Generate SMPTE mode is also active during MultiTrack recording, and the program will generate SMPTE 
code starting at the current MultiTrack cursor position.

F The SMPTE Start Offset time is added into the MultiTrack cursor position when it is translated to a 
SMPTE position. Changing the SMPTE Start Offset time will instantly change the actual SMPTE 
values generated from the same MultiTrack position, and can be used to slip the sync forward or 
backward without moving the data.

Any sequencer or other device that is set to chase SMPTE, and is connected to the SMPTE Generate 
device output, will synchronize to SAW32/SAWPlus32’s playback.

You may also generate MTC code (MIDI Time Code) by turning this option on in the Midi/Smpte Card 



Hardware Setup under the Options menu. We recommend using SMPTE, if possible, to keep the time 
code data out of the MIDI data stream.

Smpte Format/Stripe
This option allows you to set the SMPTE Format and stripe SMPTE Time Code to tape for later use in 
synchronizing sequencers and other equipment with SAW32/SAWPlus32. Selecting this option displays 
the Write Smpte To Tape window.

Set Start 
The Set Start button allows you to set the SMPTE Start Offset Time for the stripe operation. When 
clicking this button, the Enter Smpte dialog box is displayed. Set the desired time and click OK.

F This Start Offset Time affects only the stripe operation, and does not apply to the MultiTrack session.

Format 
The Format button allows you to cycle through the various SMPTE time formats. The four choices are 
30N (30 Non Drop), 30D (30 Drop), 25 or 24 frames per second.

F Using the Smpte Conform 30 to 29.97 option under the Smpte/Midi menu, in conjunction with 30N or 
30D alters those formats to 29.97.

Set Trigger 
The Set Trigger button allows you to set an incoming SMPTE trigger point which will begin the striping 
process. If this value is zero, then the process will begin as soon as you click the Start button. If a value is
entered here, SAW32/SAWPlus32 will read incoming SMPTE and wait for the trigger point to be reached 
before starting the stripe operation. 

F This option can be used to generate new SMPTE code, offset by an exact amount from an older 
existing code.

Start 
The Start button begins generating SMPTE code starting with the displayed Start Offset value. The 
display will be updated as the Time Code is generated provided that the SMPTE generate device is 
capable of feeding the Time Code back to SAW32/SAWPlus32.

Stop 
The Stop button stops Time Code generation.

OK
The OK button closes the dialog box.

MultiTrack Smpte Emulate
This option can be used whenever SMPTE references need to be visible, and is always available even 
without any SMPTE/MIDI device installed in the system.



MultiTrack Smpte Trigger
This option allows SAW32/SAWPlus32 to manually trigger to incoming SMPTE Time Code and act as a 
slave component when synchronizing other equipment or software with the SAW32/SAWPlus32 
environment. The current MultiTrack cursor position defines the SMPTE trigger point. 

This menu item will be grayed and unavailable if no Midi In-device has been selected in the Midi/Smpte 
Hardware Setup under the Options menu.

Selecting this option toggles MultiTrack SMPTE Trigger mode on and off. When active, Receive Midi 
Trigger will be deactivated (if active), and the Current Time display in the Remote Transport window will 
show that SMPTE Trigger is active by displaying SMPTE Trig and the SMPTE Format information.

All time references in the Remote Transport will switch to display SMPTE Time Code references 
(Hrs:Mins:Secs:Frmes:Sub-Frames). The Time Lines in the Full, SoundFile and MultiTrack Views will also
switch to indicate SMPTE times.

When this option is active, and MultiTrack playback is initiated by pressing the spacebar, the Waiting For 
SMPTE window is displayed.

SAW32/SAWPlus32 will cue all MultiTrack data and wait for SMPTE Trigger at the current MultiTrack 
cursor position. The trigger point is displayed in the Waiting For SMPTE At: readout. Incoming SMPTE is 
displayed in the Current SMPTE Time: readout. SAW32/SAWPlus32 will begin playback when the 
incoming SMPTE time matches the trigger point time.

You may click the Cancel button to cancel the SMPTE Trigger playback.

Clicking the right mouse button to initiate MultiTrack playback, instead of pressing the spacebar, overrides
the Trigger operation and activates normal playback. 

MultiTrack SMPTE Trigger mode is also active during MultiTrack recording, and the program will wait for 
SMPTE Trigger at the current MultiTrack cursor position when the Rec button is clicked in the Record 
Remote Transport window.

MultiTrack Smpte Chase Trigger
This option allows SAW32/SAWPlus32 to automatically chase and trigger to incoming SMPTE Time 
Code and act as a slave component when synchronizing other equipment or software with the 
SAW32/SAWPlus32 environment. The Trigger point is automatically calculated from incoming Time 
Code.

This menu item will be grayed and unavailable if no Midi In-device has been selected in the Midi/Smpte 
Hardware Setup under the Options menu.

Selecting this option toggles MultiTrack SMPTE Chase Trigger mode on and off. When active, Receive 
Midi Trigger will be deactivated (if active), and the Current Time display in the Remote Transport window 
will show that SMPTE Chase Trigger is active by displaying SMPTE Chse and the SMPTE Format 
information.

All time references in the Remote Transport will switch to display SMPTE Time Code references 
(Hrs:Mins:Secs:Frmes:Sub-Frames). The Time Lines in the Full, SoundFile and MultiTrack Views will also
switch to indicate SMPTE times.

When this option is active, SAW32/SAWPlus32 is actively looking for incoming SMPTE Time Code. 
When code arrives, the program will automatically cue forward or backward to the arriving SPMTE 



position, then add the number of SMPTE Chase Advance seconds as a pre-roll. (Set in the SMPTE 
Chase Advance option under the Smpte/Midi menu.) This pre-roll time is used for MultiTrack PreLoad and
can be set smaller or larger based on the speed of your computer and the complexity of the session.

SAW32/SAWPlus32 will wait for SMPTE Trigger at this new MultiTrack cursor position. The new Trigger 
point is displayed in the Waiting For SMPTE At: readout. Incoming SMPTE is displayed in the Current 
SMPTE Time: readout. 

You may click the Cancel button to cancel the SMPTE Chase Trigger playback.

Clicking the right mouse button to initiate MultiTrack playback, overrides the Chase Trigger operation and 
activates normal playback.

MultiTrack SMPTE Chase Trigger mode is also active during MultiTrack recording, and if incoming 
SMPTE arrives, the program will chase, cue, and wait for SMPTE Trigger at the new MultiTrack cursor 
position. SAW32/SAWPlus32 will begin recording when the incoming SMPTE time matches the Trigger 
point time.

Chase Trigger Record = SRP
When this option is selected, Chase Trigger recording will actually activate SRP recording.

Smpte Conform 30 To 29.97
This option will adjust all SMPTE mode 30 fps position calculations for 29.97 broadcast color video. Use 
this option if you are working with any type of color video synchronization in the SAW32/SAWPlus32 
environment.

Set Smpte Start Offset
This option allows you to set the SMPTE Start Offset time for the MultiTrack session. When selecting this 
option, the Enter Smpte dialog box is displayed. Set the desired time and click OK.

Smpte Chase-Advance
This option opens the SMPTE Chase-Advance window. The scroll bar allows you to adjust the number of 
seconds that the SMPTE Chase Trigger mode advances after first detecting incoming SMPTE Time 
Code. The MultiTrack will cue to the advanced SMPTE point, then preload its data and wait to Trigger. 
Slower machines or complex sessions will require a larger value.

Auto Smpte Stop Detection
When this option is selected, and playback is initiated by one of the Trigger modes SAW32/SAWPlus32 
will stop playback automatically when incoming SMPTE code stops.

Auto Smpte Format Detection
When this option is selected, the SMPTE Format will be automatically detected and changed with 
incoming SMPTE data. When this option is not active, the incoming Format data will be ignored, allowing 



you to override any automatic Format changes.



Options Menu
The Options menu allows you to setup hardware preferences and select various adjustable options within 
the SAW32/SAWPlus32 environment.

You may save these choices as program defaults by using the Save Preferences option under the File 
menu.

Audio Hardware Setup

This option displays the Audio Card Setup window which allows you to select the appropriate soundcard 
drivers for up to eight separate soundcards. (Four for SAW32.)

Wave Devices
The Audio Card Setup window first displays the wave output device selections. Start with Wave Device 1 
and select the audio card driver that matches the card that you have installed. If you have more than one 
card installed, repeat this for each card. SAW32/SAWPlus32 will not allow you to select a driver more 
than once, nor allow you to assign a wave device out of sequence.

Next, click the Out/In Device Toggle button to display the wave input device selections. Start with Wave 
Device 1 and select the audio card driver that matches the card that you have installed. If you have more 
than one card installed, repeat this for each card. If your sound card has an unmatched number of inputs 
and outputs, you should set the matching input and output pairs to the same device number, leaving 
unmatched devices set to none. 

F For example, if your sound card has four stereo analog outputs and one stereo digital output, but 
only one stereo analog input and one stereo digital input (thereby creating an unmatched set of 
inputs and outputs), set out device 1 to driver-out 1-2, out device 2 to driver-out 3-4, out device 3 to 
driver-out 5-6, and out device 4 to driver-out 7-8, and out device 5 to driver-out digital 1-2. Then set 
in device 1 to driver-in 1-2, and in device 5 to driver-in digital 1-2, leaving in device 2, 3, and 4 set to 
none.

PreLoad Buffer Queue
This setting controls how many buffers of data are preloaded to the card before playback or recording 
begins. This affects the response time of live controls such as mutes, solos, faders and pans. If this 
setting is too low for your system, audio stuttering or glitching during playback may occur, especially when
minimizing or sizing windows, etc.

Pressing the PreLoad Queue button to the right of the display window will cycle through the available 
settings from 1 to 15. Lower values will give you faster response times.

If you are using a fast Windows NT system, a setting of 1 or 2 may work well. If you have a slower 
machine running Windows 95, try using higher settings like 4 to 6.

Reset
The Reset button allows you to reset all devices at one time. If you have added or removed audio devices
in your Windows setup, then you may use this option to clear then reselect the devices for 
SAW32/SAWPlus32 if necessary.

OK and Cancel



When you are finished with all adjustments, click OK to close the dialog box and save the new settings, or
click Cancel to close the dialog box and leave settings as they were.

F Save your new settings permanently by clicking on the File menu and selecting Save Preferences.

Midi/Smpte Hardware Setup

This option displays the Midi/Smpte Card Hardware Setup window which allows you to select the 
appropriate MIDI drivers and SMPTE protocol for MIDI and SMPTE devices.

Midi Device In
This device is used as the in-port for the receive MIDI Trigger options, and for the SMPTE generate 
feedback signal with certain devices. This is not a required setting unless you plan to use those features. 
Select the desired MIDI device from the drop down list box.

Midi Device Out
This device is used as the communication link for generating SMPTE with certain devices. In some cases,
if MTC messages are turned on, they will be sent out through this device. 

Sync Device In
This device is used as the in-port for reading MTC or SMPTE Time Code. Select the desired MIDI device 
from the drop down list box. 

SAW32/SAWPlus32 can read MTC with any MIDI device, but only certain devices have the capability to 
read actual SMPTE Time Code directly. Check the documentation that came with your MIDI device to 
confirm whether or not this capability is available.

SMPTE Gen Protocol
Since there is no Windows standard for generating SMPTE through the Multimedia driver mechanism, 
you must select a SMPTE generate protocol in this window if you plan to use the generate functions, to 
instruct SAW32/SAWPlus32 how to communicate with your SMTPE device. Select the protocol from the 
drop down list box that matches your SMTPE device. 

F Because each protocol is proprietary to each device, you must use a device that supports one of the 
listed protocols. This list is constantly being updated as new devices become available.

MTC Midi Out Msgs
This option toggles the output of MTC MIDI Time Code Messages on and off. This feature is only 
available on certain MIDI devices that have the ability to generate SMPTE and output MTC at the same 
time.

I Regarding MTC Messages: MTC messages are transmitted in the MIDI data stream, and can place 
a heavy burden on MIDI data processing. Therefore, this is not the preferred method for achieving 
sync between equipment or software. If possible, use dedicated SMPTE devices.

OK and Cancel
When you are finished with all adjustments, click OK to close the dialog box and save the new settings, or
click Cancel to close the dialog box and leave settings as they were.



F Save your new settings permanently by clicking on the File menu and selecting Save Preferences.

Directory Path Setup
This option displays the Directory Path Setup window which allows you to select the default paths for 
special data files used within the SAW32/SAWPlus32 environment.

To use the Directory Path Setup window, click inside the desired path name text box, type a full path (for 
example C:\AUDIO) and click OK to accept the new path and close the window, or click Cancel to close 
the window without changing the path.

Aux Peak Data File
This option is used to set a path for the creation of peak data files when utilizing soundfiles from a read 
only device such as a CD-ROM in a SAW32/SAWPlus32 session. SAW32/SAWPlus32 normally creates 
it’s peak data information (for faster screen redraws) in the same folder as the source soundfile. If for 
some reason it cannot place the files in that folder (i.e. on a CD-ROM), it will use this path. These files will
remain there until you delete them manually.

Undo Data File
This option is used to set a path for the creation of    soundfile undo data files. These files store actual 
audio data when performing destructive editing operations, and can grow quite large. Use this option to 
point to a large drive for storing these files. 

F If this option is left blank, the undo file will be stored in the same folder as the soundfile from which 
the data comes.

Color Setup

This option opens the Color Setup dialog box which allows you to customize the color combinations of 
many areas of the program. The Color Setup window displays two palettes of color choices, the top one 
being the actual 256 color palette and the bottom being the static or system colors. Static colors have a 
more controlled and repeatable inverse algorithm and are therefore useful in the waveform and 
background areas of the program where colors are inverted for certain operations. 

The 256 color palette offers more color choices and is more fun to utilize, but inverted colors (such as a 
Marked Area in the SoundFile View) cannot be easily controlled and may change randomly due to the fact
that the palette is continually altered as programs are opened and closed in the Windows environment. 

Individual color-set files can be saved and loaded at any time, and a default set can also be saved which 
the program will use on startup.

èTo Change Colors of Selected Items:

1. Select the item you wish to adjust from the Color Item Selection drop down list.

2. Choose a color from Palette Colors or Static Colors by clicking the left mouse button on the desired 
color. The item color will update upon release of the mouse.

If choosing from the Palette Colors, drag the mouse across a color box to adjust the color shade.



èTo Change Overall Graphic Color Intensity:

1. From the Color Palette Selection drop down list, choose the desired palette.

Color Setup Dialog Box Command Buttons
Reset Item
The Reset Item button will reset the currently selected item in the Color Item Selection drop down list to 
the previously saved color.

Load
The Load button displays the Open Color Preset dialog box allowing you to load previously saved color 
preset files.

Save
The Save button displays the Save Color Preset dialog box allowing you to save the current color settings
to a color preset file.

Save Default
The Save Default button saves your current color settings as the default preset will be loaded each time 
you restart the program.

F If you create a color scheme as a default that you wish to keep, save it as a unique file name also, 
so that it can be reloaded at any time. This allows use of the Clear Default option without 
permanently losing your color scheme.

Clear Default
The Clear Default button clears the current default color preset file, so the next time the program is 
restarted, it will load the original predefined SAW32/SAWPlus32 colors.

OK
The OK button closes the Color Setup window and retains the color settings until the program is closed. 
To use the current color scheme each time the program is started, click the Save Default button before 
closing this window.

Refresh All Windows
This option allows you to refresh all windows to the SAW32/SAWPlus32 default window sizes and 
positions for the current video resolution. You can use this to instantly reset your windows after you have 
changed video resolution.

Refresh All Function Keys
This option resets all programmed function key views to the currently displayed view. You will be 
prompted to confirm this action. Your original function key settings are saved with your preferences. If you
do not re-save your preferences after refreshing the function keys, all settings will be restored when you 
next run the program.



SoundFile View Transcribe Mode
Selecting this option toggles a special transcription mode on or off. When active certain elements about 
the SoundFile View window change to facilitate the use of SAW32/SAWPlus32 as a transcription tool. 

The Time Line display is replaced with a H/S (Hide/Show) button, a time readout display, and a back-step 
time display. The SoundFile View window is now capable of becoming a topmost window allowing 
operation on top of other applications, such as a word processor. 

Playback operates slightly differently. Beginning playback is handled in any of the normal ways (including 
GamePort foot switch), but when playback stops, the finished playback position time is copied into the 
Windows clipboard (which can then be easily pasted into your word processor document), and the start 
cursor position will automatically jump forward to the finished playing position minus the number of 
seconds set in the back-step time display. This gives an automatic built-in pre-roll for the next playback.

F This mode allows for very efficient transcribing, because playback will begin just in front of where you 
left off each time you start and stop playback.

You may adjust the back-step time from zero to ten seconds by clicking on the left or right arrows in 
display. You may also jump the playback position forward or backward with the left mouse button during 
playback, just as in the Full View window, allowing you to scan and search for a specific spot in the 
material to be transcribed. You may also use the Play Mark and Play Loop features in the SoundFile View
to help with difficult sections of material. These operations differ from normal SoundFile View mode in that
the entire Marked Area will be played or looped regardless of where the starting cursor position is set.

SoundFile View Playback Tracking
Selecting this option toggles SoundFile View Playback Tracking on or off. When active, the SoundFile 
View window will update as the tracking cursor reaches the end of the display. If inactive, the original 
SoundFile View cursor position or wave form display will not be disturbed when the cursor scrolls off the 
screen during playback.

F This option will track playback only if the Zoom level is set to display data from the peak data file. If 
the display does not track when this option is active, try zooming out a level or two until the display 
refreshes.

This setting can be saved with your preferences.

MultiTrack View Playback Mixer Tracking
Selecting this option toggles MultiTrack View Playback Mixer Tracking on or off. When active, any open 
faders will track their associated mix settings with MultiTrack playback.

On slower machines, turning the option off can help performance by reducing the overhead required to 
update the screen as mix changes occur. 

This setting can be saved with your preferences.

Zoom In/Out Factor = 2
This option adjusts the scaling factor used for the Zoom In/Out functions. Normally SAW32/SAWPlus32 
automatically scales the factor based on the current zoom level and the size of the soundfile to keep 



screen redraws at an even speed as you move from one zoom level to the next, and to reduce the need 
to step through many zoom levels that are very similar in display.

This option allows you to force the scaling factor to a value of 2 which allows for many more intermediate 
levels of display than SAW32/SAWPlus32 would normally step through. This option provides the 
maximum number of zoom steps.

This setting can be saved with your preferences.

Zoom In/Out Factor = 3
This option adjusts the scaling factor used for the Zoom In/Out functions. Normally SAW32/SAWPlus32 
automatically scales the factor based on the current zoom level and the size of the soundfile to keep 
screen redraws at an even speed as you move from one zoom level to the next, and to reduce the need 
to step through many zoom levels that are very similar in display.

This option allows you to force the scaling factor to a value of 3 which allows for many more intermediate 
levels of display than SAW32/SAWPlus32 would normally step through.

This setting can be saved with your preferences.

Wave Display Scroll Factor = Slow/Fast
These options adjust the speed of the wave display scrolling when pushing or clicking the mouse at the 
edge of the SoundFile or MultiTrack views. With both unchecked, the default speed is medium. 

These settings can be saved with your preferences.

Activate GamePort Switch Trigger
Selecting this option toggles Activate GamePort Switch Trigger on or off. When active, 
SAW32/SAWPlus32 can be remotely triggered through the game port by a mechanical switch or relay. 
The Trigger will toggle play or record on and off.

F Pressing and holding the Shift key when the footswitch is triggered will toggle a Play Mark operation. 
Pressing and holding the Ctrl key when the footswitch is triggered will toggle a Play Loop operation. 

èTo Build a Remote GamePort Switch Trigger:

1. Obtain a 15 pin din plug.

2. Solder a 150K resistor between pins 1 and 3. 

3. Solder another 150K resistor between pins 1 and 6. 

4. Solder switch or relay #1 between pins 2 and 5. 

5. Solder switch or relay #2 between pins 7 and 5. 

6. Go to the Control Panel in Windows and select Joystick. Choose Custom and test your buttons.

F A standard musician's keyboard sustain pedal is a good choice for a foot switch. These are readily 
available at most music stores.

This setting can be saved with your preferences.



GamePort Switch Toggle Mode
When this option is checked, the GamePort Switch Trigger functions as a toggle switch. Pushing and 
releasing turns it on, and pushing and releasing again turns it off.

When this option is unchecked, the GamePort Switch Trigger functions as a momentary switch. Pushing 
turns it on, and releasing turns it off.

This setting can be saved with your preferences.

GamePort Switch Record = SRP
When this option is checked, and recording is triggered by the GamePort Switch, SRP recording is 
automatically engaged.

This setting can be saved with your preferences.

Auto Zero Cross Marking
Selecting this option toggles Auto Zero Cross Marking on or off. When active, zero cross detection (same 
as pressing the Z key) is automatically performed every time you mark a beginning or end boundary with 
a command button or a keyboard equivalent.

Zero cross detection finds the nearest waveform zero crossing point. The program looks for the lowest 
left/right average waveform value within a small range before and after the current cursor position. This is 
helpful in the best editpoint for creating quiet splices.

This setting can be saved with your preferences.

Auto EDL Undo
Selecting this option toggles Auto EDL Undo on or off. When active, Undo files will automatically be 
created prior to most functions that affect the MultiTrack and Region areas of the session. This is a one-
level Undo. Selecting the Undo option under the Edit menu will return the session back to the previous 
EDL state.

This setting can be saved with your preferences.

Auto SRP/Rec Link
Selecting this option toggles Auto SRP/Rec Link on or off. When active, the SRP and Rec buttons on the 
Record Remote Transport are linked together. This allows recording to start simultaneously when the 
SRP button is clicked. 

When inactive, clicking the SRP button begins MultiTrack playback only. Recording begins after clicking 
the Rec button. This mode of operation is used for punching in and out.

F In either mode, pressing the Shift key while clicking the SRP button overrides the existing mode with 
the opposite. For example, if the buttons are linked, pressing the Shift key temporarily unlinks them.

This setting can be saved with your preferences.



Auto Mute During SRP Punch-In
Selecting this option toggles Auto Mute During SRP Punch-In on or off. When active, SRP punch-in will 
cause automatic muting of any MT Entry that is being recorded over. For example, if you are recording a 
new vocal on the same track and over top of an existing vocal, the existing vocal will be heard up to the 
point of record punch-in, at which point it will be muted.

F A slight delay, dependent on the PreLoad Buffer Queue setting in the Audio Hardware Setup under 
the Options menu, will occur. Smaller settings result in shorter delays. On a fast computer running 
Windows NT, with a PreLoad Buffer Queue setting of 1 or 2, the delay should be almost unnoticeable.

F This option requires a MultiTrack re-cue operation each time you punch in or out. Re-cue operations 
on dense MultiTrack sessions can be extremely CPU intensive, and on slower computers, can result 
in a ‘Machine Not Fast Enough’ warning message, which will stop the MultiTrack.

This setting can be saved with your preferences.

Auto MT PreLoad After Break
When this option is active, a Break control entry will cause the MultiTrack to automatically preload after 
stopping and re-cueing. 

Display MT Entry Names At Top
When this option is active, the MT Entry names are displayed at the top of each entry, rather than in the 
middle. This is helpful with mono waveform displays.

This setting can be saved with your preferences.



Info Menu
Help Contents
This option displays the contents of the Help File.

Latest Release Notes
This option displays the Latest Release Notes which contain the most recent information on the newest 
features of your current version of SAW32/SAWPlus32.

About
This option displays the current Version and Registration Number of your product.



Effects Overview
SAW32/SAWPlus32 provides several effects processing options for use in your sessions. These effects 
can be patched or “plugged-in” to a track in the MultiTrack. The interface has been designed with an open
architecture that will allow easy integration of additional plug-in effects modules as they are made 
available.

Most all of the SAW32/SAWPlus32 effects may be applied in real-time, closely emulating the look and 
feel of the physical hardware they replace. Because you can change settings live during playback and 
hear the results instantly, production time can be reduced to a minimum. Without the need for the typical 
time-consuming Do/Undo process of auditioning effects, you can shave hours off your session 
construction time.

F Effects processing can be very CPU intensive, especially on slower computers. When building a 
complex session with many effects and mix operations, real-time playback may be adversely affected 
due to the tremendous processing demands on your computer’s CPU. SAW32/SAWPlus32 offers 
some nice options to help you avoid playback warnings, while building a successful production:

· Select either the Build Mix To Output File or Build Mix To New SoundFile option under the 
Process/MixDown menu to pre-process some of the effects.

(For more information on these options, see the Process/MixDown Menu section in the Using the 
Menus section.)

Plug-Ins
SAW32/SAWPlus32 comes with many built-in effects. Additional effects can be added by installing 
software Plug-Ins. Once these Plug-Ins are installed you will be able to select them and use them as 
though they were part of SAW32/SAWPlus32.

Accessing the Effects 



Accessing the Effects
Clicking the FX icon displays the Effect Patch Builder window. This window displays a list of all built-in 
and installed Plug-In effects. It allows you to patch in various combinations of processing effects for that 
particular track.

All effects are assigned to the entire track, not to individual entries on a track. To effect an MT Entry 
differently then the entries on the rest of the track, move that entry to a different track.

Most effects can be assigned to multiple tracks, each having different settings. All effects settings are 
saved with your EDL file. 

When effects are patched to a track, that track’s FX icon will display a connected bar through the center 
of the icon to indicate that effects are being used. If effects are patched, but the track is in Bypass mode, 
the connected bar will be broken in the middle to indicate that the effects are currently inactive.

Closing an EDL file clears all effects from the MultiTrack. Pressing the Ctrl key and clicking on any FX 
icon clears all FX patches from all tracks at once.

The Effects Patch Builder Window
Title Bar
The top of the Effects Patch Builder window is the title bar which can be used to reposition the window.

Effects Choices List
The Effects Choices list displays the installed effects that can be patched to the current track. Any 
additional installed Plug-In effects will display at the bottom of the list. 

Current Patch List
The Current Patch list displays the currently patched effects in the order in which they will be processed.

F Double clicking on an effect listed in the Current Patch window will display that effect’s control 
window, where you can adjust it’s settings.

Trk Indicator Readout
The Trk indicator readout displays the current Hot Track. Once the Effects Patch Builder window is open, 
switching Hot Tracks will automatically display the effects patch for the new Hot Track.

Add
The Add button adds the selected effect from the Effects Choices list into the Current Patch list. Double-
clicking on the effect in the Effects Choices list has the same result. The effect is inserted above the 
currently selected effect in the Current Patch list. 

Rem
The Rem button removes the selected effect from the Current Patch list.

Clr
The Clr button removes all effects from the Current Patch list at once.



Close
The Close button closes the Effects Patch Builder window. If any effects control windows are open, they 
will also be closed at the same time.

Bypass
The Bypass button bypasses all effects processing for this track. Use this to quickly compare the 
processed sound to the original, unprocessed sound.

Post fader
The Post Fader button forces the effects processing to take place after the volume and pan processing. 
This can result in a subtle change of the overall processed sound for certain effects.

Effects:

Vari-Pitch/Speed 

Reverse Audio 

Reverse Phase 

CenterCh Eliminator 

Graphic Equalizer 

Echo/Delay 

Comp/Gate/Limiter 



Vari-Pitch/Speed
This effect changes the pitch and speed of the audio. Vari-pitching is similar to a speed control on a tape 
recorder. If you pitch the audio up, you will also increase the playback speed. If you pitch the audio down, 
you will slow down the playback speed.

When adjusting the vari-pitch amount, the MT Entries in the MultiTrack will automatically resize to reflect 
the change. These adjustments can be made live during playback.

SAW32/SAWPlus32 performs the vari-pitch operation without removing or duplicating any samples, 
thereby producing extremely clean, glitch-free results. 

F This is a great tool for creating special effects or fine tuning the length of a radio spot.

This effect is completely non-destructive and operates in real-time.

Title Bar
The top of the window is the title bar which can be used to reposition the window. 

Pitch/Speed Readout
The Pitch/Speed readout displays the relative change (from zero) of the current setting.

Jog Slider Control
This control is used to adjust the amount of vari-pitch. The plus and minus buttons change the amount in 
single increments. The jog slider can be dragged left or right, and held, to change the amount. The farther
the slider is dragged to either side, the faster the change occurs.

Pitch
The Pitch button allows you to adjust the vari-pitch amount in reference to 1/10th of a step.

F SAW32/SAWPlus32 defines a step as one musical note of the twelve note octave.

This button is interlocked to the Time and Tempo buttons, and only one may be selected at any one time.

Time
The Time button allows you to adjust the vari-pitch amount in reference to 1/100th of a percent.

This button is interlocked to the Pitch and Tempo buttons, and only one may be selected at any one time.

Tempo
The Tempo button allows you to adjust the vari-pitch amount of the current track by referencing and 
matching the tempo of another piece of music. The two pieces should already be relatively close in tempo
for this feature to be useful.

This button is interlocked to the Pitch and Time buttons, and only one may be selected at any one time.



F SAW32/SAWPlus32 performs tempo matching by calculating the difference between two areas that 
reference the same amount of time in each piece of music, and setting the vari-pitch amount to 
compensate. The Marked Areas can be referenced from either the MultiTrack or the SoundFile View, 
whichever is the active window at the time. 

Src
The Src button is used in conjunction with the Tempo button to lock-in a tempo reference (a Marked Area)
from the source file (the file you wish to vari-pitch).

Dst
The Dst button is used in conjunction with the Tempo button to lock-in a tempo reference (a Marked Area)
from the destination file (the file you wish to match).

Clr
The Clr button is used in conjunction with the Tempo button to clear the source and destination tempos 
allowing you to set new tempo references.

Reset
The Reset button simultaneously resets the current vari-pitch amount adjustment to zero for pitch, time 
and tempo modes, clearing all previous settings.

Lock Pos
The Lock Pos button locks the start position of each MT Entry on the track when Vari-Pitch is used, 
adjusting each entry separately. If the vari-pitch setting extends the length of an entry causing it to run into
the next entry, the first will be truncated and the next entry will still start on time.

F Use this option when individual entries are synchronized to other tracks, for example, when sound 
effects are synchronized to music cues on another track. Suppose you want to lower the pitch of an 
explosion sound effect that has been synchronized to music on another track. Using Vari-Pitch 
without the Lock Pos will adjust the pitch and the position of the explosion entry, causing it to lose 
sync with the music track. Using Vari-Pitch with the Lock Pos will adjust only the pitch of the explosion
track, locking the entry to the exact same start position, therefore keeping perfect sync with the music 
track.

Close
The Close button closes the Vari-Pitch/Speed control window.

Methods for Using Vari-Pitch
èTo Adjust Vari-Pitch Using Pitch Mode in the MultiTrack:

1. Select the track to apply a pitch change to.

2. Patch in the Vari-Pitch/Speed effect and double-click the effect in the Current Patch list to open the 
Vari-Pitch/Speed control window.



3. From the control window, click the Pitch button.

4. Drag the Jogger Slider left or right, or click the plus or minus buttons to adjust the vari-pitch in 1/10th
of a step increments.

5. Initiate playback to hear changes.

èTo Adjust Vari-Pitch Using Time Mode in the MultiTrack:

1. Select the track to apply a time change to.

2. Patch in the Vari-Pitch/Speed effect and double-click the effect in the Current Patch list to open the 
Vari-Pitch/Speed control window.

3. From the control window, click the Time button.

4. Drag the Jogger Slider left or right, or click the plus or minus buttons to adjust the vari-pitch in 
1/100th of a percent time increments.

5. Initiate playback to hear changes.

èTo Adjust Vari-Pitch Using Tempo Matching in the MultiTrack:

F This operation assumes that you wish to match the tempo of two pieces of music, and have placed 
those pieces on two separate tracks of the MultiTrack. It is recommended, for ease of use, that the 
two tracks be adjacent. The piece of music you wish to vari-pitch will be referred to as the source. 
The piece of music you are matching will be referred to as the destination.

1. Expand the two tracks, turn on the waveform display, and adjust the zoom level to create a 
comfortable working view.

2. Select the destination track and create a Marked Area of exactly eight complete beats anywhere 
within the music. 

F It may be helpful to solo and play back the track to more easily find a clearly defined eight beat 
area. Use the zoom control to help trim the begin and end points to adjust the Marked Area to 
be as accurate as possible. The accuracy of the tempo match relies on the accuracy of the 
Marked Area.

3. Select the source track and patch in the Vari-Pitch/Speed effect.

4. Double-click the Vari-Pitch/Speed effect in the Current Patch list to open the control window.

5. Click the Tempo button.

6. Click the Dst button to lock-in the destination Marked Area.

7. On the source track, create a Marked Area of exactly eight complete beats. 

8. Click the Src button to lock-in the source Marked Area. The percent difference between the source 
and destination areas is automatically calculated and applied as the vari-pitch amount. Both tracks 
should now be the same tempo.

Other Effects:

Reverse Audio 

Reverse Phase 



CenterCh Eliminator 

Graphic Equalizer 

Echo/Delay 

Comp/Gate/Limiter 



Reverse Audio
This effect causes each MT Entry to be played in reverse. The entries keep their positions on the track 
but the audio in each is played backwards. If the waveforms are displayed on the track, they will be 
reversed also. 

This effect is completely non-destructive and operates in real-time.

Other Effects:

Vari-Pitch/Speed 

Reverse Phase 

CenterCh Eliminator 

Graphic Equalizer 

Echo/Delay 

Comp/Gate/Limiter 



Reverse Phase
This effect reverses the phase of the audio 180 degrees. All positive and negative values of the waveform
are swapped. Two signals that are mixed out of phase will cancel each other out rather than reinforce 
each other.

This effect is completely non-destructive and operates in real-time.

F Phase reversal can sometimes be used to control audio leakage between tracks. For example, 
suppose you have a guitar on one track and a piano on another that were recorded at the same time. 
Both tracks have unwanted drum leakage. Reversing phase on one of the tracks could possibly 
cancel the drum leakage, creating a cleaner overall mix.

Other Effects:

Vari-Pitch/Speed 

Reverse Audio 

CenterCh Eliminator 

Graphic Equalizer 

Echo/Delay 

Comp/Gate/Limiter 



CenterCh Eliminator
This effect reverses the phase of the left side of a stereo signal and mixes it with the right side creating a 
mono result, effectively canceling all center channel (common to both left and right) information.

This effect is completely non-destructive and operates in real-time.

Other Effects:

Vari-Pitch/Speed 

Reverse Audio 

Reverse Phase 

Graphic Equalizer 

Echo/Delay 

Comp/Gate/Limiter 



Graphic Equalizer
This effect offers many different ways to alter the frequency content of your audio. The Paragraphic 
Equalizer (EQ) is designed to look and feel like a typical graphic equalizer, but also gives you the 
versatility of a parametric equalizer, hence the name “Paragraphic”.

Adjusting the slider controls creates a somewhat-graphic representation of the overall shape of the 
resulting EQ curve (like a typical graphic equalizer). Also, each of the seven bands has adjustments for 
center-frequency and bandwidth (like a typical parametric equalizer). There are also adjustable Hi-Cut 
and Lo-Cut filters and a control to trim the output volume. 

This effect is completely non-destructive and operates in real-time. Because this effect requires a lot of 
calculations which places a heavy demand on the CPU, the number of bands that can process live 
depends completely upon the speed of your computer.

F Examples of machine performance: a typical 486/66 running Windows NT might average 2-4 bands 
live; a Pentium 166 might average 18-22 bands; a Pentium 200 might average 30-40 bands; a 
Pentium Pro200 might average 50-60 bands; a P2/266 might average 80-100 bands!

Title Bar
The title bar area, labeled Paragraphic Equalizer, can be used to reposition the window.

Slider Controls
The Slider Controls adjust the amount of boost or cut at the associated center frequency. The db 
representation is displayed above each control. 

Drag a slider with the left mouse button to adjust the EQ. Clicking the right mouse button at the same time
will reset any control back to zero db.

Freq
The Freq controls adjust the center frequency for each of the seven frequency bands. The frequency 
range overlaps the adjacent bands to allow plenty of versatility in setting frequency combinations.

Each frequency band is a bandpass filter that affects only the audio frequencies that are near the center 
frequency setting and lie within the bandwidth range evenly balanced on either side.

Click and hold the left mouse button inside this window and move the mouse forward or backward to 
change the frequency setting. Clicking with the right mouse button will turn the individual band on or off.

Width
The Width controls adjust the bandwidth of the frequency range affected by the filter. A smaller bandwidth 
has a sharper sound and can be used to zero in tight on a specific frequency. A larger bandwidth has a 
smoother sound and can be used to affect a wider range of frequencies with one control.

Click and hold the left mouse button inside this window and move the mouse forward or backward to 
change the frequency setting. Clicking with the right mouse button will turn the individual band on or off.



Hi-Cut Filter
The Hi-Cut filter control is a shelving filter that will attenuate high frequencies above the cutoff frequency 
setting. The rate of attenuation is 18 db per octave.

Click and hold the left mouse button inside this window and move the mouse forward or backward to 
change the frequency setting. Clicking with the right mouse button will turn the individual band on or off.

Lo-Cut Filter
The Lo-Cut filter control is a shelving filter that will attenuate low frequencies below the cutoff frequency 
setting. The rate of attenuation is 18 db per octave.

Click and hold the left mouse button inside this window and move the mouse forward or backward to 
change the frequency setting. Clicking with the right mouse button will turn the individual band on or off.

Vol Trim
The Vol Trim control can be used to trim the overall volume to eliminate clipping that may occur when 
boosting or cutting frequency bands in a loud section of audio.

Drag the Vol Trim slider with the left mouse button to trim the volume. When this control is at the top, no 
volume processing occurs.

Reset
The Reset button resets all EQ frequency bands to the center, flat position, and turns off the Hi-Cut and 
Lo-Cut filters. This button does not change the frequency or bandwidth settings.

Load 
The Load button loads a previously saved preset file containing all adjustable settings for a specific EQ 
setup. Clicking this button opens the file dialog box. Select the folder and file name of the preset file you 
wish to load and all settings will be set accordingly. Equalizer preset files use the .EQ extension.

Save
The Save button saves a preset file containing all adjustable settings for the current EQ setup. Clicking 
this button opens the file dialog box. Select the folder and enter a file name for the preset file you wish to 
save and all settings will be saved to the preset file. Equalizer preset files use the .EQ extension.

About 
The About button displays the About information window including current version information. 

This window allows you to save preferences for the EQ module which includes the load and save file 
paths and the current EQ window position.

Close
The Close button closes the EQ window. Any settings that were made remain in effect.



Other Effects:

Vari-Pitch/Speed 

Reverse Audio 

Reverse Phase 

CenterCh Eliminator 

Echo/Delay 

Comp/Gate/Limiter 



Echo/Delay
This effect creates a variety of digital delay and repeating echo effects. Individual left and right controls 
are available for the Delay Time, Feedback and Strength of the delayed signals. There is absolutely no 
noise and no degradation of the audio signal on repeating echoes.

This effect is completely non-destructive and operates in real-time. 

Title Bar
The title bar area, labeled Echo Effects Generator, can be used to reposition the window.

Left/Right Delay Time
The Delay Time setting determines the amount of time between echo repeats.

Clicking and holding the left mouse button in the Delay Time readout area and moving the mouse forward 
or backward will change the delay time by 2 millisecond (ms) increments. Holding the Shift key at the 
same time will change the Delay Time by 10 ms increments. Holding the Ctrl key at the same time will 
change the Delay Time by 100 ms increments. 

A special link to the SoundFile View provides a unique and powerful feature to assist in setting precise 
delay times. Double-clicking an MT Entry from the current track into the SoundFile View provides the 
opportunity for a visual display of the current Delay Time setting referenced against the audio waveform. 
When adjusting the Delay Time setting, a red vertical cursor will appear on top of the waveform indicating 
the exact Delay Time distance from the SoundFile View cursor.

F Use this feature to set echo repeats precisely in rhythm with a piece of music by placing the 
SoundFile View cursor on a downbeat or upbeat, and adjusting the delay time to align the red cursor 
to the next beat, or halfway to the next beat.

Left/Right Feedback
The Feedback setting determines how much of the echo signal is fed back to the input. This creates 
repeating echoes, spaced at the Delay Time interval, each one at a slightly lower volume than the 
previous, eventually fading away to nothing. Using 0% Feedback creates a single echo of the original 
sound, acting as a simple delay effect.

Clicking and holding the left mouse button in the Feedback readout area and moving the mouse forward 
or backward will change the feedback amount by 5% increments.

Left/Right Strength
The Strength setting controls the loudness of the main echo relative to the original audio volume. It will 
also affect how many repeats are heard at a particular Feedback setting.

Vol Trim
The Vol Trim control can be used to trim the overall volume of the audio waveform eliminating clipping 
with dense echo settings.



Mode
The Mode setting switches between Normal and Cross delay. Clicking and holding the left mouse button 
in the Mode readout area and moving the mouse forward or backward will change the setting.

Normal delay mode keeps the Left and Right echoes in place on their respective channels.

Cross delay mode crosses the Left channel echo over to the Right channel and the Right channel echo 
over to the Left channel. With a high percentage of feedback, you can create a ping-ponging effect of 
echoes bouncing back and forth between channels. With 0% feedback and a delay time of 20 to 40 ms, 
you can create the effect known as Cross Delay Stereo, which can give the illusion of a wider overall 
stereo image from a mono signal source.

F Creating a Cross Delay Stereo effect requires the use of the Post Fader button in the Patch Builder 
window. The source track must be panned to one side or the other, and the Delay Time should be set 
between 20-40 ms. Set the Strength for that channel to the maximum setting and select Cross delay 
mode. This should result in the mono signal being spread across the left/right stereo image. The width
of the spread can be controlled by the delay setting.

Load 
The Load button loads a previously saved preset file containing all adjustable settings for a specific 
Echo/Delay setup. Clicking this button opens the file dialog box. Select the folder and file name of the 
preset file you wish to load and all settings will be set accordingly. Echo/Delay preset files use the .EKO 
extension.

Save
The Save button saves a preset file containing all adjustable settings for the current Echo/Delay setup. 
Clicking this button opens the file dialog box. Select the folder and enter a file name for the preset file you 
wish to save and all settings will be saved to the preset file. Echo/Delay preset files use the .EKO 
extension.

About 
The About button displays the About information window including current version information. 

This window allows you to save preferences for the Echo/Delay module which includes the load and save 
file paths and the current Echo/Delay window position.

Close
The Close button closes the Echo/Delay window. Any settings that were made remain in effect.

Other Effects:

Vari-Pitch/Speed 

Reverse Audio 



Reverse Phase 

CenterCh Eliminator 

Graphic Equalizer 

Comp/Gate/Limiter 



Comp/Gate/Limiter
This effect performs four volume dynamics processing functions. These functions are performed with 
much finer precision than most external analog compressor/limiters can provide.

A unique and powerful visual approach to threshold adjustments allows you to reference the various 
Threshold adjustments directly against the SoundFile View waveform display, providing accuracy never 
before achievable with currently existing audio equipment.

Title Bar
The title bar area, labeled Gate/Compressor Limiter, can be used to reposition the window.

Gate
The Noise Gate is used to help eliminate unwanted background noise during low volume areas of your 
soundfile. The Gate starts with the volume off and opens the volume to full when the audio signal rises 
above the Threshold setting. When the signal level falls below the Threshold setting again, the Gate turns
the volume back down.

By experimenting with different combinations of control settings, you can effectively clean up otherwise 
noisy soundfiles.

Attack
The Attack setting adjusts how quickly the volume is ramped up once the signal level rises above the 
Threshold setting. Speeds range from instantaneous to a very slow fade up.

Release
The Release setting adjusts how quickly the volume is ramped down once the signal level falls below the 
Threshold setting again. Speeds range from instantaneous to a very slow fade down. 

F By using a slower Release time, the Gate will operate smoother as the signal momentarily fluctuates 
above and below the Threshold.

Threshold
The Threshold setting determines the signal level which triggers the Gate into action. 

A special link to the SoundFile View provides a unique and powerful feature to assist in adjusting the 
Threshold settings. Double-clicking an MT Entry from the current track into the SoundFile View provides 
the opportunity for a visual display of the current Threshold setting referenced against the audio 
waveform. When adjusting the Threshold setting, a pair of horizontal lines for each channel will appear 
superimposed on the audio waveform in the SoundFile View window.

F You may zoom and magnify the display to reference the Threshold setting directly against the 
unwanted noise in the waveform data.

On
The On button turns the Gate on and off. When the Gate is off, it adds no processing time to the 
Compressor/Limiter functions. 



Compressor
The Compressor is used to help squeeze high volume areas of your soundfile to a lower volume. The 
Compressor starts with the volume at full and lowers the volume down when the audio signal rises above 
the Threshold setting.

Attack
The Attack setting adjusts how quickly the Compressor springs into action, and begins the volume 
squeeze once the signal level rises above the Threshold setting.

F Using a fast Attack setting can effectively compress the attack transient and the sustain of a musical 
instrument, whereas a slow Attack setting lets the attack transient through at full volume compressing 
only the sustain portion of the signal. Experimenting with the Attack setting allows you to drastically 
alter the dynamic quality of different types of audio signals.

Release
The Release setting adjusts how quickly the Compressor releases it’s effect on the signal, and begins 
ramping the volume back up once the signal level falls below the Threshold setting again.

F Experimenting with the Release setting can help smooth out the overall Compression effect, but for 
most signals should probably be set in the center position.

Threshold
The Threshold setting determines the signal level which triggers the Compressor into action. The actual 
Threshold setting you choose will depend on whether you are attempting to create a noticeable change in
the sound or keep the effect as transparent as possible. The lower the Threshold, and therefore the 
deeper into the bulk of the audio, the more audibly noticeable the compressing effect will be.

A special link to the SoundFile View provides a unique and powerful feature to assist in adjusting the 
Threshold setting. Double-clicking an MT Entry from the current track into the SoundFile View provides 
the opportunity for a visual display of the current Threshold setting referenced against the audio 
waveform. When adjusting the Threshold setting, a pair of horizontal lines for each channel will appear 
superimposed on the audio waveform in the SoundFile View window.

F You may zoom and magnify the display to reference the Threshold setting directly against the 
unwanted noise in the waveform data.

Ratio
The Ratio setting determines how much the Compressor squeezes (thereby lowering the volume) the 
audio once it kicks into action. The higher the Ratio the lower the volume is dropped.

F The interaction of the Compressor controls allow you to alter the dynamics of your audio file 
drastically. By adjusting the Threshold down into the bulk of the audio material and using a large Ratio
setting, you can effectively squash sharp transient sounds and balance out the overall volume level of
the entire signal, or create unnatural audio effects by adjusting the settings to extremes.

By using a small Ratio setting, the effects of the compression will be more subtle, effectively 
smoothing out only the rough edges of the signal.

On
The On button turns the Compressor on or off. When the Compressor is off, it adds no additional 



processing time to the Compressor/Limiter functions. 

Peak Limiter
The Peak Limiter is used to limit large transient spikes to a specified volume. SAW32/SAWPlus32 can 
perform this process absolutely transparently, effectively removing large transient spikes without audibly 
affecting the overall sound of the waveform! Most hardware peak limiters can only chop the transient at 
the specified volume level, introducing many noticeable audible side effects. Using a unique design 
concept, SAW32/SAWPlus32 actually scales the volume level of each half cycle (positive and negative) 
of the waveform independently, from zero cross to zero cross, resulting in an instantaneous blending of 
the transient into the rest of the signal, with no noticeable thumping or pumping side effects.

Peak Limit
The Peak Limit setting adjusts the ceiling threshold, which triggers the Peak Limiter into action, thus 
creating the maximum audio level that any transient in the file can attain. If the setting is left at the 
extreme top of the control, the Peak Limiter is turned off and adds no processing time to the 
Compressor/Limiter functions.

A special link to the SoundFile View provides a unique and powerful feature to assist in adjusting the 
Peak Limit setting. Double-clicking an MT Entry from the current track into the SoundFile View provides 
the opportunity for a visual display of the current Peak Limit setting referenced against the audio 
waveform. When adjusting the Peak Limit setting, a pair of horizontal lines for each channel will appear 
superimposed on the audio waveform in the SoundFile View window.

F When adjusting this setting, attempt only to clip the peaks that stick out well above the bulk of the 
audio material. If you place the setting down into the bulk of the audio you can introduce varying 
amounts of audible distortion.

F Peak Limiting requires a complete pre-scan of the data first, and then a second pass to perform the 
process, therefore this effect cannot be processed live during MultiTrack playback. Use this function 
by processing the data back into the original soundfile, or by using one of the Build Mix options to 
process the effect to a new soundfile.

Normalizer
The Normalizer automatically calculates and determines the exact amount of volume adjustment (up or 
down) needed for the soundfile to attain a certain percentage of clipping. 

Clicking and holding the left mouse button in the Normalize readout area and moving the mouse forward 
or backward will activate and adjust the Normalize percentage in 1% increments. Pressing the Shift key at
the same time will change the percentage in 5% increments. Clicking the right mouse button in the 
Normalize readout area will turn the Normalize on or off, retaining the current setting.

F Normalizing requires a complete pre-scan of the data first, and then a second pass to perform the 
process, therefore this effect cannot be processed live during MultiTrack playback. Use this function 
by processing the data back into the original soundfile, or by using one of the Build Mix options to 
process the effect to a new soundfile.

Average/Peak
There are two Normalizing modes available, Peak and Average.

Clicking and holding the left mouse button in the mode readout area and moving the mouse forward or 



backward will switch between Peak and Average modes.

Peak mode applies a different scaling factor to each channel, placing the loudest peaks at the new margin
setting. This mode will set both channels to approximately equal levels, thereby canceling large volume 
discrepancies between left and right. 

Average mode averages all the peaks on each channel, combines the left and right results into another 
average, then applies the same scaling factor to both channels. If the scaling factor applied will cause 
clipping, the factor is adjusted so that the loudest peak is placed at 95%. This mode tries to place the bulk
of the audio material into an average relative margin position. Some peaks will still rise above this margin.
This mode preserves relative volume differences between the left and right channels.

F Combining the use of the Peak Limiter and the Normalizer is an incredibly effective way to maximize 
the overall volume level of your final mixdowns. For example, in order to master a CD at the 
maximum level, apply the Peak Limiter to limit transient peaks to a level just above the bulk of the 
audio material, and add the Normalize function in Peak mode at a setting of around 98%. This should 
maximize the final output level with no audible side effects.

Out Vol
The Out Vol control can be used to adjust the overall volume of the Compressor/Limiter output. You may 
use this to increase the overall average sound level of your waveform by compressing or limiting the 
peaks, and at the same time raising the overall gain of the entire output. 

Dragging the Out Vol control with the left mouse button and pressing the right mouse button at the same 
time will reset the control back to zero db.

This control and the Normalize setting are connected together. Only one can be active at a time, and 
adjusting either one resets the other.

Load 
The Load button loads a previously saved preset file containing all adjustable settings for a specific 
Compressor/Limiter setup. Clicking this button opens the file dialog box. Select the folder and file name of
the preset file you wish to load and all settings will be set accordingly. Compressor/Limiter preset files use
the .CL extension.

Save
The Save button saves a preset file containing all adjustable settings for the current Compressor/Limiter 
setup. Clicking this button opens the file dialog box. Select the folder and enter a file name for the preset 
file you wish to save and all settings will be saved to the preset file. Compressor/Limiter preset files use 
the .CL extension.

About 
The About button displays the About information window including current version information. 

This window allows you to save preferences for the Compressor/Limiter module which includes the load 
and save file paths and the current Compressor/Limiter window position.



Close
The Close button closes the Compressor/Limiter window. Any settings that were made remain in effect.

Other Effects:

Vari-Pitch/Speed 

Reverse Audio 

Reverse Phase 

CenterCh Eliminator 

Graphic Equalizer 

Echo/Delay 



Working with SMPTE
This section is a light-hearted attempt at shedding some light on the overly complex and confusing world 
of SMPTE synchronization as it applies to SAW32/SAWPlus32. It explains in depth, the different 
considerations that need to be addressed when attempting to link MIDI Sequencers and audio/video 
decks to the SAW32/SAWPlus32 environment through the use of SMPTE time code. This section 
uncovers the many complications surrounding successful SMPTE operation, and is mainly intended as an
educational guide to the many variables involved, and the possible solutions to the problems. Realize that
many thousands of registered users are happily and successfully synchronizing their SAW32/SAWPlus32
environments to a vast variety of other equipment.

What Is SMPTE? 

MIDI Sequencers and the SAW Environment 

Audio Tape Decks and the SAW Environment 

Video Tape Decks and the SAW Environment 

SMPTE Summary 



What Is SMPTE?
For the purpose of this discussion, SMPTE will simply be defined as an electronic reference to time that 
can be recorded on audio/video decks and transmitted between different pieces of equipment allowing 
them to keep in sync with each other. 

The SMPTE code is displayed as follows: 00:00:00:00 (Hours: Mins: Secs: Frames). There are many 
sources of detailed technical descriptions of the actual SMPTE standard, and this section will not attempt 
to reiterate them. One of the most important things to note about SMPTE, as it applies to the 
SAW32/SAWPlus32 environment, is the different formats that are commonly used by the different 
industries. There are generally four format types that we will concern ourselves with: 30 Non-Drop, 30 
Drop, 25, and 24 frames per second.

· 30 Non-Drop is often used by the music production industry, usually in conjunction with MIDI 
sequencers.

· 30 Drop is often used by the video production industry in the United States.

· 25 is often used by the video production industry outside the United States.

· 24 is often used by the film production industry.

The concept starts out simple, but hang on to your hat because Complicitis (a human condition that 
presumes that the shortest distance between two points is around the world 10 times) sets in real fast 
from here. Twenty four and Twenty Five frames per second are fairly straightforward. Time is broken 
down into 24 or 25 fractions of a second. Each fraction is called a Frame and therefore defines the 
smallest segment of time that can be referenced. Thirty Non-Drop works similarly with a Frame being 
equal to 1/30 of a second. Now the confusion sets in.

Thirty Drop was created for use by the video industry in the United States because of a specific technical 
dilemma that resulted when color video was introduced. Each frame of color video required an extra 
signal for the color burst information that was encoded in between video frames. This caused a tiny 
amount of extra time to occur during playback between each frame of color video and as a result, the 
actual number of video frames no longer matched the actual running time of the full video production. In 
truth, the frame count actually lagged    behind, loosing approximately 1.8 frames per minute. Drop Frame 
was    created (although many would argue that it never should have been) and the Pandora's Box was 
opened. Drop Frame encoding is at best, a weak attempt at solving the color video timing problem. At 
every Minute Boundary, two frames are dropped from the SMPTE value, helping to keep the actual 
SMPTE time reference in line with the actual video frame count. Since we are dealing with a fractional 
timing loss however, more adjustment was necessary. To compensate for the remainder of the timing 
inaccuracy, at every Ten Minute Boundary, the SMPTE Time is not adjusted at all. Now lets look at what 
this means in terms of actual SMPTE code values. As we cross the first Minute Boundary, the SMPTE 
values actually look like this; 00:00:59:28… 00:00:59:29… 00:01:00:02… 00:01:00:03…etc. Notice the 
two frames that are skipped at the crossing. Each minute up to the Ten Minute Boundaries follows the 
same pattern. As we cross a Ten Minute Boundary, the SMPTE values actually look like this; 
00:09:59:28… 00:09:59:29… 00:10:00:00… 00:10:00:01…etc. Notice that no frames are skipped.

As you may begin to see, hardware and software handling of SMPTE in this format has been complicated
considerably. But realize, once Complicitis sets in, it can spread quickly. Sometime after that, the 
conclusion was drawn and (surprisingly) widely accepted that instead of doing all this complicated 
manipulating of numbers, a similarly accurate result could be created by simply slowing down the actual 
SMPTE stripe by a correction factor of .999%. Thus was born the 29.97 SMPTE format. The SMPTE 
running time now matched the video frame count.



Are you still with us? What exactly is this 29.97 SMPTE format? It is usually 30 Non-Drop running slow. 
But believe it or not, it is also, in many cases, 30 Drop running slow, which is actually a double application
of the correction factor resulting in the same error in the opposite direction that Drop Frame attempted to 
correct originally.

Many of the MIDI devices on the PC platform cannot detect 29.97 timing at a hardware level, and will 
actually read it as 30, therefore making it much more complex for software applications to handle it 
properly.

Lets feed the Complicitis a bit and spice up the situation with the addition of digital audio. Digital audio 
creates sound by sampling the continuous analog audio signal at precise timing increments called the 
Sampling Rate. Some of the most common rates used are 32000, 44100 and 48000. Recording audio 
signals with a digital connection (rather than analog connection) complicates matters because the 
soundcards will lock to the source digital clock and not use their internal clock during the recording 
process. The problems arise when the source deck is a video deck locked to a House Sync master 
generator running at 29.97. A Sampling Rate of 44100 will actually be internally pulled down .999% by the
deck to 44056. The soundcard will happily record at this rate, but during playback, will use its internal 
clock and playback at the 44100 rate. The result is a serious corruption of synchronization.

We have now been introduced to some of the SMPTE complexities at the ground floor. Many more 
variables come into the picture as we begin interfacing to different types of equipment. Since each 
situation has unique parameters, let's take a look at each one individually.



MIDI Sequencers and the SAW Environment
This is actually the easiest of combinations. In this configuration, the SAW32/SAWPlus32 environment is 
usually setup as the master, generating the SMPTE code for the sequencer to chase as the slave. The 
generate SMPTE capability is MIDI card dependent. SAW32/SAWPlus32 can currently generate SMPTE 
with a variety of MIDI devices, however there are other factors involved in this equation that can 
complicate matters somewhat.

The Windows MultiMedia specification has no real direct provision for generating SMPTE through the 
Windows driver mechanism. Many of the newer MIDI products provide a method of accessing the SMPTE
generator using their own programming protocol, and many of these protocols have been added to the 
SAW32/SAWPlus32 environment. New products will continue to be added to the list as the required code
for each device is written and tested.

Another option, instead of hardware SMPTE generation, is to output MTC (MIDI Time Code) code directly 
from software through the MIDI port. This method, however, is overwhelmed with timing problems in the 
Windows environment and it is very difficult, if not impossible, to generate evenly spaced Quarter Frame 
MTC messages that can be used to drive a MIDI sequencer smoothly without stuttering. 
SAW32/SAWPlus32 makes no attempt at this method, as after much research into the matter, the 
conclusion was made that this is currently not a good solution within the Windows Operating System.

So, the final outcome of all this confusion, boils down to using one of two recommended procedures for 
having SAW32/SAWPlus32 act as a SMPTE Master:

1) Generating SMPTE Within One of the Supported Devices
Using one of the supported MIDI/SMPTE devices, have SAW32/SAWPlus32 generate SMPTE within the 
device itself and have the sequencer program take its sync input from the same device. Most of the newer
supported devices can internally feed the generated SMPTE back into a MIDI port as MTC code, which 
the sequencer can read and chase to. To do so, the device drivers must be capable of MultiClient 
operation, meaning that more than one program can access the device at the same time. Such devices 
allow both SAW32/SAWPlus32 and the MIDI sequencer program to open the driver at the same time, 
giving SAW32/SAWPlus32 the ability to control the SMPTE Generator while the sequencer program 
waits and looks for sync input.

One remaining concern with this method is the fact that the sequencer is actually chasing the SMPTE 
Generator signal from the MIDI device, not the soundcard. If the soundcard oscillator circuitry and the 
MIDI device generator circuitry are not precisely accurate and are running at slightly different speeds, 
then the sequencer and the digital audio playback can drift apart. In most cases, any subtle differences in 
timing between the devices is irrelevant when dealing with project lengths of 4-5 minutes, and in general 
this method works well even on projects of substantial length, such as 30-60 minutes.

Many of the newer multi-channel output audio cards now also include MIDI and SMPTE capabilities and 
these offer the best solution. Generating SMPTE from such a card will usually guarantee perfect sync 
because both the generator and the audio output reference the same oscillator.

2) Striping SMPTE on a Track in the MultiTrack
Using one of the multi-channel output audio cards, (with or without SMPTE capabilities), record a SMPTE 
stripe from a separate SMPTE generator source to a MultiTrack track and assign that track to one of the 
card's last outputs (for example, output 4). Now as you play the audio tracks in the MultiTrack, the SMPTE
stripe is also played and remains in perfect sync. Have your sequencer read the SMPTE through your 
MIDI device and you are in business.



Choice of SMPTE Format
When working with MIDI sequencers, it is recommended that the SMPTE Format be set to 30 NonDrop to
maximize the resolution of the timing signal.

Operation
Operation when SAW32/SAWPlus32 is the master, is simple and straightforward. Select the Generate 
Smpte As Master option under the Smpte/Midi menu. Playing back from the MultiTrack will automatically 
begin SMPTE generation from your MIDI/SMPTE device at the current MultiTrack cursor position, or if 
you are using a SMPTE stripe on one of the tracks, SMPTE will be output from that track. SMPTE will not 
be generated, in either case, during Soundfile View playback.

Recording will also generate SMPTE, starting from the MultiTrack cursor position when the SRP or REC 
button is clicked on the Record Remote Transport. If you are using the striped method on one of the 
MultiTrack tracks, you must use the SRP option to output the SMPTE stripe while recording.



Audio Tape Decks and the SAW Environment
This combination has many parameters to consider and can get a bit complex. In this configuration, the 
SAW32/SAWPlus32 environment is usually setup as the slave, triggering to SMPTE Time Code which is 
striped on one track of the tape deck, which acts as the master. There are many factors involved here in 
order for accurate sync to happen. SAW32/SAWPlus32 can manually trigger, or chase and trigger to the 
incoming SMPTE, but once playback has accurately started, the computer and the tape deck are running 
wild. In order for sync to be maintained, the tape transport must be very accurate and not wow and flutter 
during the playback process. Most newer Digital decks, like ADATs and DA-88s, can maintain this level of 
accuracy, and with one of these decks, SAW32/SAWPlus32 can happily pass data back and forth 
between the tape system and the computer in perfect sync, or be used as an add-on to increase the 
number of live tracks in the system.

Analog tape decks, however, can pose a problem. Most analog tape decks have a high degree of wow 
and flutter and very rarely playback the exact same way twice. Therefore moving audio between the tape 
and computer in multiple passes will cause individual tracks to be randomly out of sync with each other. 
The best way to integrate analog tape decks with the SAW32/SAWPlus32 environment, is to have the 
analog tape deck act as the slave, if possible, and have it chase and lock to SAW32/SAWPlus32 acting 
as the master. Many analog decks are capable of motor drive control using a specialized synchronizer 
device which can chase SMPTE and constantly vary the motor speed of the transport. This is the only 
recommended method of integrating analog decks with the SAW32/SAWPlus32 environment. ADATs and
DA-88s can also be used as the slave in this configuration with the proper sync devices.

Another option is to use one of the newer soundcards which are capable of external Word Clock sync. 
Many newer audio decks are capable of generating a Word Clock sync signal directly, or there are 
devices available that will generate Word Clock sync directly from a SMPTE stripe. If the soundcard is set
to reference external Word Clock for its oscillator signal, after the initial SMPTE trigger, the soundcard 
output will actually chase and lock at a hardware level (no need to worry about drift) because the actual 
oscillator reference is coming from the generated Word Clock sync.

Choice of SMPTE Format
When working with Audio Tape Decks, it is recommended that the SMPTE Format be set to 30 NonDrop 
to maximize the resolution of the timing signal.

Operation
Operation when SAW32/SAWPlus32 is the slave, can be handled in one of two ways, manual trigger or 
chase trigger.

Manual trigger allows you to select the trigger point manually by placing the MultiTrack cursor at the 
desired trigger location. Select the MultiTrack Smpte Trigger option under the Smpte/Midi menu. Press 
the spacebar to initiate SMPTE trigger playback. SAW32/SAWPlus32 will pre-load the MultiTrack and 
wait for SMPTE at the trigger location. Rewind your audio deck to a location in front of the trigger point 
and start the audio deck playback. SAW32/SAWPlus32 will read the incoming SMPTE and start playback
in sync when the SMPTE matches the trigger location.

Chase trigger allows you to leave SAW32/SAWPlus32 unattended and control the operation completely 
from your audio deck. Select the MultiTrack Smpte Chase Trigger option under the Smpte/Midi menu. 
Rewind your audio deck to the desired location and start the audio deck playback. In this mode, 
SAW32/SAWPlus32 is actively looking for incoming SMPTE and when code arrives, the program will 
automatically cue forward or backward to the arriving SPMTE position, then add the number of SMPTE 
Chase Advance seconds as a pre-roll (set in the SMPTE Chase Advance option under the Smpte/Midi 
menu). This pre-roll time is used for MultiTrack PreLoad and can be set smaller or larger based on the 



speed of your computer and the complexity of the session. SAW32/SAWPlus32 will wait for SMPTE 
trigger at this new MultiTrack cursor position. The new trigger point is displayed in the Waiting For SMPTE
At: readout. Incoming SMPTE is displayed in the Current SMPTE Time: readout. 

Operation when SAW32/SAWPlus32 is the master, is simple and straightforward. Select the Generate 
Smpte As Master option under the Smpte/Midi menu. Playing back from the MultiTrack will automatically 
begin SMPTE generation from your MIDI/SMPTE device at the current MultiTrack cursor position, or if 
you are using a SMPTE stripe on one of the tracks, SMPTE will be output from that track. SMPTE will not 
be generated, in either case, during Soundfile View playback.

Recording will also generate SMPTE, starting from the MultiTrack cursor position when the SRP or REC 
button is clicked on the Record Remote Transport. If you are using the striped method on one of the 
MultiTrack tracks, you must use the SRP option to output the SMPTE stripe while recording.



Video Tape Decks and the SAW Environment
This combination can drive many people to drink. There are many parameters and variations of 
parameters that can truly test any man's ability to stay sane. In this configuration, the 
SAW32/SAWPlus32 environment is usually setup as the slave, triggering to SMPTE Time Code which is 
striped on one track of the video deck, which acts as the master. There are many factors involved here in 
order for accurate sync to happen. SAW32/SAWPlus32 can manually trigger, or chase and trigger to the 
incoming SMPTE, but once playback has accurately started, the computer and the video deck are running
wild. In order for sync to be maintained, the tape transport must be very accurate and not wow and flutter 
during the playback process. Most video deck transports can maintain this level of accuracy, and 
SAW32/SAWPlus32 can happily pass data back and forth between the tape system and the computer in 
perfect sync, for long periods of production time.

For more precise synchronization, especially when working on long projects, use one of the newer 
soundcards which are capable of external Word Clock sync. Many video decks are capable of generating 
a Word Clock sync signal directly, or there are devices available that will generate Word Clock sync 
directly from a SMPTE stripe. If the soundcard is set to reference external Word Clock for its oscillator 
signal, after the initial SMPTE trigger, the soundcard output will actually chase and lock at a hardware 
level (no need to worry about drift) because the actual oscillator reference is coming from the generated 
Word Clock sync.

When working with the PAL video standard, things remain fairly straightforward from here. The NTSC 
video standard, however, can complicate matters very rapidly. The problems arise from the use of the 
29.97 SMPTE timing used with all NTSC color video. Most video production houses run a master clock 
signal, called House Sync, to all video and audio equipment in the control room. This master clock 
generates a 29.97 SMPTE code signal, a Word Clock sync signal, and a video burst signal that all pieces 
of equipment reference in order to stay in perfect phase accurate sync. The SMPTE stripe placed on the 
video tape copy you will most likely work with, will have come from this master clock. The actual SMPTE 
Format encoded within the stripe, will be either 30 NonDrop or 30 Drop (even though it is really at 29.97), 
depending on the production house you are involved with, and in some cases will even vary from project 
to project within the same house. It is imperative that you properly match the format and set the 
SAW32/SAWPlus32 environment to conform the 30 to 29.97 so all trigger and position calculations will 
be accurate.

Transferring all audio information using analog soundcard inputs and outputs can eliminate any further 
complications. Transferring audio using digital inputs and outputs throws a few more elements into the 
fire. When recording digitally, the soundcards will lock to the source digital clock and not use their internal 
clock. A Sampling Rate of 44100 will actually be internally pulled down .999% by the deck to 44056. The 
soundcard will happily record at this rate, but during playback, will use its internal clock and playback at 
the 44100 rate. This will obviously compromise the sync, and also make it impossible to work within the 
SAW32/SAWPlus32 environment. The solution here is to use one of the newer soundcards, capable of    
playback at the 44056 rate. In fact, the soundcard should be capable of all the video pulldown and pullup 
rates (44056, 44144, 47952 and 48048). These soundcards will usually also be capable of external Word 
Clock sync, making them the best choice for working with video projects.

Choice of SMPTE Format
When working with the PAL video standard, the SMPTE Format should be set to 25. When working with 
the NTSC video standard, the SMPTE Format should be set to 30 NonDrop or 30 Drop to match the 
individual project. In all NTSC cases, the Smpte Conform 30 to 29.97 option should be turned On under 
the Smpte/Midi menu.

Operation



Operation when SAW32/SAWPlus32 is the slave, can be handled in one of two ways, manual trigger or 
chase trigger.

Manual trigger allows you to select the trigger point manually by placing the MultiTrack cursor at the 
desired trigger location. Select the MultiTrack Smpte Trigger option under the Smpte/Midi menu. Press 
the spacebar to initiate SMPTE trigger playback. SAW32/SAWPlus32 will pre-load the MultiTrack and 
wait for SMPTE at the trigger location. Rewind your video deck to a location in front of the trigger point 
and start the video deck playback. SAW32/SAWPlus32 will read the incoming SMPTE and start playback
in sync when the SMPTE matches the trigger location.

Chase trigger allows you to leave SAW32/SAWPlus32 unattended and control the operation completely 
from your video deck. Select the MultiTrack Smpte Chase Trigger option under the Smpte/Midi menu. 
Rewind your video deck to the desired location and start the video deck playback. In this mode, 
SAW32/SAWPlus32 is actively looking for incoming SMPTE and when code arrives, the program will 
automatically cue forward or backward to the arriving SPMTE position, then add the number of SMPTE 
Chase Advance seconds as a pre-roll (set in the SMPTE Chase Advance option under the Smpte/Midi 
menu). This pre-roll time is used for MultiTrack PreLoad and can be set smaller or larger based on the 
speed of your computer and the complexity of the session. SAW32/SAWPlus32 will wait for SMPTE 
trigger at this new MultiTrack cursor position. The new trigger point is displayed in the Waiting For SMPTE
At: readout. Incoming SMPTE is displayed in the Current SMPTE Time: readout.

When using analog inputs and outputs, you may select any samplerate as the MultiTrack default rate and 
recording rate.

When using digital inputs and outputs, you must determine the samplerate of the source audio signal and 
match the    MultiTrack default rate and recording rate to the pulldown version of it. For instance, if the 
source audio is at 44100, you must select 44056 as your recording and MultiTrack samplerate, and of 
course, your soundcard must be capable of this rate.



SMPTE Summary
As can be seen from this information, working with SMPTE requires a little attention to the details at hand,
but once configured to your specific setup, stable and consistent results can be achieved. It is highly 
recommended that you test and confirm the results of your specific setup on a test project, from beginning
to end, prior to attempting any real projects that have a completion deadline. This information is not meant
to scare you away, but to make you aware of the many variables involved and present you with some of 
the various options that can have you up and running and synching successfully to SMPTE in the shortest
amount of time.



Troubleshooting in Windows 95
The Windows 95 operating system may have difficulty with real time applications for many reasons, but 
the dynamic disk caching and the multitasking time slicing are the two that most concern the 
SAW32/SAWPlus32 environment.

These suggested optimizations are recommended to avoid clicks/pops and audio glitching within the 
Windows 95 platform.

Below are steps that can be taken to optimize Windows 95 for audio and video real-time applications, in 
the order of importance. We recommend starting at the top of the list and making the minimum amount of 
changes needed to hopefully solve your particular problem.

Windows 95 will normally ask you to restart after each one of these adjustments, so it is recommended 
that you close all applications before making these changes.

Optimization Suggestions
Virtual Memory Size
The virtual memory swap file seems to be one of the most troublesome areas of the Windows 95 platform
for real-time applications such as SAW32/SAWPlus32. By default, Windows 95 allows this swap file to be
resized dynamically as the operating system runs. This resizing leads to system delays which may cause 
clicks/pops or audio glitching to happen during audio playback. 

Setting the virtual memory size of Windows 95 to prevent resizing of the swap file can have a big impact 
on improving SAW32/SAWPlus32’s performance. 

èTo Set Virtual Memory Size:

1. Click Start on the Windows 95 Taskbar. Click Settings and choose Control Panel.

2. Double-click the System icon.

3. Click the Performance tab.

4. Click the Virtual Memory button.

5. Click the option Let me specify my own virtual memory settings.

6. Set both the Minimum and Maximum values to 16 to prevent repeated resizing of the swap file. 

F We recommend a setting of 16 megabytes regardless of the amount of RAM installed on the 
system.

7. Click OK to accept your changes.

CD-ROM Auto Insert Notification
By default, Windows 95 is set to continuously check the CD-ROM for the insertion of a CD so that it may 
automatically run the CD setup program. This can result in audio glitches during playback and recordings 
because it forces Windows 95 to continually time-slice all other running applications. This will also 
interfere with the ability of a CD-R burner to write a CD by causing the SCSI controller to error out if it 
checks the CD-R at the same time a CD is being burned.

èTo Disable CD Auto Insert Notification:



1. Click Start on the Windows 95 Taskbar. Click Settings and choose Control Panel.

2. Double-click the System icon.

3. Click the Device Manager tab.

4. Click the plus sign next to the CD-ROM listing to expand the list of CD-ROM devices.

5. Select your CD-ROM and click the Properties button.

6. Click the Settings tab.

7. Uncheck the Auto Insert Notification checkbox.

8. Click OK to save your changes.

F Follow this procedure for each CD-ROM installed on your system.

Write Caching
By default, Windows 95 is set to enable disk write file caching. This function allows Windows 95 to write 
disk files in the background at some later time, rather than at the moment you initiate a disk write 
procedure. When recording soundfiles in SAW32/SAWPlus32, the data is presented to the disk in one 
continual streaming operation, leaving no time for background writing operations. When write file caching 
is active, Windows 95 tries to put the data in RAM first, waiting for an opportune time to write it to disk in 
the background. This opportune time never comes, and Windows 95 runs out of RAM space, interrupts 
SAW32/SAWPlus32 trying to quickly empty its cache to disk, and potentially loses incoming data, 
causing audio glitches in the recording.

èTo Turn Off File Write-Caching:

1. Click Start on the Windows 95 Taskbar. Click Settings and choose Control Panel.

2. Double-click the System icon.

3. Click the Performance tab.

4. Click the File System button.

5. Click the Troubleshooting tab.

6. Check the Disable Write-Behind Caching For All Drives checkbox.

7. Click OK to save your changes.

Read Caching
By default, Windows 95 caches all disk reads to RAM. Normally read caching can be an advantage for 
SAW32/SAWPlus32. Problems can occur, however, when Windows 95 dynamically resizes the amount of
space allocated for the read-cache buffers. This can cause audio glitching during playback.

èTo Limit the Maximum File Read-Cache Size:

F This procedure requires a good working knowledge of the Windows 95 environment. If you’re not 
comfortable with the following steps, solicit the help of someone well-versed in the Windows 95 
platform.

1. Using Windows Explorer, navigate to your Windows folder, and double-click the System.ini file to 
open it into the Notepad application.

2. Scroll through the file looking for a section labeled [vcache].



3. Create a blank line under the [vcache] heading and type MaxFileCache = 4096. If this entry already 
exists, just change the size value. Make sure the upper case and lowercase letters are maintained, 
otherwise this line will not work. 

F This limits the maximum file cache size to 4096 Kilobytes (4 Megabytes). You can experiment 
with different sizes, but the size specified should be in increments of 1024 and it is 
recommended that the size not be made less than 2048.

4. Save the file and close Notepad. Restart Windows 95 for this change to take effect.

Double Buffer
In some cases, depending on your disk configuration, Windows 95 may create a double buffering scheme
for handling disk transfers. This can cause serious audio glitching during record and playback.

èTo Disable Double Buffering:

F This procedure requires a good working knowledge of the Windows 95 environment. If you’re not 
comfortable with the following steps, solicit the help of someone well-versed in the Windows 95 
platform.

1. Using Windows Explorer, navigate to the root directory of your boot drive. 

2. Right-click on the MSDOS.SYS file and select Properties from the popup menu.

3. Uncheck the Read Only checkbox.

4. Click OK.

5. Double-click on the MSDOS.SYS file and choose Notepad to open the file.

6. Scroll through the file looking for a section labeled [Options].

7. Create a blank line under the [Options] heading and type DoubleBuffer=0. If this entry already 
exists, make sure it is =0, not =1. Make sure the upper case and lowercase letters are maintained, 
otherwise this line will not work. 

8. Save the file and close Notepad.

9. Right-click on the MSDOS.SYS file and select Properties from the popup menu.

10. Check the Read Only checkbox.

11. Click OK.

12. Restart Windows 95 for changes to take effect.

Additional Suggestions
If the above suggestions do not work, here are some additional options you may try.

Video Cards
Some video cards can interfere with the PCI bus and/or DMA operations. Many of the newer hardware 
accelerated video cards will contain their own specialized applet or settings tab in the Windows 95 
Display Properties control panel. If a checkbox exists referencing PCI bus retries or DMA bus mastering, 
or something similar, try disabling this option.

Graphics Hardware Acceleration
Some video cards hardware acceleration interactions can be controlled directly from the Control Panel in 



Windows 95.

èTo Reduce Graphics Hardware Acceleration:

1. Click Start on the Windows 95 Taskbar. Click Settings and choose Control Panel.

2. Double-click the System icon.

3. Click the Performance tab.

4. Click the Graphics button.

5. Adjust the Hardware Acceleration slider control one notch to the left to lower the setting.

6. Click OK to save your changes.

F After restarting Windows 95, if the problem persists, try adjusting this setting one notch lower, 
until the desired results are achieved. If the lowest setting does not work, it is recommended that
you reset the control to the highest setting.

Media Control
By default, the Media Control Interface (MCI) will allocate a certain amount of memory to buffer from 2 to 
9 seconds worth of audio for the default audio wave device. This can introduce a double buffering 
condition and may cause clicks/pops and/or audio glitches when using SAW32/SAWPlus32. 

èTo Disable the Wave Audio Device:

1. Click Start on the Windows 95 Taskbar. Click Settings and choose Control Panel.

2. Double-click the MultiMedia icon.

3. Click the Advanced tab.

4. Click the plus sign next to the Media Control Devices listing to expand the list.

5. Select the Wave Audio Device (Media Control) and click the Properties button.

6. Select the Do not use this Media Control device option button.

Click the Settings button, and adjust the slider control all the way to the left to the minimum 
setting.
7. Click OK to save changes.

Computer Role
Windows 95 allows you to select different role types for your computer system, and it appears that 
memory and disk handling may be treated differently depending on the type selected. Sometimes 
selecting a different role type may be the solution.

èTo Change the Computer Role Type:

1. Click Start on the Windows 95 Taskbar. Click Settings and choose Control Panel.

2. Double-click the System icon.

3. Click the Performance tab.

4. Click the File System button.



5. Change the typical role of this machine to Mobile or Docking System.

6. Click OK to save your changes.

Background Processing
· Ensure that all power management functions are disabled on the computer.

· Ensure that no memory resident virus software is installed. Software of this type intercepts all disk 
access and can cause audio glitches due to these delays. 

· Ensure that no disk compression software is enabled on any drives regardless of whether these 
drives are used for audio data or not.

· Ensure that no RAM doubling software is installed.




